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Getting Started

GENTRAN:Director” for Windows"~ Application Integration subsystem
provides you with the tools you need to trandate your application files to
EDI standard formats for documents you send to your partners (outbound
mapping), and to translate EDI standard formats to your application format
for documents that you receive from your partners (inbound mapping).

GENTRAN:Director Application Integration User's Guide March, 1999 1



What’s in this Manual Getting Started

What's in this Manual

The majority of the GENTRAN:Director Application Integration
documentation is contained in the online Help system. This manual is
intended to support the online Help by assisting you in performing various
tasks in the Application Integration subsystem. This task-oriented approach
isintended to answer any questions you may have about
GENTRAN:Director with step-by-step instructions.

Thismanual assumesthat you arefamiliar with usinga
PC and with Microsoft® Windows functions,
including:

B Theterminology used to describe mouse and
cursor actions.

B Theterminology used to describe Windows-
specific attributes, including dialog boxes, icons,
windows, and buttons.

B Using the Windows Program M anager.

Thismanual also assumesthat you are familiar with
EDI concepts, EDI standard structure, your internal
application format, data mapping concepts, and the
GENTRAN:Director 0 product.

The Application Integration User’s Guide is organized into chapters. A brief
description of the chapter contents follows.

B Chapter 1, Getting Sarted explains the content, organization, and
conventionsin this guide, as well as the system requirements. This
chapter also describes to get technical support, provides a brief outline
of how to build maps using the Application Integration subsystem, and
gives you an introduction to mapping and GENTRAN:Director for
Windows.

B Chapter 2, Mapping Basics explains how to perform basic functionsin
the Application Integration subsystem, including creating a new map;
using fixed-format and EDI files; opening, saving, and naming a map;
compiling a map; and printing a mapping report. This chapter also
explains customizing display options; setting the default date format;
selecting which map components to use; cutting, copying, and pasting;
setting up the document name and reference; formatting your data; and
using field-to-field linking.

B Chapter 3, Customizing the Properties of Map Components explains
how to customize the properties of record, segments, looping structure,
fields, elements, and composite elements. This chapter also explains
how to use loop start (LS) and loop end (LE) segments.

2 March, 1999 GENTRAN:Director Application Integration User’'s Guide



Getting Started

What's in this Manual

Chapter 4, Using Sandard Rules explains how to use the Application
Integration standard rules: select, update, constant, use accum, loop
count, and use code. This chapter also illustrates examples of when you
might use certain standard rules.

Chapter 5, Setting Up the Import Process explains all the facets of the
import process, definesimport file restrictions, and describes how to
create a system import map.

Chapter 6, Setting Up the Export Process explains all the facets of the
export process and describes how to use envel ope information.

Chapter 7, Using Extended Rules defines what extended rules are and
when they are used, and explains the proprietary programming language
syntax.

Chapter 8, Error Messages describes GENTRAN:Director error
messages and specifies corrective actions.

The Glossary contains definitions of mapping and GENTRAN:Director
terms and concepts.

The Index provides you with alist of terms, concepts, functions, and
processes to enable you to quickly find them in this guide.

GENTRAN:Director Application Integration User's Guide March, 1999 3



What's in this Manual

Getting Started

Conventions in

this Manual The different typefaces used in this manual are as follows:

Creating a new map

NEW..

F1

Click this button

Thistypefaceis used for emphasis or to indicate a
chapter or section in this manual or other
GENTRAN:Director manuals.

Thistypeface indicates a button in the program.
Click the button with your mouse, or press TAB
until the button is highlighted, then pressENTER
to execute that command.

Thistypeface indicates a key that you need to press
on your keyboard. A plus sign (+) between key
names indicates a combination of keysto be
pressed together (e.g., CTRL + C).

Thistypeface highlights an action that you should
take or indicates descriptive text. It is most often
used for callouts (text that is“pulled out” to the side
or bottom of an illustration) in this manual to
highlight specific steps that you need to take to
complete atask. In the callouts, any button that you
need to click is described in this same typeface.

The different icons used in this manual are as follows:

Thisicon indicates a note that givesyou additional
information on the current subject.

Thisicon indicates a caution that alertsyou to the
potential loss of information. Please read any text
preceded by thisicon carefully.

Thisicon indicates helpful tips, suggestions, shortcuts,
and alternative actions.

4 March, 1999
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Getting Started

Getting Support

Getting Support

Sterling Commerce’'s GENTRAN:Director software is supported by trained
product support personnel who are available to help you with product
questions or concerns. To help us provide prompt service, we ask that you do
the following:

Attempt to recreate any problem that you encounter and record the exact
seguence of events.

Make copies of the tablesin the following sections so that you can enter
the regquested information and have it available when you call us.

For assistance, please refer to your Getting Support card to determine which
support phone humber you should use.

When you call product support, you should be prepared to provide us with
the information bel ow.

To help us provide prompt service, we ask that you do the following:

Attempt to recreate any problem that you encounter and record the exact
sequence of events.

When you call product support, you should be prepared to provide us
with the information below.

1

System Configuration:

Information about the primary system controller and all machines
experiencing problems, including the computer manufacturer and
model number, Windows version, amount of memory, available
disk space, and the network adapter type.

Error Messages:
Record the exact wording of any error messages you receive and
the point in the software where the error occurred.

Attempted Solutions:
Record any steps that you took attempting to resolve the problem
and note all the outcomes.

GENTRAN:Director Application Integration User's Guide March, 1999 5



Introducing Mapping Getting Started

Introducing Mapping

A map isaset of instructions you define in the GENTRAN:Director
Application Integration subsystem that indicates the corresponding
relationship between your application file and the EDI standards, and defines
how the system should tranglate data.

For inbound mapping, the system trandlates your trading partner’s EDI
standard formatted business document to your application file format. To
translate inbound data, you need to create an export map in
GENTRAN:Director Application Integration (because the system is
exporting to your application file).

For outbound mapping, the system translates your application file format to
EDI standard formats, so you can send documents to your partners. To
translate outbound data, you need to create an import map and a system
import map in the GENTRAN:Director Application Integration subsystem.
You need to create an import map because the system isimporting fromyour
application file. The import map defines how to move data from your
application file (flat file definition), which may contain multiple documents,
to the EDI standard-formatted documents that your partners expect to
receive from you. You need to create a system import map to determine
which trading relationship (established in Partner Editor) corresponds to
each document in the application file, so the system knows which import
map to use to process the document. Please see Creating a System Import
Map on page 217 for more information on creating a system import map.

After you create a map in the Application Integration subsystem, thismap is
the source from which you compile atranslation object. A trandation object
isaset of rulesthat instruct the translator how to convert afile from one
format to another. Every function performed during trandation requires a
translation object. Trand ation objects are used to control all the functions of
GENTRAN:Director EDI translation. Translation objects can belong to the
following two categories: system translation objects or user trandation
objects. System tranglation objects control the creation and separation of
interchanges, functional groups, and transaction sets. They are also used to
generate and reconcile functional acknowledgements. User translation
objects control data entry, importing, exporting, document turnaround, and
creating printed reports. All the required system tranglation objects are
automatically installed with the GENTRAN:Director system.

6 March, 1999 GENTRAN:Director Application Integration User’'s Guide



Getting Started

Introducing Mapping

The GENTRAN:Director Application Integration subsystem enables you to
generate import, export, and document turnaround translation objects. The
GENTRAN:Director Forms Integration subsystem enables you to generate
data entry and print translation objects. Once you generate a translation
object using the GENTRAN:Director Application Integration subsystem (or
the GENTRAN:Director Forms Integration subsystem), you must register
the trandation object with GENTRAN:Director (seethe
GENTRAN:Director User’s Guide for more information). In addition, you
must establish correct trading relationships for all trading partners from
which you receive or to which you send data (see the GENTRAN:Director
User’s Guide for more information). During the process of establishing a
trading relationship, you need to specify the name of the appropriate
translation object that the translator uses to trand ate the data (see the
GENTRAN:Director User’s Guide for more information).

The diagram below illustrates the inbound and outbound translation process:

Export Translation Object

'

Application
Inbound —E2 g | APPTCAton,
GENTRAN:Director
Outbound -w——— .
EDI Application

!

Import Translation Object

When you create an import map, you need to define to GENTRAN:Director
your application file format (your data that you sends to your partners) and
the EDI standard format in which your partners expect to receive the
documents. When you create an export map, you need to define to
GENTRAN:Director the EDI standard format in which your partners sends
documentsto you and your application file format (how the data needs to be
formatted for your application to processiit).

GENTRAN:Director Application Integration User's Guide March, 1999 7



Introducing Mapping

Getting Started

Application File
Format

If you are creating an import or export map, you must define your
application to the GENTRAN:Director Application Integration subsystem.
In GENTRAN:Director terminology, your application fileis also referred to
as afixed-format file or a positional file. Your application file must contain
all the information that you either need to extract from your partner’s
document (if the map is inbound) or need to send to your partner (if the map
is outbound), so that your system can accurately process the data.

The map components that you use to define your application file are as
follows:

B A group isalooping structure that contains related records and/or
groups that repeat in sequence until either the group data ends or the
maximum number of times that the loop is allowed to repeat is
exhausted. If you create a group that is subordinate to another group (a
sub-group), this corresponds to a nested looping structure (aloop within
aloop). The application (positiona) file is agroup and therefore, it is
visually represented the same way as other groups and sub-groupsin the
Application Integration subsystem: ]

B A record contains agroup of related fields. A record can occur once or
can repeat multiple times. A record is visually represented in the
Application Integration subsystem as the following: .

B A fied isthe smallest piece of information defined in the application
file. A field isthe application map component that is mapped (linked) to
acorresponding EDI element to move datato and from your application
file. A field isvisually represented in the Application Integration
subsystem asthefollowing: o

When afield has a mapping operation performed against it, ared
checkmark is displayed over the field icon.

Before you define your application, you should obtain alayout of the
necessary records, fields, and groups. Each map component is arranged
sequentially in the order that it is most logical for the system to process.
Therefore, each level of your application must be created sequentially. For
example, your application file contains records and groups. The records
contain fields and the groups contain records and/or sub-groups. This means
that you must create records and groups before you create the subordinate
fields. Please see Using a Fixed-Format File on page 23 for more
information on defining your application file format.

8 March, 1999 GENTRAN:Director Application Integration User’'s Guide



Getting Started Introducing Mapping

EDI File Format

The EDI file must contain all theinformation that you expect to receive from
your partner (if the map is inbound) or need to send to your partner (if the
map is outbound), so that your system can accurately process the data.

The GENTRAN:Director Application Integration subsystem generates an
EDI file for you, based on the standard (agency), version, transaction set,
and release (for the TRADACOMS standard only) you selected. The system
includes all the groups, segments, composites, and elements that are defined
by the standards agency for the version of the document you selected. Please
see Creating a New Map on page 18 for more information on generating an
EDI file when you create a new map. If you are creating an import or export
map, you typically need to customize the system-generated EDI file by
modifying the properties of the map components, and using specialized
GENTRAN:Director functions to manipulate the EDI file structure.

However, if you want to use a specialized version an EDI standard that is not
available in the GENTRAN:Director standards database, it may be
appropriate for you to define the EDI file yourself.

Regardless of whether the system generates the EDI file or you defineit, the
specific EDI map components that you use depend on the type of map you
are creating. Thisincludes the standard, version, and transaction set
(document) sel ected, and which groups, segments, composites, and elements
your company reguires. We recommend that you determine which map
components you are using before generating or defining an EDI file.

The map components that GENTRAN: Director uses to define the EDI file
format are asfollows:

B A group isalooping structure that contains related segments and/or
groups that repeat in sequence until either the group data ends or the
maximum number of times that the loop is allowed to repeat is
exhausted. Groups are defined by the EDI standards. A group that is
subordinate to another group isasub-group (this correspondsto a nested
looping structure —aloop within aloop). The EDI fileis a group and
therefore, it is visually represented the same way as other groups and
sub-groups in the Application Integration subsystem: (1

B A segment contains a group of related elements or composite data
elements that combine to communicate useful data. Segments are
defined by the EDI standards. A segment can occur once or can repeat
multiple times. A segment is visually represented in the Application
Integration subsystem as the following: ‘.

GENTRAN:Director Application Integration User's Guide March, 1999 9
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Getting Started
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A composite is a data element that contains two or more component
data elements or sub-elements. Composites are defined by the EDI
standards that use them (EDIFACT, TRADACOMS, and certain ANSI
X12 standards). A composite is visually represented in the Application
I ntegration subsystem as the following: - &

An element isthe smallest piece of information defined by the EDI
standards. An individual element can have different meanings
depending on the context. Therefore, elements are normally not
considered to have useful meaning until they are combined into
segments. An element isthe EDI map component that is mapped
(linked) to a corresponding application field to move data to and from
the EDI file. An element is visually represented in the Application
Integration subsystem as the following:

When an element has a mapping operation performed against it, ared
checkmark is displayed over the element icon.

Please see Using an EDI File on page 35 for more information on
customizing the properties of the map components, and using specialized
GENTRAN:Director functions to manipulate the EDI file structure.

March, 1999
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Introducing the Application Integration Subsystem

Introducing the Application Integration Subsystem

The GENTRAN:Director Application Integration subsystem enables you to
translate your application files to EDI standard formats for documents you
send to your partners (outbound mapping), and to translate EDI standard
formatsto your application format for documents that you receive from your
partners (inbound mapping).

Navigation

You can access the GENTRAN:Director Application Integration Window in
one of four different ways:

Click the menu option from the Main Menu Bar.
Click the appropriate button on the Main Toolbar.
Click the appropriate part of the map.

Click amap component with the right mouse button to access a shortcut
menu, which contains all the functions that are currently available for
that map component. The content of the shortcut menus varies,
depending on the type and level of the selected map component.

When you start GENTRAN:Director Application
Integration, the Main Menu Bar contains a subset of

menu items. A full set of menu itemsisdisplayed after
you create a new map or open (load) an existing map.

GENTRAN:Director Application Integration User's Guide March, 1999 11
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12

The GENTRAN:Director - Application Integration Window appears as

follows::

Control Menu

— éfile Edit Functionz “iew Optionz ‘Window Help

TitIT Bar

Minimize/Maximize Buttons

i e e G 2 = e e KA S e 1

al

£ 550 M- PURCHASE ORDER
[ 4PBEG M- 1 BEGINNING SEGH

— @ 01 0353 -M- Sting 2 TRAMN
—#® 02 0032 -M- Sting 2 PURC
—¥® 03 0324 -M- Sting 22 PUR
—p® 050323 -M- Dt/ T 6 PLIRI

—@DTM -C-10DATE/TIME REFI

—#® 01 03746 -M- String 3 DAT
— @ 0203736 -C- Dt T b DA

4P TEMPDATES -C- 1 TEMPORS

—¥® 01 DELDATE -C- Dt/ Tm B

M1 -C-1 HAME
S 01 0092 -M- String 2 EM

@ 02 0093 -C- String 35 M,

F

L® (12 CAMCELDATE -C- DT —
T 0200 M1 -C- 200

—423 C- 1 ADDRESS |NFiFIj
2

tring & Cugtomer Mumber #® —
n B Purchasze Order Date o —
Purchaze Order Number v® —

ﬁ/_,,—f”
H\“‘-«

Lchagze Order Type Code ¥® —
String 35 Ship To Mame ¥ —
b Ship To Addrezs Line 1 ¥® —
b Ship To Addrezs Line 2 ¥® —
tC- Strirg 30 Ship To City o® —
C- String 2 Ship To State #® —
g 9 Ship To Postal Code ¥® —
I_- String 35 Bill To Mame ¥® —
35 Bill To Addresz Line 148 —
35 Bill To Addresz Line 148 —

-C- String 30 Bill Ta City o® —

OUTPUT M- £F =
ER -M- 1 PO Header Record 48]

-C- String 2 Bill Ta State v® —

For Help, prezs F1

1

Lr]

| NoMT

— Main Menu Bar

Status Bar

Main Toolbar —

B The Control Menu contains the following commands: Restore, M ove,
Size, Minimize, Maximize, and Close.

B TheTitle Bar containsthe name of the application. You can use thisto
move the position of the EDI Director window on your desktop.

B The Minimize button reduces the window to an icon.

The M aximize button enlarges the window to its maximum size.

March, 1999
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B TheMain Menu Bar containsthe following drop-down menus
(detailed descriptions of each of the commands on these menus are
found in the online Help). Unavailable items are dimmed.

File

Ot
Open Crl+0 Lory v Status B
Elp Pagte G4 i
oze .
Save Ctrl+5 Create Sub b &tha,te By JEEED
= [ » Deactivate Ezpand Al
Save As.. . ————— Unexpand Branch
Delete Del Link =
Cormpile Ereptics ﬁnlink Show Active Only
Print.... Chil+P i Equalize
_T!n T+ Session Bules Generate TOF 9
Print Setup... Caongtants Generate LIEF]
Print Ta File. . Spntax Tokens =
Code Lists F0t T
1 Pet_B50.map —
Details
£l Find..

Date Formats. .. Tile Index
Amange lcons Using Help

v 1 Pet_850.map About GEMTRAM:Server - Application Integration. ..

B TheMain Toolbar givesyou access to some of the most common
operations in the Application Integration subsystem. Unavailable items
are dimmed. The Main Toolbar is adockable toolbar, so you can affix it
to any edge of the client window. The Main Toolbar isillustrated below:

New Cut
‘ Save

Constants Split Unlink

Paste Code Lists ‘ Deactivate

R
NErED R EEEE R

Open Copy Syntax Activate Generate
. . Tokens ) TDE
Compile Session Promote Link
Rules
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14

B TheStatusBar displays statusinformation about a selection, command,
or process, defines menu items as you highlight each item in the menu,
and indicates any current keyboard-initiated modes for typing (e.g.,
CAP for the “Caps Lock” key).

Keyboard
Techniques The proceduresin this manual are designed to be executed with a mouse. If

-

you prefer to use the keyboard, pressthe ALT key and the underlined letter
of the desired menu option to open the menu. Once the menu is open, press
the underlined letter of the desired menu option to access that option.

If akey combination (e.g., CTRL + N for the NEW
command) isspecified ontheme # that option, you
may pressthat key combination aswell.

Instead of clicking a button to executea command on a

dialog or browser, press TAB to highlight the desired
button, and press ENTER to execute that command.
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Building a Map with Application Integration

Building a Map with Application Integration

This section defines how to proceed with building a map using the
GENTRAN:Director Application Integration subsystem.

1

Prepare and Analyze

Obtain alayout of your application file and determine how it
corresponds with the EDI standard you are using. Determine how you
move data to or from each application field.

Set Global Defaults (first time only)

The first time you use the GENTRAN:Director Application Integration
subsystem, you should establish the default date format that the system
uses. Please see Setting Default Date Format on page 93 for more
information on setting the global date defaullt.

Create, Save, and Name a New Map
Please see Creating a New Map on page 18 for more information on
creating, saving, and naming a map.

Activatethe Appropriate EDI Groups, Segments, and Elements or
Auto Trim Based on a Sample EDI File

Please see Selecting Which Map Components to Use on page 94 for
more information on activation. Please see Using Auto Trim on page 46
for more information on auto trim.

Defineyour Application
Please see Using a Fixed-Format File on page 23 for more information
on defining your application.

Map the Appropriate Data for Each Application Field

Please see Using an EDI File on page 35 for more information on
customizing your EDI file. Please see Creating Smple Field-to-Field
Links on page 84 for more information on simple mapping (linking).
Please see Chapter 4, Using Sandard Rules for more information on
using standard rules. Please see Chapter 6, Using Extended Rules for
more information on using extended rules.
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10.

11

March, 1999

Compilethe Trandation Object

Please see Compiling a Map on page 62 for more information on
compiling the tranglation object and trandation object naming
conventions.

Print the Mapping Report

Validate and review the map, and make modifications as needed. Please
see Printing a Mapping Report on page 65 for more information on
printing the mapping report.

Register the Translation Object with GENTRAN:Director
Please see the GENTRAN:Director User’s Guide for more information
on registering translation objects.

Createthe Appropriate Trading Relationship

Establish the appropriate trading relationship in GENTRAN:Director
for your trading partners. Please see the GENTRAN:Director User’s
Guide for more information on creating trading relationships.

Testing the Trandation Object

Obtain test data from your partners and process the data. Verify
acknowledgement processing (if applicable). Verify communications
with your network.
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Mapping Basics

This chapter explains some of the basic (not lengthy) mapping functions.
Some of the mapping functions are performed initially (creating a map),

some are performed as you define the map, and some are performed after the

map is completed (compiling and printing a mapping report).
This chapter includes the following topics:

Creating aNew Map

Using a Fixed-Format File

Using an EDI File

Opening a New Map

Saving aMap

Naming aMap

Compiling aMap

Printing a Mapping Report

Setting the Default Date Format

Selecting Which Map Components to Use
Setting Up the Document Name and Reference
Formatting Your Data

Creating Simple Field-to-Field Links
Customizing Your Display

GENTRAN:Director Application Integration User’'s Guide December, 1998
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Creating a New Map

You can create four different types of maps: System Import (containing the
header information for an Import map), Import (for Outbound Maps), Export
(for Inbound Maps), or Turnaround (for EDI to EDI maps). Theinitial
procedures for creating a new map of each of the four typesisthe same.

Complete the following steps to create anew map:
1. Select New from the File menu to display the Create New Translation

Object dialog.
Function ||mp0rt
ats Saurce I j ez |
— Input Format
Tupe I 'I I s Etandand:
SgErE I ﬂ
Ersian I ﬂ
Tiarzactior I ﬂ
HelEase Iﬁ
r— Dutput Farmat
Type Iﬂ ™|z Standand:
Saency I ﬂ
WETSIET I ﬂ
TatiEaEto I ﬂ
HelEase Iﬁ

2. Complete the Input Format section of the dialog. Thisis the format of
the data that istrandated by the GENTRAN:Director system.

18 December, 1998 GENTRAN:Director Application Integration User’'s Guide



Mapping Basics Creating a New Map

3. Select the type of format for the input data from the Type list. Valid
values are “EDI” or “Positional.”
B For Inbound maps (Export), the Input Format Typeis“EDI.”
B For Outbound maps (System Import or Import), the Input Format
Typeis*“Positional.”
B For Turnaround maps, the Input Format Typeis“EDI.”
4. If you selected “EDI” in the Type box and if you want to use the EDI

standard, click the Use Standards check box. If you select “Positional”
in the Type box, proceed to step 9.

5. If you want to select a data source name from which Application
Integration accesses EDI standards, select one from the Data Sourcelist.
This DSN is prompted the next time you create a map.

6. Select the EDI standard you are using for the input side of the map from
the Agency list. Valid values are:

[A] = TRADACOMS
[E] = EDIFACT

[O] = ODETTE

[T] = TDCC

[U] = UCSWINS
[X] = ANSI X12

7. Select the version of the standard from the Version list. The versions
that are available depend on which standard you selected.

8. Select the transaction set (document or message) from the Transaction
list. The transactions that are avail able depend on which standard and
version you selected.

9. For TRADACOMS only, select the rel ease number of the version that
you are using from the Release list. The releases that are available
depend on which standard, version, and transaction you selected.

10. Select the type of format for the output data from the Typelist. Valid
vaues are “EDI” or “Positional.”

B For Inbound maps (Export), the Output Format Typeis
“Positional .”

B For Outbound maps (System Import or Import), the Output Format
Typeis“EDI.”

B For Turnaround maps, the Output Format Typeis“EDI.”

11. If you selected “EDI” in the Type box, click the Use Standards check
box. If you selected “Positional” in the Type box, proceed to step 15.
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12.

13.

14.

15.

16.

17.

Select the EDI standard you are using for the input side of the map from
the Agency list. Valid values are:

[A] = TRADACOMS
[E] = EDIFACT

[O] = ODETTE

[T] = TDCC

[U] = UCSWINS
[X] = ANSI X12

Select the version of the standard from the Version list. The versions
that are available depend on which standard you selected.

Select the transaction set (document or message) from the Transaction
list. The transactions that are avail able depend on which standard and
version you selected.

For TRADACOMS only, select the release number of the version that
you are using from the Release list. The releases that are available
depend on which standard, version, and transaction you selected.

Click OK to generate a new map (this may take afew seconds). The
new map is displayed in the GENTRAN:Director Application
I ntegration Window.

After you create a new map, it isimportant to define the details of the
map and save it. Select Save from the File menu to display the
Translation Object Details dialog.

Translation Object Details

— Summary
Authar

Dezcription Tranzlation Object Function System

I IE:-:DDIt j [

Cancel |

b ajor wer

—Werzion Control

Fion ID Minor wersion ID Eompiledonl

Agency

Yersion

Release

F Group

— EDI Aszociations

Tranzaction IUHDEHS IF'UFHEHJ’-\SE ORDE

Input Output

£ [Edtact [ ]

|DE|2IZIIZI1 |EDIFAI:T1992F|EL

|
|
e —

|DF|DEF|S |
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18.

19.

20

21.

Complete the Author box. This box typically contains the name of the
person who created the map.

Complete the Description box. This box must be unique because it is
used by the system to identify the map. We recommend that you use the
following identifying characteristics: the partner that this map is used
for, the standard, the version, the type of transaction this map uses, and
the direction of the map (e.g., Import, Export). For example, “MWT X
3030 850 Export” isthe description of amap used with partner MWT,
for an ANSI X.12 version 003030 Purchase Order (850), that is sent
Inbound (Export).

Verify the type of trandlation object in the Translation Object Function
list.

Click the System check box if you want to designate thisform asa
system tranglation object (one that isused internally by the system).

You should only select thischeck box if you arecertain
you want to definethistranslation object asa system

22.

23.

translation object. Once a translation object is
registered with GENTRAN:Director, it cannot be
deleted.

Complete the Major and Minor boxes if you want to designate a version
number for this translation object. Type the version number in the Major
box and the release number in the Minor box.

The Input and Output boxes (Agency, Version, Transaction, Release,
and F Group) containsinformation only if the Input and/or Output sides
of the map are of EDI format. You can change the information in these
boxes, but it does not alter the content of the map. You may wish to alter
these boxes if, for example, you want the map to reflect a standards
version that is not loaded on your system. You can change the version
on this dialog, and then alter the map to be compliant with that version.
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24. Click OK to save the translation object details and access the Save As
dialog.

Save As
Save in: IaMaDS j gl IT-_

File narme: IF'et_enrd.map

Save az upe; IMaps [# map) ﬂ Cancel |

25. We recommend that you store maps in the Maps folder where
GENTRAN:Director isinstalled.

26. Type the name of the map (one to eight characters) in the “File name”
box. The default file extension is .MAP.

27. Click SAVE to save the map.

After you finish creating and saving anew map, you need to define the Input
and Output sides of the map. The steps you take are different, depending on
whether the map is an Import, System Import, Export, or Turnaround map.
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Using a Fixed-Format File

If aside of your map is positional (fixed-format), you must either define
your application to GENTRAN:Director or load a previousdy-saved file
definition. Your application file must contain al the information that you
need to extract from your partner’s document (if the map isinbound) or send
to your partner (if the map is outbound).

Before you define your application, you should obtain alayout of the
necessary records, fields, and groups. The records contain related fields and
the groups contain related records. Each map component is arranged
sequentially in the order that it is most logical for the system to process.
Therefore, each level of your application must be created sequentially.

For example, your application contains records and groups. The records
contain fields and the groups contain records, sub-groups, or both. This
means that you must create records and groups before you create the
subordinate fields.

Loading a File

Definition GENTRAN:Director enablesyou to load an individual file format definition
that you previously saved. This feature provides you with a quick way to
build the fixed-format or EDI sides of your map. Please see Saving a File
Definition on page 24 for more information on saving afile definition.

Loading afile definition replaces the selected side of
the map. Please be certain that isyour intent before
performing thistask.

Complete the following stepsto load afile format definition:

1. Usetheright mouse button to click the fixed-format icon (either the
INPUT or OUTPUT side of the map) to access the shortcut menu.

2. Select Open File Definition... from the shortcut menu.

If you already used GENTRAN:Director to createa
fixed-format file on that side of the map, you are
prompted with a message that warnsyou that the

existing file format will be replaced. Click YES to
continue.
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The Open File Definition dialog is displayed.

Open File Definition
Look i Ia Bin
E921_ord.ifd

File pame:  [E921_ord.ifd P
Files of bope: IFiIe Definitions [*1FD] ﬂ Cancel |

3. The“Look in” list should reflect the drive\folder where
GENTRAN:Director isinstalled. The default is c:\Program
Files\Sterling Commerce\ GENTRAN Director. If the current subfolder
is not the correct one, select the appropriate folder.

4. Select the type of file that you want to display from the Files of Type
list. The default file extension is .IFD.

5. Select thefile definition that you want to load into the system from the
list or typeitin the “File name” box.

6. Double-click the filename or click OPEN to load the selected file format
definition.

Saving a File

Definition GENTRAN:Director enablesyou to save an individual file format definition
so that you can use it asaguide in future maps. This provides you with a
quick way to build the fixed-format or EDI sides of your map. Please see
Loading a File Definition on page 23 for more information on loading afile
definition.

Complete the following steps to save an individual file format definition:

1. Usetheright mouse button to click the fixed-format icon (either the
INPUT or OUTPUT side of the map) to access the shortcut menu.
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2. Select Save File Definition As... from the shortcut menu. The Save File
Definition dialog is displayed.

Save File Definition

Save jn: Ia Bin

File name: |E921_DHD.IFD

Save as lwpe: IFiIe Definitions [*IFD) ﬂ Cancel |

3. The“Savein” list should reflect the drive\folder where
GENTRAN:Director isinstalled. The default is c:\Program
Files\Sterling Commerce\ GENTRAN Director. If the current subfolder
is not the correct one, select the appropriate folder.

4. Select the file definition from the list or type the name of thefile
definition (one to eight characters) in the “File name” box. The default
fileextensionis.IFD.

5. Click SAVE to save the file definition.

Creating the

First Record Thefirst record in your application is generally the header record. The first
record is subordinate to the icon in the application side of the map. This
shows how the records (and groups) are contained within it.

Werecommend that you include a header record in
each application file. The header record ismandatory
and repeat only once (not a looping structure).

Complete the following steps to create the first application record:

1. Click the Positiona Fileiconto highlight it (OUTPUT for an inbound
map and INPUT for an outbound map).

2. Select Create Sub from the Edit menu. Select Record from the submenu.
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The Positional Record Properties dialog is displayed.

Eles

— [dentific.ation
Namel

Cancel |
Desc I

Fiomate |
Tag I— Pasition I'I_ [ Use KeyField  FepField. |

Slif.. |
— Looping |

tin Uzage ID
¢ Loop Start
tax Usage I'I  Loop End

— Special Properties
& Mormal
" Floating

 wildeard

Altermate Tiag I Eastion |1

Edit Fields...

3. Inthe Name box, type the record name.

Do not use spaces or dashes (-) in the Name box. You
can use the under score () to separate words.

4. Inthe Desc box, type a description of the record. This box is used to
provide a brief explanation of the record that allows you to differentiate
it from similar records.

5. Inthe Tag box, type the record identification code <TAG>. For

26
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example, arecord is recognized by the system as:

<TAG>[Fidld_1][Field 2]

The record TAG for each record enables the system to recognize that
record and then determine the mapping requirements.
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Positional Record Propertiesdialog, instead of defining
fieldswith the purpose of explicitly containing the
record tag.

Q Werecommend that you definetherecord tag on the

6. Inthe Position box, type the starting column position of the tag in the
datarecord.

The Looping section of the Positional Record Properties dialog enables you
to specify the minimum and maximum number of times this record can
repeat, and whether arecord is mandatory or conditional. Alter this section
only if therecord is alooping structure. Otherwise, accept the defaults.

7. Inthe Min Usage box, type the minimum amount of times the record
must repeat.

We recommend that you type “1” to make the header record mandatory.
If the Min Usage box containsa“0" (zero), therecord
is“conditional.” If the Min Usagebox containsa*“1” or

greater, therecord is“ mandatory.”

8. If you want the record to repeat (loop), type the maximum amount of
timesit can repeat in the Max Usage box.

For the header record, we recommend that you accept the default of “1”
so it remains arecord that only occurs once (not alooping structure).

9. Click OK to create the record.
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28

Creating

Su bseq uent After you create the first record, you can define subsequent records at the
Records $me level. You can also define groups, if your application includes looping
structures. You may need to define aloop if your application requires a
group of related records (and/or sub-groups) that repeat in sequence. Please
see Creating a Group on page 30 for more information on defining groups.

Complete the following steps to create additional application records:

1. Highlight the record which precedes the record you are creating in the
file layout.

2. Select Insert from the Edit menu. Select Record from the submenu.

The Positional Record Properties dialog is displayed.

— Identification
Namel

Canhicel |
Desc I

Eramate |
Tag I Position |1_ [ UseKeyField  KeyField. |

Salit |
— Looping

[ |
tin Uzage IIJ . .

" Loop Start Edit Fields...l

tax Usage |1 " Loop End

— Special Propertiez

& Nomal
" Floating

™ wildcard Altemate Tiag I Erstinr I'I

3. Inthe Name box, type the record name.
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4. Inthe Desc box, type a description of the record. This box is used to
provide a brief explanation of the record that allows you to differentiate
it from similar records.

5. Inthe Tag box, type the record identification code <TAG>. For
example, arecord is recognized by the system as:

<TAG>[Field_1][Field_2]
The record TAG for each record enables the system to recognize that

record and then determine the mapping requirements.

6. Inthe Position box, type the starting column position of the tag in the
datarecord.

7. Inthe Min Usage box, type the minimum amount of times the record
must repeat.

8. If you want the record to repeat (Ioop), type the maximum amount of
timesit can repeat in the Max Usage box.

9. Click OKto create the record. Use this procedure to create any
additional records.
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Creating a
Group

30

A group contains related records, groups, or both that repeat in sequence
until either the data ends or the maximum number of times that the loop is
allowed to repeat is exhausted. If you create a group that is subordinate to
another group, this corresponds to a nested looping structure (aloop within a
loop).

Complete the following stepsto create a group:

1. Tocreateagroup that is at the samelevel as a selected map component,
highlight the map component and select Insert from the Edit menu.
Select Group from the submenu.

OR
To create a group that is subordinate to a selected map component,

highlight the map component and select Create Sub from the Edit menu.
Select Group from the submenu.

The Group Properties dialog is displayed.

Group Properties

Mame I

Cahcel

Description I

Minimum Usage ID [T Promote records b parsnt

Rules...

Eramate

M axirurn Usage |1 Solits |

2. Inthe Name box, type the group name.
Do not use spaces or dashes (-) in the Name box. You
can use the underscore () to separate words.

3. Inthe Description box, type the loop description. This box isused to
provide a brief explanation of the loop.

4. Inthe Minimum Usage box, type the minimum number of times the
loop must be repeated. For a conditional 1oop, the minimum usage
should always be “0” (zero). For amandatory loop, the minimum usage
should be “1” or greater.
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5. Inthe Maximum Usage box, type the maximum number of times the
loop can be repeated.

6. Click OKto create the group.
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Creating Fields

Each record you create contains a group of logically-related application
fields. These fields define the structure and content of the data to the system.

The easiest way to add application fields to arecord is to use the Positional
Field Editor. Generally, you create the fields for the first record in the
application file, and then proceed with each sequential record.

%

Werecommend that you do not define fields with the
purpose of using thefield to explicitly contain the

record tag. Thisisbecausethe system takesthetag that
you definein therecord into account when the
automatic sequencing (Auto Position) featureis used.
Werecommend that you definetherecord tag on the
Positional Record Propertiesdialog. Please see page 26

for moreinformation.

Complete the following steps to create the application fields for arecord:

1. Right-click the application record and select Edit Fields... from the
shortcut menu to access the Positional Field Editor dialog.
Positional Field E ditor
~ Record
0K
Mame HEALDER Tag HODR TagPoz 1 —l
Cancel |
= CrEldiELElE
f{Ame I I | ffandatan
[Vesarptian I
[Vata Tvee I 'I Earmia I "I
Start Fas ID o = e L I & LErmtty IIJ
— Fields
I ame MiC Type Start  Length §
Delete |
Auto Position |
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If the field you are creating is the first field in the record, click NEW
Highlight the field that precedes the field you are creating in the record
layout and click NEW A highlight bar is displayed in the Fields section
where the new field is positioned. You need tofill inthefield valuesin
the Field Details section.

In the Name box, type the field name. Each application field must have
aunique name. It is useful to tag the end of the fields that occur in
multiple records with a suffix that identifies the record that contains it.
For example, “HDR” for the Header record.

Do not use spaces or dashes (-) in the Name box. You
can use the underscore () to separate words.

If you want to designate the field as “mandatory” (must be present),
click the Mandatory check box.

In the Description box, type adescription of the field. The description is
used to provide a brief explanation of the field that allows you to
differentiate it from similar fields.

From the Data Type list, select the type of the field. Valid values are:

String = alphaelement
Number = numeric or real element
Dt/Tm = dateor time element

From the Format list, select how the data element is formatted. The
choices for this field depend on the type of field you selected from the
Data Type list. If you choose Number or Dt/Tm in the Data Type box,
you can select the data format from the Format list. If you selected
String from the Data Type box, you should type a syntax token to denote
that this field must be formatted as the specified syntax token dictates
(the default syntax token is“X"). Please see Using Syntax Tokens on
page 77 for more information on defining and using syntax tokens.
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Using a Constant
with a Field

8. If youwant to indicate the exact position of the field in the record, type
the starting position of the field in the Start Pos box. You want to specify
field start positionsiif, for example, you are only using a few fields but
you want them positioned exactly in the record.

The alternative to specifying the start position of each field, isto add the
fields sequentially in the record and then use the Auto Position function.
Please see step 13 below for more information on the Auto Position
function.

9. Inthe Min Length box, type the minimum number of charactersthat is
acceptable for thisfield.

10. Inthe Max Length box, type the maximum length of the field.

11. Toaddthefield and to create another field positioned after it, click NEW
A new field with blank values ready for you to identify is positioned
below the field.

12. Create the rest of the fields according to your record layout.

13. After adding the last field, if you want the system to automatically
position the fields in the record, click AUTO POSI TI ON. This
automatically calculates the start position in the record of each field
based on the criteria that each field is positioned directly after the
previous field and is of the length specified in the Max Length box.
Click YES to acknowledge the warning message that fields are
sequenced in order.

It isonly valid to use the Auto Position function if you
@ definearecord tag, and if you define every field in the

record in the sequencethat each field occurs. Please see

page 26 for moreinformation on defining record tags.

14. When you are completely finished adding fields to the record, click
CLOSE. Complete this procedure to add fields to the other records you
defined.

For inbound maps, you may want to use a literal constant to move avalue
into an application field that has no corresponding EDI data (you cannot link
the field directly to an EDI element). Please see Defining Literal Constants
on page 154 for more information on defining constants. Please see Mapping
Literal Constants on page 159 for more information on mapping a constant
to afield.
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Using an EDI File

GENTRAN:Director generates an EDI file for you, based on the standard
(agency), version, transaction set, and release you select. The system
includes all the groups, segments, composites, and elements that are defined
by the standards agency for the version of the document you select. Please
see Creating a New Map on page 18 for more information on generating an
EDI file when you create a new map. You can modify the system-generated
EDI file by modifying the properties of the map components, and using the
promote, split, copy, cut, and paste functions.

However, if you want to use a specialized version of an EDI standard that is
not available in the GENTRAN:Director standards database, it may be
appropriate for you to either load an EDI file definition or definethe EDI file
yourself.

Regardless of whether the system generates the EDI file or you load or
defineit, the specific EDI map components that you use depends on the type
of map you are creating. Thisincludes the standard, version, and transaction
set (document) selected, and which groups, segments, composites, and
elements your company requires. We recommend that you determine which
map components you are using before generating or defining an EDI file.

Verifying EDI

Delimiters If you areusing an EDI standard that contains composite elements or sub-
elements, you must verify that GENTRAN:Director is specifying the correct
delimiters. Delimiters are flags that you define to the system as separating
specific EDI components. Delimiters are necessary for all variable field-
length standards, because the data is compressed (and the leading zeroes and
trailing blanks are removed). Since the fields vary in length, the system
needs aflag to determine where one element ends and another begins. For
example, an element delimiter marks the beginning of a new element.

Although verifying EDI delimitersin
GENTRAN:Director ismandatory only if you are
using a standard with composite elements or sub-

elements, we recommend that you perform thistask
regar dless of which standard you use.
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Complete the following stepsto verify EDI delimiters:

1. Right-click the EDI fileicon and select Properties... from the shortcut
menu to display the EDI File Format Properties dialog.

EDI File Format Properties

Mame |ORDERS
™ Stream segments

—EDI Spntax

Desc IPUHEHASE ORDER MESSAGE

Cancel

¥ Specify defaults

Tag Delimiter I—
Element Delimiter |+—
Segment Delimiter I'—
Sub Element Delimiter I—
Release Character |7—
Decimal Separator I—

Eecond ey

—

Tjan Easitian
ID
Eecond Cengtt

—

Rules...

Pl

[T Eoritains data

Tjam WEelmiter Eas
Element DelimtenFos

Seament DelmtenEas

Suelement Delimiter Fos

Erelease Eharacter Fos

NN RN

ecmalSeparatarn oz

2. Inthe EDI Syntax section, verify that the Specify defaults check box is

sel ected.

3. Veify therequired delimiters for the EDI standard you are using. If the
delimiters differ from the defaults in the table below, type either the
character or the hexadecimal value in the correct box.

4. Click OKto exit the EDI File Format Properties dialog.
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Loading a File
Definition

GENTRAN:Director enables you to load a previously-saved individual file
format definition. This provides you with a quick way to build the EDI or
fixed-format sides of your map. Please see Saving a File Definition on page
38 for more information on saving afile definition.

Loading afile definition replaces the selected side of
the map. Please be certain that isyour intent before
performing thistask.

Complete the following stepsto load afile format definition:

1. Right-click the EDI icon (either the INPUT or OUTPUT side of the
map) and select Open File Definition... from the shortcut menu.

If you already used GENTRAN:Director to generate
an EDI fileor if you created an EDI file on that side of
the map, you are prompted with a message that warns

you that the existing file format isreplaced. Click YES
to continue.

The Open File Definition dialog is displayed.

Open File Definition

Look i |E Bin j gl F
E921_ord.ifd

File pame:  [E921_ord.ifd P
Files of bope: IFiIe Definitions [*1FD] ﬂ Cancel |

2. The“Look in” list should reflect the drive\folder where
GENTRAN:Director isinstaled. The defaultis GENTRAN
Director\BIN. If the current folder is not the correct one, select the
appropriate folder.

3. Select the type of file that you want to display from the Files of Type
list. The default file extension is .IFD.

4. Select the file definition that you want to load into the system from the
list or type the name in the “File name” box.
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5. Double-click the filename or click OPEN to load the selected file format
definition.

Saving a File

Definition GENTRAN:Director enablesyou to save an individual file format definition
so that you can use it as a guide in future maps. This provides you with a
quick way to build the EDI or fixed-format sides of your map. Please see
Loading a File Definition on page 37 for more information on loading afile
definition.

Complete the following steps to save an individual file format definition:

1. Right-click the EDI icon (either the INPUT or OUTPUT side of the
map) and select Save File Definition As... from the shortcut menu. The
Save File Definition dialog is displayed.

Save File Definition

Save jn: Ia Bin j gl FE

File name: |E921_DHD.IFD

Save as hupe; IFiIe Definitions [*IFD ﬂ Cancel |

2. The“Savein” list should reflect the drive\folder where
GENTRAN:Director isinstalled. The default is GENTRAN Director. If
the current folder is not the correct one, select the appropriate folder.

3. Select the name of the file definition from the list or type the name of
the file definition (one to eight characters) in the “File name” box. The
default file extension is.IFD.

4. Click SAVE to save the file definition.
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Modifying
Group
Properties

A group contains related segments and/or groups that repeat in sequence
until either the group data ends or the maximum number of times that the
loop is allowed to repeat is exhausted. If you create a group that is
subordinate to another group, this corresponds to a nested looping structure
(aloop within aloop).

Complete the following steps to modify the properties of a group:

1. Right-click the group you want to modify and select Properties... from
the shortcut menu The Group Properties dialog is displayed.

MName |D2DD_N1

Cahicel |
Description I

Rules... |
Minimum Usage ID I | Brarmnte resnnds boparemt

Fromate |
b axiniun Uzage |2DD Spi.. |

2. If youwant to modify the group name, type the group name in the Name
box.

If a segment/record or element/field occurs morethan
oncein amap it isidentified by itsname <ID>. The
second and subsequent occurrences are identified by
<ID>:n, where“n” isthe number of the occurrencein
the map.

3. If you want to modify the group description, type the new description in
the Description box. This box is used to provide a brief explanation of
the loop.

4. Inthe Minimum Usage box, type the minimum number of times the
loop must be repeated. For a conditional 1oop, the minimum usage
should alwaysbe “ 0" (zero). For amandatory loop, the minimum usage
should be“1” or greater.
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Modifying

5. Inthe Maximum Usage box, type the maximum number of times the

loop can be repeated.

6. Click OK to save the changes to the group.

Seg ment You can modify the properties of any segment, including the minimum and
maximum number of times the segment can repeat, whether the segment is
mandatory or conditional, and whether it isaloop start or loop end segment.
Please see Using Loop Sart and Loop End Segments on page 105 for more
information on using loop start and loop end segments.

Properties

Complete the following steps to modify the properties of a segment:

1. Right-click the segment you want to modify and select Properties...
from the shortcut menu. The EDI Segment Properties dialog is

displayed.

EDI Segment Properties E3

— Identification
Mame IN'I
Cancel |
Desc  [MAME Al |
Tag |N1 [T Use Key Field ke | Eramate |
e Sl |
tin Uzage ID « N maE
€ Loop Start
Max Uzage |1 " LoopEnd

— Special Properties

& Mormal
" Floating

" wildeard

[ Binary

Altermate Tiag I
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2. If you need to modify the name of the segment, type the segment name
in the Name box.

If a segment/record or element/field occurs morethan
oncein amap it isidentified by itsname <ID>. The
second and subsequent occurrences are identified by
<ID>:n, where“n” isthe number of the occurrencein
the map.

3. If you want to modify the description of the segment, type a new
description in the Desc box. This box is used to provide a brief
explanation of the segment that allows you to differentiate it from
similar segments.

4. If you want to modify the segment tag, type the segment identification
code <TAG> in the Tag box. For example, arecord isrecognized by the
system as:

<TAG>[Delimeter]<DATA>[Delimeter] <DATA>......<DATA>
[Segment Terminator]

The segment TAG for each segment enables the system to recognize
that segment.

5. Inthe Min Usage box, type the minimum amount of times the segment
must repeat.

If theMin Usage box containsa“ 0" (zero), the segment
is“conditional.” If the Min Usagebox containsa*“1” or
greater, the segment is“mandatory.”

6. If youwant the segment to repeat (Ioop), type the maximum amount of
timesit can repeat in the Max Usage box.

7. Unlessyou want to indicate that the segment is the beginning of aloop
(Loop Start) or the end of aloop (Loop End), accept the default of
Normal for the Normal/Loop Start/L oop End options. These options are
defined as follows:

Normal = Thissegment isintheloop but is not the beginning or
ending segment

Loop Start =  This segment marks the beginning of the loop

LoopEnd = This segment marks the end of the loop

8. Click CK to save the changes to the segment.
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Modifying
Composite
Properties

A composite is a data element that contains two or more component data
elements or sub-elements. You can modify the composite name and
description, and whether or not it is mandatory.

“ Composite elementsare only used for EDI maps.

Complete the following steps to modify the properties of a composite;

1. Right-click the composite you want to modify and select Properties...
from the shortcut menu. The Composite Properties dialog is displayed.

Composite Properties E3

Marme |cooz

Description I Cahcel |

2. If you want to change the composite name, type the data element
identification number in the Name box.

If a segment/record, composite, or element/field occurs
morethan oncein a map it isidentified by itsname
<ID>. The second and subsequent occurrencesare

identified by <ID>:n, where“n” isthe number of the
occurrencein the map.

3. Click the Mandatory check box to indicate whether this composite must
be present.

4. If you want to change the composite description, type the new
description in the Description box.

5. Click CK to save the changes to the composite.
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Modifying
Element Each segment or composite contains a group of logically-related elements.
Pro pe rties These elements define the structure of the EDI data that your system needs
to process the document.
Complete the following steps to modify the properties of an element:
1. Double-click the element you want to modify to access the Field
Properties dialog.
Name 2380 Ll
Description — [DATE/TIME/PERIOD Cancel |
[rata v alidation Advanced »» |
Min  Max  Type Format =
{I‘ Mendatoy [& [ | [ovtm =] [vMmoD =] 4|E°ndm°ns"'

2. To change the name of the element, type the new namein the Name box.
The name is typically the element sequence number.

If a segment/record or element/field occurs morethan
oncein amap it isidentified by itsname <ID>. The
second and subsequent occurrences are identified by
<ID>:n, where“n” isthe number of the occurrencein
the map.

3. To change the description of the element, type the new description in the
Description box. The description is used to provide a brief explanation
of the element that allows you to differentiate it from similar elements.

4. If you want to designate the element as “mandatory” (must be present),
click the Mandatory check box.

5. To change the minimum length of the element, type the minimum length
in the Min box. If the data is less than the minimum length, a
compliance error is generated when trand ation occurs.

6. To change the maximum length of the element, type the maximum
length in the Max box.
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7. Fromthe Type list, select the type of the element. Valid values are:

String = aphanumeric element
Number = numeric or real element
Dt/Tm = dateor time element

8. From the Format list, select how the data element ID is formatted. The
choices for this field depends on the type of the element you selected
from the Typelist. If you choose Number or Dt/Tm in the Type box, you
can select the data format from the Format list. If you selected String
from the Type box, you should type a syntax token to denote that this
element must be formatted as the specified syntax token dictates (the
default syntax token is“X"). Please see Using Syntax Tokens on page 77
for more information on defining and using syntax tokens.

9. Click OK to save the changes to the element.

When GENTRAN:Director generates the EDI sides of the map, the system
includes all the groups, segments, composites, and elements that are defined
by the standard agency for the version of the document you selected. The
system activates all the groups, segments, composites, and elementsthat are
defined as “mandatory” (must be present) by the standard. The system does
not enable you to deactivate the mandatory groups, segments, composites,
and elements.

When translating data, the system does not process groups, segments,
composites, and elements (or records and fields) that are not activated.
Therefore, you must activate the groups, segments, composites, and
elementsthat are not defined as mandatory by the standard, but that you have
determined that you need to use in mapping.

Asan alternative to activation, you can use the Auto
Trim featureif you have a sample EDI file defined.
Please see Using Auto Trim on page 46 for more
information on the Auto Trim feature.
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Complete the following steps to activate groups, segments, composites, and
elements:

1. Select Activation from the Functions menu or the Main Toolbar.

Asan alternative to opening each map component
(steps 2, 5, and 7), you can select Expand All from the

View menu to open every map component. You can
also select amap component and select Expand Branch
from the View menu to open that map component.

Open (double-click) each group that contains segments or groups that
need to be activated.

Click each inactive group that you need to use. This activates the
groups.

If you accidentally click a group, segment, composite,
or element that you did not mean to activate, right-

click the map component and select Deactivate from
the shortcut menu.

Click each inactive segment that you need to use. This activates the
segments.

Open (double-click) each segment that contains composites or elements
that need to be activated.

Click each inactive composite that you need to use. This activates the
composites.

Open (double-click) each composite that contains elements that need to
be activated.

Click each inactive element that you need to use. This activates the
elements.

Once you have activated all the necessary groups, segments, and
elements, click the Activation button on the Main Toolbar to turn
activation mode off.
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Using Auto
Trim

Instead of activating map components manually, you can use the Auto Trim
feature to modify the EDI side of the map according to asample EDI file that
you select (you must have previously created this EDI fil€). Thisfeature
examines the EDI file that you specify and then activates and deactivates
map components on the EDI side of the map, so that the two files match. The
sample EDI file must be the same standard, version, and transaction set
(message) as the map for Auto Trim to match map components. To use Auto
Trim, you must define the Segment and Element Delimiters. If you do not
supply the Tag Delimiter, the system substitutes the Segment Delimiter. If
you want to use composite elements, you must specify the Sub Element
Delimiter. If you want to use release characters, you must specify the
Release Character. Please see Verifying EDI Delimiters on page 35 for more
information on specifying EDI delimiters.

The sample EDI file must be compliant and must not
contain envelope segments.

Complete the following steps to use Auto Trim:

1. Select amap component on the EDI side of the map. The EDI side of
the map must be selected for the Auto Trim function to be available.

2. Select Auto Trim from the Functions menu. The Auto-trim Sample EDI
Filedialog is displayed.

Auto-trim 5ample EDI File EE3
Lookin: | Bin =] ok e =
Archive, exe ':ﬂ Dirgen.exe Genmag.dil @ M apper.ex
CLAPICTO.dI e dimgrexe Gensec.dl MEEwntl0
a Commpost. exe # Fomz.exe @ Gentran.hip Mbfile10.d
Canfig exe FSEwnt10.dl & Giorm hip MEMAPII

CTT 288 tmp GienComPC.dl Gimapper.gid A MClient.ex
CTT241.tmp GenComUldl @ Gmapperhip Mercuil 0.

L« | i

File harmne: I"."

Filez of bype: IAIIFiIes[“."] ﬂ Cancel |

3. The“Look in” list should reflect the drive\folder where the EDI fileis
stored. The default is GENTRAN Director\BIN. If the current subfol der
is not the correct one, select the appropriate subfolder.

4. If necessary, select the type of file that you want to display from the
Files of Typelist.
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5. Select thesample EDI filethat you want to load into the system from the
list.

6. Double-click the filename or click OPEN to begin the auto trim process.
When auto trim is complete, the system displays a message stating
whether or not auto trim was successful. Click OK to acknowledge the
message.

Promoting

Grou ps an d  The Promote function extracts one iteration (instance) of a group or
Re pe atin g repeating segment. This enables you to map unique data from your
application file, and/or enter a specialized definition. GENTRAN:Director
Seg ments specifies that only one-to-one (no loops) or many-to-many (loop) mapping
relationships are valid.

You can use the Copy and Paste functions (and change the number in the
maximum usage box) to accomplish the same task. However, Promoteisa
specialized function that guarantees the integrity of your EDI structure.
Depending on the circumstances, you may use the Split or Copy/Cut and
Paste functionsinstead. Please see Slitting Groups and Repeating Segments
on page 50 for more information on splitting groups and repeating segment.
Please see Using Copy, Cut, and Paste on page 54 for more information on
copying, cutting, and pasting.

The Promote function isonly availableif a group or
repeating segment is selected.

Complete the following steps to promote a group or repeating segment:

1. Highlight the group or repeating segment from which you want to
extract oneiteration.

2. Click the PROMOTE button on the Main Toolbar. This extracts one
iteration (instance) of the looping structure.

Outbound |n thisexample, your application file contains a Ship To record that groups
Example all the shipping information and a Bill To record that groups all the billing

information. Your Ship To and Bill To records both occur only once in the
application. The EDI file contains a N1 group (for ANSI) or aNAD group
(for EDIFACT) that repeats 200 times. If the Entity Identifier Code of the
N1/NAD is“BT,” that means the NI/NAD group contains billing
information. If the Entity Identifier Codeis*”ST,” the NI/NAD group
contains shipping information.
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Complete the following steps to map unique data to your application file:

1

Activate the NI/NAD loop and the appropriate segments and €lements,
if you have not already done so. Please see Activating EDI Map
Components on page 44 for more information on activating. If you
already activated the NI/NAD group, just highlight it.

Click the PROMOTE button on the Main Toolbar to extract asingle
instance of the NI/NAD group.

Select Properties from the Edit menu to access the Group Properties
diaog.

Hame |D1DD_N1:2

Cancel |
Dezcription I

Erules.. |
tinirum Lzage IEI v ‘Promote records to parent

Hramate |
I axirmurn Usage |1 el |

In the Description box, type a specialized definition to identify this
group as containing billing information.

Click OK to save the change and exit the Group Properties dial og.

Highlight the original N1I/NAD group (that now repeats 199 times)
again.

Click the PROMOTE button on the Main Toolbar to extract another

single instance of the NI/NAD.

Select Properties from the Edit menu to access the Group Properties
dialog.

Narme |oroo_w1:3

Caticel |
Drescription I

Hiles |
tinimum Uzage ID W Promate records o parent

Eramate |
hd axirmumn U zage I'I el |
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9. Inthe Description box, type a specialized definition to identify this
group as containing shipping information.

10. Click OK to save the change and exit the Group Properties dialog.

11. Click the DEACTI VATE button on the Main Toolbar and then click the
original NI/NAD group (that now repeats 198 times), so the system
does not processiit.

12. Now you can link the elements in the single occurrence of the NI/NAD
that contains billing information to the fieldsin your Bill To application
record. And, you can link the elements in the single occurrence of the
N1/NAD that contains shipping information to the fields in your Ship
To application record.
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Splitting Groups The Split function enables you to split (break) a group or repeating segment

and Repeating
Segments

into two loops. You typically use this function when you need more than one
instance of the same map component that still occurs multiple times.

You can use the Copy and Paste functions (and change the number in the

maximum usage box) to accomplish the same task. However, Splitisa
specialized function that guarantees the integrity of your EDI structure.

The Split function isonly availableif a group or
repeating segment is selected.

Complete the following steps to split a group or repeating segment:

1

2.

Highlight the group or repeating segment from which you want to
extract oneiteration.

Click the SPLI T button on the Main Toolbar. The Split dialog is
displayed.

Split E

First Loop Entries IU

Cancel |

In the First Loop Entries box, type the number that indicates the
seguential number of iterations where you want the group or repeating
segment split. For example, if the X 1oop repeats a maximum number of
5 times, and you type “2” in the First Loop Entries box, the resulting
split generates one X loop that repeats a maximum of 2 timesand a
second X loop that repeats a maximum of 3 times.

number of iterations of the loop.

Thenumber you enter in the First Loop Entriesbox
must be greater than zero and less than the maximum

4. Click OKto exit the Split dialog.
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Outbound

In this example, your application file contains an Allowance record that

Example groupsall the allowance information and a Charge record that groups all the

charge information. Your Allowance and Charge records can repeat up to
five timesin the application file. The EDI file contains a AL C repeating
segment that repeats 10 times. If you split the ALC segment in two, you can
map allowance information directly to your Allowance application record
and map charge information directly to your Charge application record.

Complete the following stepsto split the ALC segment:
1. Activatethe ALC segment and the appropriate elements, if you have not

already done so. Please see Activating EDI Map Components on page
44 for moreinformation on activating. If you already activated the ALC
segment, just highlight it.

Click the SPLI T button on the Main Toolbar. The Split dialog is
displayed.

S plit

First Loop E ntries IEI

In the First Loop Entries box, type “5.” Thisisthe number of sequential
iterations where you want the repeating segment split.

4. Click OKto exit the Split dialog.
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5. Select Properties from the Edit menu to access the EDI Segment

Properties dialog.

EDI Segment Properties E3

— |dentific.ation

Mame I."—".LC

oK

Cancel

Desc IALLDW&NEE OF CHARGE

Rules...

f

Fromate

Max Usage |5 " LoopEnd

Tag [ALC ™ UsekeyField  feoficld |
i~ Looping
tin Uzage ID 0 N maE
' Loop Start

— Special Properties

= MNomal I~ Binary
" Floating

" ildzard Elterriate Tag I

Spit...

i

6. Inthe Desc box, type a specialized definition to identify this segment as

containing allowance information.

7. Click OK to save the change and exit the EDI Segment Properties

diaog.

8. Highlight the original ALC segment (that now repeats 5 times).
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9. Select Properties from the Edit menu to access the EDI Segment

10.

11

12.

Properties dialog.

EDI S5egment Properties

— ldentification

oK
Mame |ALC:2
Cancel |
Desc |ﬁ3«LLDWANEE 0OR CHARGE Fules |
Tag [ALC ™ Use Key Field faer Eeld.. | Pramate |

~Leerti Split... |
Yl ID—
" Loop Start

taw sage |5  LoopEnd

— Special Properties

& Mormal [ Einamy
' Floating

Cwildeard Giltermaterjaa I

In the Desc box, type a specialized definition to identify this segment as
containing charge information.

Click OK to save the change and exit the EDI Segment Properties
diaog.

Now you can link the elements in the ALC segment that contains
allowance information to the fields in your Allowance application
record. And, you can link the elementsin the AL C segment that
contains charge information to the fields in your Charge application
record.
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information in the map. You may need to use these functionsif you are using
an EDI standard differently, or if you need to create nested looping
structures.

You can cut or copy a single map component (loop, segment, composite,
element, record, or field) and paste it in another location in the map. Copied
map components retain all the information of the original map component. If
the copied map component contains subordinate map components (like a
segment contains subordinate elements), the subordinate map components
are also copied.

You can also cut, copy, and paste a map component from one map to another.
Complete the following steps to cut, copy, and paste a map component:

1. Select the map component that you want to cut or copy.

2. Click the Copy button on the Main Toolbar.

3. If you are pasting the map component in another map, open that map, if
itis not already open. Please see Opening a Map on page 57 for more
information on opening a map.

4. Select the map component that you want the cut or copied selection
pasted after.

If you cut or copied an EDI component, you can only
paste that component into the EDI side of a map.
Conversdly, if you cut or copied a positional

component, you can only pastethat component intothe
positional side of a map.

5. Select Paste from the Edit menu or the Main Toolbar to paste the
contents of the Clipboard. If the map component that you selected isa
group, GENTRAN:Director prompts you to specify whether you want
the contents of the Clipboard pasted as a child (subordinate) of the
group or pasted at the same level as the group. Select the appropriate
option and click OK.

GENTRAM:Director - Application Integration

The contents of the clipboard can be pasted as fallows:

9 Pazte Options Cancel |

¥ Paste az a child of the selected item

" Paste after the selected item [t the same level]
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Example Inthisexample, you are defining an ANSI X12 Ship Notice/Manifest (856).
When the system generates the 856 document, it contains one HL group. The
HL group identifies dependencies between and the content of hierarchically-
related groups of segments.

However, for your EDI file, you need to define additional levels of detail
information. The details that you need to define include shipment, order, and
lineitem information. In order to modify the structure of your EDI fileto
accommodate these requirements, you need to use the Copy and Paste
functions to create a nested looping structure for the HL group.

Complete the following steps to create a nested |ooping structure:
1. Highlight the HL group. Click the Copy button on the Main Toolbar.
2. Select Properties from the Edit menu to access the Group Properties

dialog.
Name [oro0_HL
Cancel |
Dezcription I
Rules... |
Miriraum Uzage |1 = Framate records o parent
Prarnote |
Maxirurn Usage |2DDDDD St |

3. Inthe Description box, type a specialized definition to identify this
group as containing shipment information.

Click OK to save the change and exit the Group Properties dialog.

Select the map component in the HL that you want the nested HL group
(order information) pasted after.

6. Click the Paste button on the Main Toolbar to paste the contents of the
Clipboard. The second HL group is added as a nested loop to the
original HL loop.
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7.

10.
11.

12.

13.

14.

15.
16.

Select Properties from the Edit menu to access the Group Properties
dialog for the second HL group.

Group Properties E

Narme |o1o0_HL:2

Cancel |
Dezcription I

Rules... |
Minirum Uzage |1 = Framate records b parent

Framate |
Maxirnurn Usage IZDDDDD Spli. |

In the Description box, type a specialized definition to identify this
group as containing order information.

Click OK to save the change and exit the Group Properties dialog.
Double-click the second HL group (order information) to open it.

Select the map component in the HL that you want the nested HL group
(item information) pasted after.

Click the Paste button on the Main Toolbar to paste the contents of the
Clipboard. The third HL group (item information) is added as a nested
loop of the second HL group.

Select Properties from the Edit menu to access the Group Properties
dialog for the third HL group.

[ x]

Group Properties

Narme |o100_HL:3 : .

Cancel |
Drescription I

Rulez. .. |
Finimum Usage |1 = Promste renards b parent

Promate |
td axirmum U zage |2EIEIEIEIEI Split |

In the Description box, type a specialized definition to identify this
group as containing line item information.

Click OK to save the change and exit the Group Properties dial og.

Now you can activate the appropriate groups, segments, and elementsin
the new HL nested |ooping structure. Please see Activating EDI Map
Components on page 44 for more information on activating.
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Opening a Map

Opening amap loadsit into GENTRAN:Director and enables you to view or
edit it. GENTRAN:Director alows you to have multiple maps open, but
only one map has focus.

Complete the following steps to open a map:
1. Select Open from the File menu to display the Open dialog.

Open
Lookin: | {8 Maps = ==
a1 Header. map o Pet_tiny.map

@ Header_t.map @ Pet_tord.map
@ Pet_810.map

@ Pet_850.map

@ Pet_eirv.map

Type or select the file ] Pat_sard map

name of the map you
want to open

File nane: I

Filez of type: IMaps [*.map) j Cancel |

2. The“Look in” list should reflect the drive\folder where
GENTRAN:Director isinstalled. The default is GENTRAN
Director\BIN\Maps. If the current folder isnot the correct one, select the
appropriate folder.

3. Select thetype of filethat you want to display from the Files of typelist.
The default file extensionis .MAP.

4. Select the map that you want to load into the system from the list or type
it in the “File name” box.

5. Double-click the filename or click OPEN to open the selected map.
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The Save function writes (saves) the currently selected map to disk. If the
map was saved before and you completed the Translation Object Details

dialog, complete the following step to save the current map:

1. Select Save from the File menu or the Main Toolbar. The system saves
the current map under the same name that it was previously saved as.

To save a new map, complete the following steps:

1. Select Save from the File menu or the Main Toolbar. The Trandation

Object Details dialog is displayed.

Transzlation Object Details

— Summary
Author Dezcription Tranzlation Object Function

Syztem

I I IEHDDIt

= rC

E

Cancel |

—Werzion Contral

M ajor wergion IEI Minor wergion IEI Eompilednnl

— EDI Azzociations

InpLat Output

Agency IE_ IEdifact I_ I

Yersion |09an1 |ED|FMT 1992 REL

Transaction  [DRDERS | [PURCHASE DRDE

|

|
Release IEI_ I_

|

F Giroup |DHDEHS |

2. Complete the Author box. This box typically contains the name of the

person who created the map.

3. Complete the Description box. This box must be unique becauseit is
used by the system to identify the map. We recommend that you use
some combination of the following identifying characteristics: the type
of map (e.g., Import, Export), the partner that this map is used for, and
what type of transaction (document) this map uses. For example,
“Export 850 MWT” isthe description of an export map for an ANSI

Purchase Order (850) for partner MWT.

4. Verify that the correct type of map is selected in the Trandlation Object

list.
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5. Click the System check box if you want to designate thisform as a
system tranglation object (one that is used internally by the system).

You should select thischeck box only if you arecertain
you want to definethistranslation object asa system
translation object. Once a translation object is

registered with GENTRAN:Director, it cannot be
deleted.

6. Completethe Major and Minor boxesif you want to designate aversion
number for this translation object. Type the version number in the Major
box and the release number in the Minor box.

7. TheInput and Output boxes (Agency, Version, Transaction, Release,
and F Group) contain information only if the Input and/or Output sides
of the map are of EDI format. You can change the information in these
boxes, but it does not ater the content of the map. You may wish to alter
these boxes if, for example, you want the map to reflect a standards
version that is not loaded on your system. You can change the version
on this dialog, and then alter the map to be compliant with that version.

8. Click OKto save the translation object details and access the Save As
dialog.
Save As EHE
Save jr Ia Maps j gl i =

File name: — [PET_EORD.map

Save as lwpe: IMaps [*.map] j Cancel |

9. The"Savein” list should reflect the drive where GENTRAN:Director is
installed. The defaultis GENTRAN Director\Maps. If the current folder
is not the correct one, select the appropriate folder.

10. Type the name of the map (oneto eight characters) in the “File name”
box. The default file extension is .MAP.

11. Click SAVE to save the map.
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Naming a Map

You allocate afilename to a map when you save the map for thefirst time or
use the Save Asfunction to save a copy of the map under a different name.
The name of the map must be 1-8 unique characters that definethemapin a
meaningful way. For example, “850 MWT.MAP” isthe name of a map for
an inbound ANSI Purchase Order (850) for partner MWT.

The naming conventionsin GENTRAN:Director are as follows:
B The source map (map created in GENTRAN:Director) should be named
using the file extension .M AP (i.e., MWT_850.MAP)

B The compiled translation object (trand ation object that is the result of
compiling the source map) should be named using the same filename
that was allocated to the source map BUT with the file extension . TPL
(i.e, MWT_850.TPL)

We recommend that you use these naming convention to distinguish source
maps and compiled translation objects from other types of files. We also
recommend that you use the same filename (different file extension) for a
source map and the translation object that was compiled from it.

Be very careful not to overlay the source map with the
compiled translation object. Usethe . TPL fileextension

to distinguish the translation object.
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Complete the following stepsto save a copy of the current map under a
different name;

1. Select Save As... from the File menu to display the Save Asdialog.

Save As 7] ]
Save jn: IEMGDS j gl I: £

File name:  |PET_EORD.map

Sawve az upe; IMaps [* map) ﬂ Cancel |

2. Inthe“File name” box, type the name of the map copy (using the
default .MAP file extension) and click SAVE to save the map copy
under the new name and exit the Save As dialog.
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Compiling a Map

The Compile function compiles the map and creates atrandation object. The
map that you create using GENTRAN:Director is a source map. When that
source map is compiled, the result is a compiled trand ation object.

This translation object needs to be registered with the GENTRAN:Director
system before you can use it. You use the Compile function after the map is
completed and saved. Please see Saving a Map on page 58 for more
information on saving a map.

Complete the following steps to compile a map and generate atranslation
object:

1. Select Compile from the File menu or the Main Toolbar to display the
Run-Time Tranglation Object Name dial og.

Run-Time Tranzlation Object Hame

Save in: Ia Tranz0bj

File nane: IPET_EDHD.TPL

Save as hpe: ITransIation Objects . TPL] j Cancel |

2. Typethe name of the translation object in the “File name” box. The
name of the trangl ation object is 1-8 characters. Usethe default . TPL file
extension.

We recommend that you name the translation object (.TPL file) the
same filename (one to eight characters long) as you named the map
(.MAPfile). Preserving the same filename (with different file
extensions) means that the relationship between the source map and the
compiled translation object remains evident. For example, if the source
map nameis MWT_850.MAP, the compiled translation object name is
MWT_850.TPL.
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Be very careful not to overlay the source map with the
compiled trandation object. Usethe . TPL fileextension
to distinguish the translation object.

From the “Savein” list, change the drive\folder where the compiled

translation object is stored, if necessary.

Do NOT store the compiled trandation object in the
GENTRAN Director\RegTransObj folder. Thisfolder
isreserved for storing a copy of each translation object
you register with GENTRAN:Director.

4. Click SAVE and the system compiles the map and generate atrang ation
object. The Compile Error dialog is displayed. Verify that no errors
occurred and click OK to exit the dialog. The date that the translation
object was compiled on is automatically loaded into the “Compiled on”
box on the Translation Object Details dialog.

Translation Object Details

— Summary

Author Dezcription Tranzlation Object Function System

ISterIing |T E 92.1 ORDERS Expart IEHpolt =] r

Cancel |

—Werzion Control

b ajor wersion |1 Minor wersion ID Compiled on |11-Sep-1 995

— EDI Aszociations

Agency IE_ IEdifact I_ I

Input Output

Yersion |DE|2IZIIZI1 |EDIFAI:T 1992 REL

Tranzaction IUHDEHS IUFH:H.-’-\SE ORDER

|

|
Release ID_ I_

|

F Group |DF|DEF|S |
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5. Select Save from the File menu to save the source map with the
Compiled on date.

6. Thetrandation object needs to be registered with the
GENTRAN:Director system before you can use it. See the
GENTRAN:Director User’s Guide for information on registering a
translation object.
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Printing a Mapping Report

The Print function enables you to print a mapping report for the current map.

You can print amapping report to a file by selecting
Print to File... from the File menu. Changethe defaults
on the Print Optionsdialog and click OK to display the
Print to File dialog. Type the name of the fileto which

you want thereport printed and click CK.

Complete the following steps to print a mapping report.

1. Select Print from the File menu or the Main Toolbar to access the Print
Options dialog.

Print Options E

— Report sections

V¥ Piint branching diagram -
¥ Print record details Cancel |
¥ Print mapping details

¥ Print extended rules

V¥ Print code lists

™ Include only active objects

2. Select the reports that you want by clicking the appropriate check boxes
in the Report section. Click OK and the Print dialog is displayed.
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3. Set the appropriate options. Click OK if you do not need to change
Setup options, and the mapping report is printed.

Click SETUP... if you need to access printer setup information (to select
a specific printer, paper orientation, or size and source of paper). The
Print Setup dialog is displayed.

4. Set the appropriate options. Click OK if you do not need to change Print
Options (dithering, intensity control, or print true type as graphics), and
you return to the Print dialog. Click OK on the Print dialog and the
mapping report is printed.

Click OPTI ONS... if you need to access printer setup options
information. The Options dialog is displayed.

5. Setthe appropriate options. Click OK to return to the Print Setup dialog.
Click OK on the Print Setup dialog to return to the Print dialog. Click
OK on the Print dialog and the mapping report is printed.
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Formatting Your Data

When you define or modify afield or element, you must specify the type and
format. The options that are available for the format of the field or element
depend on which type you select (string, number, or Dt/Tm).

Using the String

Type A string-type field or element contains one or more printable characters. If
you specify that afield or element is a string type, you must designate the
format by specifying a syntax token.

Syntax tokens enable you to designate a “token” that defines ranges of
characters and numbers that are allowed to be used for a string-type element
or field. You can then use the syntax tokens in the Format field of the Field
Properties dialog. This enables you to define the type of characters to be
used while compliance checking each element/field (e.g., a phanumeric
within a certain range or numeric within a certain range).

Creating a Syntax Complete the following steps to create a syntax token:

Token (Western When you set up atoken, it applies only to that form.
European You may need to set one up for each form that you

languages) create.

1. Select Syntax Tokens from the Edit menu to display the Syntax Tokens

diaog.
Syntax Tokens E
Token  Allowed character ranges
& A az
N 09..-++ . 2
* AZaz09 ++ [[]]::a’.n"°/o°/o\'\!!""$$”“&&7_’—\
Click New... Mew... |
Change... |
Delete |
Ll | | _,I [WEIEEL. |

The Token column contains the value designated as the syntax token for
each existing syntax token. The Token contains arange of characters
that, when applied to an element, dictate the way that element must be
formatted. If the element is not formatted as specified, the system
generates a compliance error.
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The Allowed character ranges column contains the ranges of characters
that are permitted for each existing syntax token. Each range consists of
apair of characters that define the start and end characters.

The DBCS... button isonly availableif you are

executing a double-byte version of Windows NT.

2. Click NEW.. to access the Edit Syntax Token dialog.
Edit Syntax Token

Type a one-
character token Tok

— Character Ranges

Cahicel
Start End

Mew —— Click New...
Change...

Delete

=N

]
[ Ger. |
[ Bz |

3. Inthe Token box, type the unique one-character alphanumeric value that
the system recognizes as containing the allowed range of charactersyou
designate.

The Token can only be one unique character, upper- or
lower -case alphabetic or numeric“1” -“9".

The Character Ranges list contains the character range or ranges that
you define for this token. You can define more than one character range
for each token. For example, you can define the token “A” asalowing
the character range “A” through “Z” and the character range “a”
through “z". Thisindicates that token “A” only allows upper-case and
lower-case alphabetics.
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4. Click the NEW.. button on the Edit Syntax Tokens dialog. The Edit
Character Range dialog is displayed, which enables you to create a
character range.

Edit Character Range

Start character

Type the range of

characters End-charactar

GENTRAN:Director usesthe ANSI Character Set

when determining the start-end range.

For Western European languages, consult the ANS

character chart (1252 Windows L atin 1). Thischart

also displaysranges so that you can enter appropriate

ranges for the charactersin your language. If no chart

isavailable, usethe following guidelines:

B Toincludeall the accented charactersin the major
languages of Western Europe, add the following

GENTRAN:Director Application Integration User’'s Guide

ranges.
Start End
0xCO 0xD6
0xD8 OxF6
OxF8 OxFC

M Scandinavian user sshould also add thefollowingin

order toinclude CE and ce

Start End
0x8C 0x8C
0x9C 0x9C
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5.

In the Start character box, type the character that begins the allowed
token range. For example, if the character range you want to defineis
“B” through “D,” type “B” in the Start character box. If you type a
character, such as &, that is not accepted, you need to enter it in hex
code. To enter hex characters, “0(zero)x” or “0X,” followed by the hex
code. For example, the hex equivalent of éis OXE9.

The Start character and End character can only beone
() character, upper - or lower-case alphabetic or

10.

numeric“1” -“9.”
In the End Character box, type the character that terminates the allowed
token range. Use the guidelines from step 5.
Click OK to return to the Edit Syntax Tokens dialog.

To add additional character ranges to the syntax token, repeat steps4 - 7
as many times as necessary.

Click OK to save the syntax token and return to the Syntax Tokens
dialog.

Click CLOSE to exit the Syntax Tokens dial og.

Creating a Syntax The DBCS syntax token function enables you to create a map that accepts
Token (Far Eastern double-byte characters. If you are running GENTRAN:Director on a
languages) Chinese, Japanese, or Korean version of Windows NT, the DBCS button on

the Syntax Tokens dialog is available.

DBCS tokens are displayed only in the DBCS Syntax Tokens dialog, not in

thelist in the Syntax Tokens dialog.

When you set up a DBCStoken, it appliesonly to that
map. You may need to set one up for each map that you

create.
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Complete the following stepsto create a DBCS syntax token:
1. Select Syntax Tokens from the Edit menu to display the Syntax Tokens

dialog.
Syntax Tokens E
Token  Allowed character ranges
A Alaz i
N 09, --++ =
* AZaz09 - [[[) AR R
Mew...
Change... |
Delete |
Click DCBS + | { | DEEE. .

2. Click DCBS to access the DCBS Syntax Token dialog.

Token

ey —— Click New

Chanee.. |
[Iel=te |
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3. Click NEwto access the Edit DBCS Syntax Token dialog.

Edit DB

Token |

Lead-Byte on - Cancel

(F

Trail-Bytes

Il
10/ 1

-

=t

=
=
fl el (=1 ('

OEEEa=

—., '||-P‘ﬁ = |2 2o r-a §‘-PE

i | o] o

==

=

= |
ey EEaaN=s
e =e T s=On==

ol e
=

el
| o s
= e

e g s
e e o
‘-H; o |-H>< e ’HH-E
S e

=
-F Sl 1 | -F[D
-

==
-

Double-byte characters are composed of a lead byte
and atrail byte. In the above example, the character A

iscode point 0041.

In the Token box, type the unique one-character al phanumeric value that
the system recognizes as containing the allowed range of charactersyou
designate.

Do you want to include all charactersin the Trail-Bytes section of the
dialog?
If yes, continue with step 7.

If no, continue with step 6.

Usethe Lead-Bytelist to view other charactersin the code page on your
system. To exclude individual characters or groups of characters from
the token, select them (grey them out).

Click CLOSE to save the syntax token and return to the Syntax Tokens
dialog.

Click CLOSE to exit the Syntax Tokens dial og.
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Editing a Syntax Complete the following steps to edit a syntax token:

Token 1. Select Syntax Tokens from the Edit menu to display the Syntax Tokens
diaog.
Token  Allowed character ranges
|A Al az | Close I
N 09 --++

Select a syntax

Change... |

Defete
q | [ DEEEE |
Click Change...

The Token column contains the value designated as the syntax token,
for each existing syntax token. The Token contains arange of characters
that, when applied to afield/element, dictate the way that field/element
must be formatted. If the field or element is not formatted as specified,
the system generates a compliance error.

The Allowed character ranges column contains the ranges of characters
that are permitted for each existing syntax token. Each range consists of
apair of characters that define the start and end characters.
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Select the range
you want to
edit

2. Select asyntax token and click CHANGE... to access the Edit Syntax

Tokens dialog.
Edit Syntax Token E3

Taken IX_ 0k |
Cancel |
Start End

A Z - New... |

— Character Ranges

Click
Change...

+ + LI Delete |

If you want to change the token value, type the unique one-character
alphanumeric value that the system recognizes as containing the
allowed range of characters you designate in the Token box.

The Character Ranges list contains the character range or ranges that
you defined for thistoken. You can define more than one character
range for each token. For example, you can define the token “A” as
allowing the character range “A” through “Z” and the character range
“d’ through “z.” Thisindicates that token “A” alows upper-case and
lower-case al phabetics only.

Select the character range you want to modify and click CHANGE... on
the Edit Syntax Tokens dialog. The Edit Character Range dialog is

displayed.
Edit Character Range E3

Start character ID : i
End character IEI Cancel |

In the Start character box, type the character that begins the allowed
token range.

In the End Character box, type the character that terminates the allowed
token range.

Click OK to return to the Edit Syntax Tokens dialog.
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8. To edit additional character ranges for this syntax token, repeat steps 4 -
7 as many times as necessary.

9. Click OKto save the syntax token and return to the Syntax Tokens
dialog.

10. Click CLOSE to exit the Syntax Tokens dialog.

Deleting a Syntax You can deleteasyntax token from the system. You can also delete a specific
Token character range from a syntax token.

Complete the following steps to delete a syntax token:
1. Select Syntax Tokens from the Edit menu to display the Syntax Tokens

dialog.
Syntax Tokens E2
Token  Allowed character ranges
Select the token & 2= [ Cose |
ﬁzllJe},(Vaam to (I Aizaz05 —++ L o

Change... |
Delete |

N o

Click Delete

2. Highlight the token that you want to delete and click DELETE.

@ The selected entry is deleted without war ning.
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Complete the following steps to delete a character range from a syntax

token:

1. Select Syntax Tokens from the Edit menu to display the Syntax Tokens
dialog.
Syntax Tokens E2

Token  Allowed character ranges

Select a syntax
token

Click Change...

2. Select asyntax token and click CHANGE... to access the Edit Syntax
Tokens dialog.

Edit Syntax Token E2
Token IX_ ok |
— Character Ranges e |
Stark End
n& Z Y
Select the character 5 N Ll

range you want

—(o 3
Change...
to delete - : _ Chenge._|

—— Click Delete

3. Highlight the character range that you want to delete and click DELETE.
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Using Syntax You can use syntax tokens in the Format box of the Field Properties dialog.
Tokens Thisenablesyou to designate a “token” that defines ranges of characters
and/or numbersthat are allowed to be used for a string-type element or field.
The use of a syntax token enables you to define what characters should be
used while compliance checking this element/field (i.e., alphanumeric within
acertain range, numeric within a certain range, etc.).

Complete the following steps to use syntax tokens:

1. Double-click an existing element or field, or create a new element or
field. Please see Using a Fixed Format File and Using an EDI Filefor
more information on creating fields and elements. The Field Properties
dialog isdisplayed.

Field Properties E2
Name o352 oK |
Description IDESCHIPTIDN Cancel |

D ata Validation Advanced > |
Min  Max  Tupe Forrnat ——
tions...
[ Mandatory I‘I Ign IString j Ix ﬂl

2. Fromthe Typelist, select String. Thisindicates that the element/field
contains characters.

3. Inthe Format box, type an existing syntax token to denote that this
element/field must be formatted as the specified syntax token dictates.
Please see Creating a Syntax Token (Western European languages) on
page 67 for more information on creating syntax tokens.

4. Click OKto exit the Field Properties dialog.
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Number Type

Field Properties E2
Mame I0351 ar. |
Description — |TOTAL INVOICE AMOUNT Cancel |

D ata Yalidation Advanced >> |
Min  Max  Tupe Forrnat ——
onditions... |
W Mandatory I‘I I'ID INumber j |N2 j

A number type field or element contains either an implied decimal or real
number that can be mathematically manipulated. If you specify that afield or
element is a number type, you must designate the format by specifying a
format of either “N” (implied decimal) or “R” (real) and the number of
decimal places.

An“N” formatted number is anumber that has an implied decimal point
(eg., “2.01" isformatted as“201"). An “R” formatted number has an
explicit decimal point (e.g., “2.01" is formatted as “2.01"), and truncates
trailing zeroes. Whether you use the“N” or “R” format depends on the
requirements of your application. Regardless of whether you use the “N” or
“R” format, you must also indicate the number of decimal placesin thefield.

Complete the following steps to use the number type:

1. Double-click an existing element or field, or create a new element or
field. Please see Using a Fixed Format File and Using an EDI Filefor
more information on creating fields and elements. The Field Properties
dialog is displayed.

2. From the Typelist, select Number. Thisindicates that the element/field
isanumeric or real number that can be mathematically manipulated.
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3. From the Format list, select the appropriate real or numeric option. The
valid selections are as follows:

RO (this field/element has an explicit decimal point and no decimal
places)

R1 (thisfield/element has an explicit decimal point and up to one
decimal place)

R2 (this field/element has an explicit decimal point and up to two
decimal places)

R3 (thisfield/element has an explicit decimal point and up to three
decimal places)

R4 (thisfield/element has an explicit decimal point and up to four
decimal places)

R5 (thisfield/element has an explicit decimal point and up to five
decimal places)

R6 (thisfield/element has an explicit decimal point and up to six
decimal places)

R7 (thisfield/element has an explicit decimal point and up to seven
decimal places)

R8 (thisfield/element has an explicit decimal point and up to eight
decimal places)

RO (thisfield/element has an explicit decimal point and up to nine
decimal places)

NO (thisfield/element has an implied decimal point and no decimal
places)

N1 (this field/element has an implied decimal point and up to one
decimal place)

N2 (this field/element has an implied decimal point and up to two
decimal places)

N3 (this field/element has an implied decimal point and up to three
decimal places)

N4 (this field/element has an implied decimal point and up to four
decimal places)

N5 (this field/element has an implied decimal point and up to five
decimal places)

N6 (this field/element has an implied decimal point and up to six
decimal places)

N7 (thisfield/element has an implied decimal point and up to seven
decimal places)
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N8 (thisfield/element has an implied decimal point and up to eight
decimal places)

N9 (this field/element has an implied decimal point and up to nine
decimal places)

If you select an implicit decimal (" N" format) for a
field and the data in that field hasless than the
specified number of decimal places, thetrandator pads
the data with zeroesto theleft so that it still interprets
the data within the specified format. For example, if
you specify aformat of "N3" for afield, and thedatain
that field is" 1", the trandator interpretsthe data as
".001".

4. Click OKto exit the Field Properties dialog.
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Using the

Dt/Tm Type A DtUTm typefield or element contains a date or time. If you specify that a
field or element is a Dt/Tm type, you must specify exactly how the date or
time must be formatted.

Complete the following steps to use the Dt/Tm type:

1. Double-click an existing element or field, or create a new element or
field. Please see Using a Fixed Format File and Using an EDI Filefor
more information on creating fields and elements. The Field Properties
dialog isdisplayed.

Field Properties E2
Mame |D245 ok |
Description IIN\-"DICE DATE Cancel |

D ata W alidation Sdvanced > |
Min  Max  Twpe Farrnat o
onditions. .. |
M Mandstow 6 [6  [ovTm =] [vvmmOD 7]

2. Fromthe Typelist, select Dt/Tm. Thisindicatesthat the element/field is
adate or time.
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3. From the Format list, select the appropriate date or time option.
Valid Dt/Tm formats are the following:

MM/DD/YY Two-digit month, separator, two-digit day, separator,
last two digits of year (example: 12/15/97 for
December 15, 1997)

YYYYMMDD Four-digit year, two-digit month, two-digit day
(example: 19971215)

YYYY/MM/DD Four-digit year, separator, two-digit month, separator,
two-digit day (example: 1997/12/15)

DD/MM/YYYY Two-digit day, separator, two-digit month, separator,
four-digit year (example: 15/12/1997)

MM/DD/YYYY Two-digit month, separator, two-digit day, separator,
four-digit year (example: 12/15/1997)

HHMM Two-digit hour, two-digit minutes (example: 0330 for
thirty minutes past three o'clock)
HHMMSS Two-digit hour, two-digit minutes, two-digits seconds

(example: 033045 for thirty minutes and forty-five
seconds past three o' clock)

HH:MM Two-digit hour, separator, two-digit minutes
(example: 03:30)

HH:MM:SS Two-digit hour, separator, two-digit minutes,
separator, two-digit seconds (example: 03:30:45)

DDMMYY Two-digit day, two-digit month, last two-digits of year
(example: 151297)

MMDDYY Two-digit month, two-digit day, last two-digits of year
(example: 121597)

DDMMYYYY Two-digit day, two-digit month, four-digit year
(example: 15121997)

MMDDYYYY Two-digit month, two-digit day, four-digit year
(example: 12151997)

YYDDD Last two-digits of year, three-digit Julian day
(example: 97349 for the 349th day of 1997)
DDDYY Three-digit Julian day, last two digits of year

(example: 34997)
YYYYDDD Four-digit year, three-digit Julian day (example:

1997349)

DDDYYYY Three-digit Julian day, four-digit year (example:
3491997)

YY/DDD Last two digits of year, separator, three-digit Julian
day (example: 97/349)

DDD/YY Three-digit Julian day, separator, last two digits of

year (example: 349/97)
YYYY/DDD Four-digit year, separator, three-digit Julian day
(example: 1997/349)
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DDD/YYYY Three-digit Julian date, separator, four-digit year
(example: 349/1997)

MONTH The month (example: December)

DAY The day of the week (example: Friday)

4. Click OKto exit the Field Properties dialog.
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Creating Simple Field-to-Field Links

The Link function enables you to map afield or element from the Input side
of the map to afield or element on the Output side of the map. The link
between two map components (hereafter referred to asfields) isvisualy
represented with aline connecting the two fields.

If you need to link two input fields to the same output field because of
conditions established in your map, you must use an extended rule.

You must have at least one direct link (using the Link

function) to every record/segment on the Output side

of themap, so thetranslator can createtherecord/
segment.

Complete the following steps to link two fields:
1. Select Link from the Functions menu or the Main Toolbar.

Click afield on the Input side of the map. The cursor changesto a*“Link
AIMowW”: | re

3. Click thefield on the Output side of the map that the datafrom the field
selected on the Input side of the map is mapped to.

4. A line connects the two fieldsto visually represent the link.

If alinedoesnot appear when thetwo fieldsarelinked,
check the Preferences dialog. Please see Customizing
Global Display of Linkson page 91 for more
information. On the Linkstab of the Preferences
dialog, you should specify “ Show all links possible.”
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Customizing Your Display

The GENTRAN:Director Application Integration subsystem allows you to
customize the display of mapsin several different ways:

Customizing global display options
Customizing colours (global option)
Customizing fonts (global option)
Displaying links (global option)
Making the two sides of amap equal

The map display options can be set or changed at any time.

Customizing

Global Display complete the following steps to customize global (for all maps) display
Options options:
1. Select Preferences... from the Options menu to display the Preferences
dialog (the Tree tab is displayed by default). The Preferences dialog
enables you to set global defaults for GENTRAN:Director.

Tree ILiﬂks I Standard Furmalsl Pusilwuﬂa\Delaultsl Files I Cuﬂfilmatiunsl

These settings customize the look of the file farmat tree,

[7 Show group descriphions Calours... |
¥ Show record descriptions Fant. |

¥ Show field descriptions

ak. I Cancel Help
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2. Toturn on the default display of group, record (segment), and field
(element) descriptions, click the check box in front of each in the List
section of the dialog (so a checkmark is displayed in the check box). To
turn off the default display of group, record (segment), and field
(element) descriptions, click the appropriate check box again to remove
the checkmark.

Typically, you want to have all the descriptions displayed for reference.
However, for avariety of reasons, you may not want the descriptions
displayed. Depending on the size of your monitor, it may be easier to
see the entire map if the descriptions are not displayed.

You may want to experiment with shrinking the size of
thefont for the map (see Customizing Global Fontson
page 89) before you turn off the display of descriptions.

3. Click the OK button to save changes and exit the Preferences dialog.
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Customizing

Global Colours The Colours feature enables you to select foreground and background
coloursto visualy define the various map components. The use of colour is
optional.

Complete the following steps to customize colours for all maps:

1. Select Preferences... from the Options menu to display the Preferences
dialog (the Tree tab is displayed by default). The Preferences dialog
enables you to set global defaults for GENTRAN:Director.

Tiee |L\nks | Standard Fnrmalsl PnslllnnalDefau\tsI Files | Ennhrmahnnsl
These settings customize the look of the file farmat tree.

¥ Show grove deseritions Colours

¥ Show record descriptions Font...

[V Show field descriptions

(1]:4 I Cancel Help
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Click COLOURS... to display the Colours dialog.

Itern

eord.ﬂ'Segmer
Composite LI

Attributes
i onditional
B . M andatary
Inactive, Conditional
Inactive, Mandatory

- Sample Text -

Farearound calaur

Backimund colour

Select the type of map component from the Item list (Group, Record/
Segment, Composite, Field/Element).

Further define the type of map component by choosing whether it is
active or inactive and conditional or mandatory from the Attributes list.
Thevalid selections are;

Active, Conditional
Active, Mandatory
Inactive, Conditional
Inactive, Mandatory

Repeat steps 3 and 4 for each combination of Items and Attributes for
which you want to define colours.

Click OK to globally define the selected colours for all maps.
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Customizing

Global Fonts The Font feature enables you to globally change the font that is used in the
display of all maps. The default font that GENTRAN:Director usesisMS
Sans Serif 9 point. The Font feature enables you to change the font type,
style, and point size. This gives you the flexibility to shrink the font if you
need to view more of the map on your monitor, enlarge the font, or change
the type and style to be more easily readable by you.

Complete the following steps to customize the display font for all maps:

1. Select Preferences... from the Options menu to display the Preferences
dialog (the Tree tab is displayed by default). The Preferences dialog
enables you to set global defaults for GENTRAN:Director.

Tice |L\nks | Standard Furmalsl F’UsiliunalDefau\lsI Files | CDnFirmaliUnsl

Thesze settings customize the look of the file format tree.

[ Show group descriptions Calours..
¥ Shows record descriplions Font

W Show field descriptions

oK I Cancel Help
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2. Click FONT... to display the Font dialog.

Font EE
Font: Font style; Size
IHeguIar OF. I
b Serif - o] AI
MS Serf Italc 10 Ezirgel |
Rorman Bold 12
Script Bold Italic 14
T Small Fonts J 18
Syumbol 24
System ;I LI LI
— Sample
| AaBbrygz

Soript;

IWestem

S

December, 1998

Select the type of font from the Font box. The default is MS Sans Serif.
Select the style from the Font Style box. The default is Regular.
Select the point size from the Size box. The default is 9.

You can preview the changes to the font in the Sample box. Click OK to
make the global font changeto all maps.
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Customizing

Global Display Mapping Links arethe visual linesthat connect each field/element on the
; Input side of the map that is mapped to a field/element on the Output side of
of Links the map

Complete the following steps to customize the global display of mapping
links:

1. Select Preferences... from the Options menu to display the Preferences
dialog. The Preferences dialog enables you to set global defaults for
GENTRAN:Director.

2. Click the Linkstab to display thelinking options. The Linkstab enables
you to set the default display of mapping links.

Triee  Links |Standard Folmatsl Fosll\onalDefaultsl Files | Conﬂrmallonsl

These settings contral how links are shown between the input and output file formats.

' Show no links
© Show links to or from the currently selected slement,

€ Show links to of from ll visibls slements

Cancel Help
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2. The options on the Links tab enable you to select from the following:

B Show nolinks
Do not visually display mapping links.

B Show linksto or from the currently selected element
Display only the mapping links for the currently selected field (this
option enables you to concentrate on the selected field and removes
the confusion of viewing many links at once).

B Show linksto or from all visible elements

Display &l the mapping links.
Click the option for thelink display option you want to be the default for
all maps.

3. Click the OK button to save changes and exit the Preferences dial og.

Making the Two

Sides of a Map When you open amap, the Input and Output sides of amap are displayed in
E qu al equal dimensions. After manipulating a map and moving the center bar that
divides the display of the Input and Output sides, you may wish to again
make the two sides equal. The Equalize function enables you to reinstate the
two sides of the map with focusin equal dimensions. The use of the Equalize
function is optional.

Complete the following step to make the two sides of a map equal:

1. Select Equalize from the View menu. This moves the center dividing
bar between the two sides of the map with focus, so that the two sides of
the map are equally proportioned.
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Setting Default Date Format

You typically establish the default date format for all date fields one time
only. This default is used when EDI documents are initially loaded from the
standard. This default can be overridden on the Field Properties dialog. This
global option changes the default date format for all maps. However, the
format of the existing date fields do not change; the default is only used for
new maps.

Complete the following steps to establish the default date format:

1. Select Preferences... from the Options menu to display the Preferences
dialog. The Preferences dialog enables you to set global defaults for
GENTRAN:Director.

2. Click the Standard Formats tab to display the default date formats that
are used when elements are read from the standards database.

Preferences

Tree I Links ~ Standard Formats |PDsitiona|DefauIts| Files I Confilmationsl

These settings contiol the default data farmats used when elements are read from the
standards database.

Siw-character dates YMMDD he

Eight character dates MMDDMY

Cancel | Help |

3. Select the appropriate six-character and eight-character default date
formats from the Six-character dates and Eight character dates lists.

4. Click OK to accept the default date formats for the six- and eight-
character date boxes and exit the Preferences dialog.

To changethe order in which the date formats appear
in the Six-character datesand Eight character dates
listsor to add a new date format to thelists, select Date
Formats... from the Options menu.
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The map components for an EDI File are the following:

EDI File

Segment

Loop (Group)

Composite Element (EDIFACT and TRADACOMS standards
only)

Element

=T 1=

-

The map components for a Positional File are the following:

@ Positional File

L Record

’ Field
The specific EDI map components that you use depends on the type of map
you are creating, the standard, version, transaction set (document), and
release (TRADACOMS only) selected, and which segments and elements

your company requires. We recommend that you determine which segments
and elements you are using before starting this step.

When GENTRAN:Director generates the EDI sides of the map, the system
includes all the groups, segments, composites, and elements that are defined
by the standards agency for the version of the document you selected. The
system activates all the groups, segments, composites, and elements that are
defined as “mandatory” (must be present) by the standard. The system does
not enable you to deactivate the mandatory groups, segments, composites,
and elements.

When translating data, the system does not process groups, segments,
composites, and elements (or records and fields) that are not activated.
Therefore, you must activate the groups, segments, composites, and
elementsthat are not defined as mandatory by the standard, but that you have
determined that you need to use in mapping.

Asan alternative to activation, you can use the Auto
Trim featureif you have a sample EDI file defined.
Please see Setting up the Document Name and Reference
on page 96 for moreinformation on the Auto Trim
feature.
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Complete the following steps to activate groups, segments, composites, and
elements:

1. Select Activation from the Functions menu or the Main Toolbar.

Asan alternative to opening each map component
(steps 2, 5, and 7), you can select Expand All from the
View menu to open every map component. You can
also select amap component and select Expand Branch
from the View menu to open that map component.

2. Open (double-click) each group that contains segments or groups that
need to be activated.

3. Click each inactive group that you need to use. This activates the
groups.

If you accidentally click a map component that you did
not mean to activate, right-click the map component
and select Deactivate from the shortcut menu.

4. Click each inactive segment that you need to use. This activates the
segments.

5. Open (double-click) each segment that contains composites or elements
that need to be activated.

6. Click each inactive composite that you need to use. This activates the
composites.

7. Open (double-click) each composite that contains elements that need to
be activated.

8. Click each inactive element that you need to use. This activates the
elements.

9. Onceyou have activated all the necessary groups, segments, and
elements, click the Activation button on the Main Toolbar to turn
activation mode off.
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96

The Document Name and Reference are two recommended fields that you
can specify in the Application Integration subsystem. For an Invoice this
field istypically the Invoice Number, and for a Purchase Order thisfield is
typically the Purchase Order Number. If you specify either the Document
Name or Reference, the corresponding field in GENTRAN:Director
document browsers (In Documents, ?ln Documents, Out Documents, ?20ut
Documents, Workspace, In Drawer, Out Drawer, Send Queue, Interchanges)
is populated. The Document Name and Reference makes the identification
of adocument created by the map easier in GENTRAN:Director.

Setting up the Document Name is strongly recommended if you want to be
able to differentiate between documents in the document browsersin
GENTRAN:Director. If you set up the Document Name in the Application

I ntegration subsystem, the Name box of the document browsers that contain
this document in GENTRAN:Director contains the data from that mapped
field. If you set up the Reference in the Application Integration subsystem,
the RefData box of the document browsers that contain this document in
GENTRAN:Director contains the data from that mapped field.

You can select any field asthe Document Name, but we strongly recommend
that you choose afield that only occurs once in the map. The field that you
select should have adata type of “string” (datatypeis specified on the Field
Properties dialog). If you need to use afield with a data type of Dt/Tm or
Number for the Document Name or Reference, you can either:

B Changethefield's datatypeto “ String” on the Field Properties dial og.
OR

B Set up an extended rule to update the document record.
If you change a Dt/Tm or Number field's data typeto
“String,” you lose the data type compliance checking
for the original type.

Complete the following stepsto set up the Document Name:

1. Werecommend that you select a non-recurring field from the header or
trailer record of the EDI side of the document. The field that you select
varies for each type of document. The selected field should be
something that identifies this document meaningfully in
GENTRAN:Director. For example:

B For anInvoicethisfield istypically the Invoice Number.

B For aPurchase Order thisfield istypically the Purchase Order
Number.
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2. Right-click the appropriate field and select Properties... from the
shortcut menu. The Field Properties dialog is displayed.

M ame IUU?E (1] 4 |

D ezcriptian IINVEIIEE MUMEER Cancel |

Data Validation Advanced »» |
tin Maw  Tupe Format

[Eortters- |

v Mandatory In_ |22 IString = Conditions...

Click ADVANCED>> to display the Rules section of the dialog.
Click the Use Standard Rule check box.

Click the Update option.

From the Table list, select Document Record.

From the Field list, select Document Name.

Click OK to set up the Document Name.

o N o g~ W
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Complete the following steps to set up the Reference:

1

Field Properties

Mame

Dezcription

D ata W alidation Advanced »» |
Min  Max  Tope Format o
[ Mandatory |‘| |22 IString j Ix onditions... |

Select afield from the first record of the EDI side of the document. The
field that you select varies for each type of document. The selected field
should be something that identifies this document meaningfully in
GENTRAN:Director.

For example:

B For an Invoicethisfield istypically the Purchase Order Number.

B For aPurchase Order thisfield istypically the Purchase Order Date.
However, to use Purchase Order Date, you must use an extended
rule on that field, instead of following the steps below.

Right-click the appropriate field and select Properties... from the
shortcut menu. The Field Properties dialog is displayed.

|0324

|F'UF|I:HASE ORDER WUMBER

o N o O~ W

Click ADVANCED>> to display the Rules section of the dialog.
Click the Use Standard Rule check box.

Click the Update option.

From the Table list, select Document Record.

From the Field list, select Reference Data.

Click OK to set up the Reference.
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Customizing the Properties of Map
Components

You can customize the properties of each type of map component (record,
segment, group, field, element, and composite) on the Properties dialog for
that component.

This chapter explains how to customize the properties of map components,
including the following topics:

B Customizing the Properties of a Record, Segment, or Looping Structure
Using LS and LE Segments

Customizing the Properties of a Field or Element

Customizing the Properties of a Composite Element

Press F1 from any area of the system to accessthe
online Help for that function. The online Help system
contains dialog box element definitions and other
detailed infor mation.
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Customizing a Record, Segment, or Group

Customizing
Group
Properties

You can modify the properties of records, segments, and groups by changing
their properties on the appropriate Properties dialog, and by using the
promote, split, copy, cut, and paste functions.

A group contains related segments and/or groups that repeat in sequence
until either the group data ends or the maximum number of times that the
loop is allowed to repeat is exhausted. If you create a group that is
subordinate to another group, this corresponds to a nested looping structure
(aloop within aloop).

Complete the following steps to modify the properties of a group:
1. Click the group you want to modify with the right mouse button to

access the shortcut menu. Select Properties... from the shortcut menu.

The Group Properties dialog is displayed.

Group Properties E3

Name [0z00_MeD

Cahcel |
Description I

Rules... |
Minimum Usage ID I | Brammnte resnnds boparsmt

Fromate |
b axiniun Uzage |2D Spi.. |

If you want to modify the group name, type the segment loop
identification code in the Name box.

Do not use spaces or dashes (-) in the Name box. You

@ can use the underscore () to separate words.

100 December, 1998 GENTRAN:Director Application Integration User’'s Guide



Customizing the Properties of Map Components

Customizing a Record, Segment, or Group

Customizing

3.

If you want to modify the group description, type the new descriptionin
the Description box. This box is used to provide a brief explanation of

the loop.

In the Minimum Usage box, type the minimum number of times the

loop must be repeated. For a conditional 1oop, the minimum usage

should always be “0" (zero). For amandatory loop, the minimum usage

should be “1” or greater.

In the Maximum Usage box, type the maximum number of times the

loop can be repeated.

6. Click OK to save the changes to the group.

Seg ment You can modify the properties of any segment, including the minimum and
maximum number of times the segment can repeat, whether the segment is
mandatory or conditional, and whether it isaloop start or loop end segment.
Please see Using Loop Sart and Loop End Segments on page 105 for more
information on using loop start and loop end segments.

Properties

Complete the following steps to modify the properties of a segment:

1. Click the segment you want to modify with the right mouse button to
access the shortcut menu. Select Properties... from the shortcut menu.

The EDI Segment Properties dialog is displayed.

EDI Segment Properties

— ldentification
Name INﬁD
Canicel |
Desc |NﬁME &ND ADDRESS e |
Tag [M&D ™ Use Key Field fewkieldr. | Eramate |
I Splite. |
Min Uzage IIJ ' Normal
" Loop Start
tax Uzage |1 " LoopEnd

— Special Properties

& Homal W e
' Floating
Cwildeard Giltermaterjaa I
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2. If you need to modify the name of the segment, type the segment
identification code in the Name box.

If a segment/record or element/field occurs morethan
oncein amap it isidentified by itsname <ID>. The
second and subsequent occurrences are identified by
<ID>:n, where“n” isthe number of the occurrencein
the map.

3. If you want to modify the description of the segment, type a new
description in the Desc box. This box is used to provide a brief
explanation of the segment that allows you to differentiate it from
similar segments.

4. If you want to modify the segment tag, type the segment identification
code <TAG> in the Tag box. For example, arecord is recognized by the
system as.

<TAG>[Delimeter]<DATA>[Delimeter] <DATA>......<DATA>
[Segment Terminator]

The segment TAG for each segment enables the system to recognize
that segment.

5. Inthe Min Usage box, type the minimum amount of times the segment
must repeat.

If theMin Usage box containsa“ 0" (zero), the segment
is“conditional.” If the Min Usagebox containsa*“ 1" or

greater, the segment is“mandatory.”

6. If you want the segment to repeat (Ioop), type the maximum amount of
timesit can repeat in the Max Usage box.

7. Unlessyou want to indicate that the segment is the beginning of aloop
(Loop Start) or the end of aloop (Loop End), accept the default of
Normal for the Normal/Loop Start/L oop End options. These options are
defined as follows:

Normal = Thissegment isintheloop but is not the beginning or
ending segment

Loop Start =  This segment marks the beginning of the loop

LoopEnd = This segment marks the end of the loop

8. Click CK to save the changes to the segment.
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Customizing

Record You can modify the properties of any record, including the minimum and
Pro pe rties maximum number of times the record can repeat, whether the record is
mandatory or conditional.

Complete the following steps to modify the properties of arecord:

1. Click the records you want to modify with the right mouse button to
access the shortcut menu. Select Properties... from the shortcut menu.

The Positional Record Properties dialog is displayed.

Positional Record Properties E3
— ldentification

oK

Mame|POHEADER
Cancel

Desc IF'EI Header Record

Tag IHDH Pasition |1 [T Use Key Figld |~ Keu Feld |

— Looping
Min Uzage |1
" Loop Start E dit Fields...

Max Usage |1 " Loop End

— Special Properties

Erammiate

Sl

& Nomal =

FLLLEE

' Floating

" ildcard Altermate Tiag I EEsitior I'I

2. Inthe Name box, type the new record name.
Do not use spaces or dashes (-) in the Name box. You

can use the underscore () to separate words.

3. Inthe Desc box, type a description of the record. This box is used to
provide a brief explanation of the record that allows you to differentiate
it from similar records.
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4. Inthe Tag box, type the record identification code <TAG>. For
example, arecord is recognized by the system as:

<TAG>[Fidld_1][Field 2]

The record TAG for each record enables the system to recognize that
record and then determine the mapping requirements.

Werecommend that you definetherecord tag on the
Positional Record Propertiesdialog, instead of defining
fields with the purpose of explicitly containing the
record tag.

5. Inthe Position box, type the starting column position of the tag in the
datarecord.

The Looping section of the Positional Record Properties dialog enables you
to specify the minimum and maximum number of times this record can
repeat, and whether arecord is mandatory or conditional. Alter this section
only if therecord is alooping structure. Otherwise, accept the defaults.

6. Inthe Min Usage box, type the minimum amount of times the record
must repeat.

If the Min Usage box containsa“0” (zero), therecord
is“conditional.” If the Min Usagebox containsa*“ 1" or
greater, therecord is“ mandatory.”

7. If you want the record to repeat (loop), type the maximum amount of
timesit can repeat in the Max Usage box.

8. Click OK to save the changesto the record.
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Using Loop Start and Loop End Segments

Certain EDI standards use Loop Start (LS) and Loop End (LE) segments. LS
and L E segments differentiate between two or more loops of the same type.
If the transaction contains LS and LE segments and depending on whether
your map isinbound or outbound, you need to definethe LSand LE
segments for the loops you are using in the map in one of two different ways.

You need to communicatewith your trading partner to
determine which loop identification code your partner
sendsyou (for an inbound map), or expectsto receive

(for an outbound map).

Defining a LS
Segment Compl ete the following steps to define an LS segment for an inbound map:

Inbound 1. Click the LS segment with the right mouse button to access the shortcut
menu. Select Properties... from the shortcut menu to display the EDI

Segment Properties dialog.
EDI Segment Properties E3
— Identification
Mame ILS

Cancel |

Desc |LOOF HEADER Fiules |
Tag ILS [T Use Key Field ke | Eramate |

—Lerrl Sl |
tin Usage ID & Marnal

€ Loop Start

Max Usage |1 " LoopEnd

— Special Properties
& Momal ™ Binany
" Floating

 wildcard Altemate Tian I

2. Verify that the Loop Start option in the Looping section of the dialog is
selected.
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3. Click the Use Key Field check box to specify that the LS segment
matches a sel ected constant.

4. Click KEY FI ELD... to access the Key Field dialog.

Key Field E

Field |

r atehing rles

) Wze constant I vI Edite., |
) Wze codelist I vI fdifs |

I | Hateh resord when ey does nat mateh

5. FromtheFieldslist, select the Loop Identifier Code. Thislist contains
all the elements that are contained in the segment.

Thislist gives you the ability to define the Loop Start segment
definition, by specifying that the loop identifier code must have the
value you specify in the Matching Rules section.

6. The Matching Rules section enables you to access all the literal
constants and code lists currently defined for this map.

Click the Use constant option.
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7. Click EDI T... (at theright of the Use constant list) to access the
Translation Object Constants dialog.

Translation Object Constants
1D Type “alue
b Table 1 e

Mew. ..

=
[ Be== |

Change...

Delete

8. Click NEW.. to access the Edit Constant dialog.

Edit Constant
[] Type

W alue

9. InthelD box, typethe literal constant identifier.

10. Fromthe Type list, select “ String.” Thisisthe category of thisliteral
constant.
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11. Inthe Vaue box, type the value of the literal constant.

For an inbound map, thisis the loop identifier code that you expect to
receive from your trading partner.

12. Click OK to add the constant to the system.

13. Select the constant you created from the list. The system matches the
selected constant against the loop identifier code.

14. Click OK to exit the Key Field dialog.
15. Click CLOSE to exit the EDI Segment Properties dialog.

Defining a LE
Segment Compl ete the following steps to define an LE segment for an inbound map:

Inbound 1. click the LE segment with the right mouse button to access the shortcut
menu. Select Properties... from the shortcut menu to display the EDI
Segment Properties dialog.

EDI Segment Properties E2

— ldentification

Mame ILE

Cancel |

Dese [LOOP TRAILER Bules |
Tag ILE [ Use Key Field tepkield:. | Erammnte |

- Looping St |
Min Usage IEI * MNomal

¢ Loop Start

taw sage |1  Loop End

— Special Properties

& Narmal " Binamy
" Floating

€ wildcard Llterate Tag I

2. Verify that the Loop End option in the Looping section of the dialog is
selected.
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Click the Use Key Field check box to specify that the L E segment
matches a sel ected constant.

Click KEY FI ELD... to access the Key Field dialog.

Key Field E

Field |

r atehing rles

) Wze constant I vI Edite., |
) Wze codelist I vI fdifs |

I | Hateh resord when ey does nat mateh

From the Fields list, select the loop identifier code. Thislist contains all
the elements that are contained in the segment.

Thislist givesyou the ability to define the Loop End segment definition,
by specifying that the loop identifier code must have the value you
specify in the Matching Rules section.

The Matching Rules section enables you to access all the literal
constants and code lists currently defined for this map.

Select the constant you created for the LS segment from the list. The
system matches the selected constant against the loop identifier code.

Click OK to exit the Key Field diaog.
Click CLOSE to exit the EDI Segment Properties dialog.
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Defining a LS
Segment Compl ete the following steps to define an LS segment for an outbound map:
Outbound 1. Double-click the Loop Identifier Code field in the LS segment.

The Field Properties dialog is displayed.

Marme {0447 ak. |
Description | OOF IDENTIFIER CODE Cancel |
[rata Y alidation Advanced »» |
Min  Max  Tupe Format =
|7|7 Mandatary |1— |4— IString j IX Conditions... |
2. Click ADVANCED>> to display the Rules section of the dialog.
3. Click the Use Standard Rule check box.
4. Click the Constant option.
5. Click the second Constant option.

rédvanced

¥ 1se Standard Rule
' Select O Update @ Constant O Use Accur O Loop Count O Use Code

() System Yariable (8 Constant

Cohztants I |EI Edit... I
Qualfies | |#]
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6.

10.

11.
12.

13.

Click EDI T... to access the Translation Object Constants dial og.

Translation I]hiecl Constants E3
D Type “alue
Sub Table 1 (" Cinge

e,

Change...

Delete

di

Click NEW.. to access the Edit Constant dialog.

Edit Constant
1D Type

Walue Cancel |

Inthe ID box, typethe literal constant identifier.

From the Type list, select “String.” This the category of thisliteral
constant.

In the Vaue box, type the value of theliteral constant. For an outbound
map, thisisthe loop identifier code that your partner is expecting to
receive from you.

Click OK to add the constant to the system.

From the Constants list, select the constant that you created. The system
matches the selected constant against the loop identifier code.

Click CLOSE to exit the Field Properties dialog.
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Defining a LE

Segment  complete the following steps to define an LE segment for an outbound map:
Outbound 1. Double-click the Loop Identifier Code field in the LE segment.

The Field Properties dialog is displayed.

Field Properties -
De:scription ILEIEIP IDENTIFIER CODE
Data alidation
bdirs Max  Type Funnal —
M Mandato [1 |4 [swing  [] [
2. Click ADVANCED>> to display the Rules section of the dialog.
3. Click the Use Standard Rule check box.
4. Click the Constant option.
5. Click the second Constant option.

rédvanced

¥ Use Standard Rule
) Selecl O Update @) Constant ) Usze dccur ) Loop Count ) Use Code

) System Yariable (8 Congtant

Constants I |£I Edit... I

Dualifies I

[+]

6. From the Constantslist, select the constant that you created. The system
matches the selected constant against the loop identifier code.

7. Click CLOSE to exit the Field Properties dialog.
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Customizing a Field or Element

You can modify the properties of the fields and elements by changing their
properties on the Field Properties dialog, and by defining and modifying
element relational conditions.

Complete the following steps to modify the properties of afield or element:

1. Double-click thefield or element you want to modify to accessthe Field

Properties dialog.

Field Properties
Hame |sHIPTOADD
Description IShip To Address Line 1
[ ata ¥ alidation

it tax  Type Farmat —
[ Mandatoy [0 |35 [swing  [3] [

2. To change the name of the field/element, type the new name in the
Name box. The name s typically the element sequence number or field
name.

Do not use spaces or dashes (-) in the Name box. You
can use the underscore () to separate words.

3. To change the description of the field/element, type the new description
in the Description box. The description is used to provide a brief
explanation of the field/element that allows you to differentiate it from
similar fields/elements.

4. If you want to designate the field/element as “ mandatory” (must be
present), click the Mandatory check box.

5. To change the minimum number of charactersthat is acceptable for the
field/element, type the minimum length in the Min box. If the datais
less than the minimum length, a compliance error is generated when
translation occurs.

6. To change the maximum length of the field/element, type the maximum
length in the Max box.
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7. From the Typelist, select the type of the field/element. Valid values are:

String = aphanumeric field/element
Number = numeric or real field/element
Dt/Tm = date or time field/element

8. From the Format list, select how the field/element is formatted. The
choices for this field depend on the type of the field/element you
selected from the Type list. If you choose Number or Dt/Tm in the Type
box, you can select the data format from the Format list. If you selected
String from the Type box, you should type a syntax token to denote that
this field/element must be formatted as the specified syntax token
dictates (the default syntax token is“X"). Please see Using Syntax
Tokens on page 77 for more information on defining and using syntax
tokens.

9. Click OKto save the changes to the field/element.
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Defining and

Mod |fy| NJ You can userelational conditions to connect fields together for syntax or
Relational compliance reasons. For example, Field A isinvalid unlessField B is
.. present. Therefore, if you set up acondition that pairs Fields A and B, the
Conditions  gystem generates a compliance error if one of those fields is not present.

You can also view the conditional relationships between elements, as
provided by the standard.

The system enablesyou to edit EDI conditional
@ relationships, but if you do, you generatesa compliance
error. Werecommend that you view edi conditions
only.
Complete the following steps to define, modify, and view field and element
relational conditions:

1. Double-click the field or element to access the Field Properties dial og.

Field Properties I
Description IPHEIDUCT#SEFNII:E ID QUALIFIER
Drata Y alidation
tdin Max  Type Farmat —
[ Mandatow [2 2 | [sting [ [«
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2. Click CONDI TI ONS... to access the Field Relational Conditions dialog.

Field Relational Conditions E3

Condition Code

Conditional *
*

Condition Field
|0235 PRODUCT/SERVICE ID QUALIFIER |E|
Pozzsible Fields Figldz uzed by relation

0350 ASSIGHED IDEMNTIFIC] 4| 0234 PRODUCT /SERVICE 1D
0330 QUANTITY ORDERED

07355 UMIT OF: BASIS FOR H— m
0212 UNIT PRICE _tdi> |
0539 BASIS OF UNIT PRICE

0235:2 PRODUCT /SERVICE
07342 PEODIICT ASERVICH®

« 1 * «[ 1 [=]

This dialog enables you to view, modify, or define field relational
conditions. If you want to simply view an element relational condition,
do so and click OK to exit the dialog. Continue with the following steps
to define or modify conditions.

3. Sedlect thefield connection condition from the Condition Codelist. Valid
values are:

B Paired/Multiple—if any of the specified fields are present then all
fields must be present
B Required —at least one of the specified fields must be present

B Exclusion —no more than one of the specified fields may be
present

B Conditional —if thefirst Condition field is present, the rest of the
fields must also be present

B List Conditional —if thefirst Condition field is present, at least one
of the specified fields must also be present

4. Select thefirst field from the Condition Field list. Thisisthe field on
which the conditional relationship hingesif you chose “Conditional” or
“List Conditional” from the Condition Code list.

The Condition Field list isonly activeif you chose

either “Conditional” or “List Conditional” from the
Condition Codellist.
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5. ThePossible Fields list contains all the fields in the trandlation object
that are valid to be used in a condition at this point. Highlight afield or
fieldsin the Possible Fields list and click the ADD--> button to move the
fieldsto the Fields used by relation list, to include the fields as a part of
the conditional relationship.

To highlight ablock of adjacent items, click thefirst item and then press
the SHIFT key and click the last item. To highlight several items that
are not adjacent to each other, pressthe CTRL key and click the items.

6. TheFieldsused by relation list containsthe fields that you selected to be
apart of the conditional relationship. To remove the fields from the
conditional relationship, highlight afield or fieldsin the Fields used by
relation list and click the <--REMOVE button to move the fields back to
the Possible Fields list.

7. Click OK to add the conditional relationship to the field.
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Customizing a Composite Element

118

You can modify the properties of a composite element changing the
properties on the Composite Propertiesdialog. A compositeis adata element
that contains two or more component data elements or sub-elements. You
can modify the composite name and description, and whether or not it is
mandatory.

Composite elements are only used for EDI maps, for
the EDIFACT, TRADACOMS, and ANSI X12 003030
and later standards only.

Complete the following steps to modify the properties of a composite;

1. Click the composite you want to modify with the right mouse button to
access the shortcut menu. Select Properties... from the shortcut menu.

The Composite Properties dialog is displayed.

Composite Properties

MName |C5D? ¥ tdandatan

Degcription I Cancel I

2. If you want to change the composite name, type the data element
identification number in the Name box.

If a segment/record, composite, or element/field occurs
morethan oncein a map it isidentified by itsname
<ID>. The second and subsequent occurrencesare

identified by <ID>:n, where“n” isthe number of the
occurrencein the map.

3. Click the Mandatory check box to indicate whether or not this
composite must be present. A checkmark means that the composite is
mandatory.

4. If you want to change the composite description, type the new
description in the Description box.

5. Click OK to save the changes to the composite.
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The GENTRAN:Director Application Integration subsystem provides you
with standard rules that you can apply to fields and elements. Standard rules
give you access to functions that are necessary for mapping operations that
are more complex than simple linking, but lessinvolved than extended rules.

Extended rules enable you to use a GENTRAN:Director proprietary
programming language to perform virtually any mapping operation you

require. Please see Creating S mple Field-to-Field Links on page 84 for more
information on linking. Please see Introducing Extended Rules on page 244
for more information on extended rules.

Each of the standard rules are mutually exclusive (you can use only oneon a

particular field). This chapter defines the standard rules and provides
examples (where appropriate) of when you may use them. This chapter

includes the following topics:

Using the Select standard rule

Using the Update standard rule

Using the Constant standard rule

Using the Use Accum standard rule

Using the Loop Count standard rule

Using the Use Code standard rule

Using the System Date and Time

Using Literal Constants and Qualifying Relationships
Using Partner-Related Information in Maps
Using Accumulators

Using Code List Tables

Press F1 from any area of the system to accessthe
online Help for that function. The online Help system
contains dialog box element definitions and other
detailed information.
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Using the Select Standard Rule

The Select function enables you to select entries from alocation table, cross-
reference table, partner table, or lookup table (all tables created in the
GENTRAN:Director Partner Editor). You can then map the fields in those
tables to one or more fieldsin the data. The Select function uses the val ue of
the current field to perform the selection.

Complete the following steps to use the Select function:

1. Double-click an existing element or field, or create a new element or
field (please see Using a Fixed Format File and Using an EDI File for
more information on creating fields and elements). The Field Properties
dialog is displayed.

Field Properties E2
Name  [PARTNERD
Dezcription I Partrier 1dentifier
[ ata W alidation \

it tax  Type Farmat
P Mendoor [1 | [3 | [oum [3] % [ Condors..|

Click Advanced>>

2. If the Advanced section of the dialog is not currently displayed, click
ADVANCED>> to access this section, which enables you to define rules.

3. Inthe Advanced section, click the Use Standard Rule check box to
display the rule options.

120 December, 1998 GENTRAN:Director Application Integration User’'s Guide



Using Standard Rules

Using the Select Standard Rule

4.

Verify that the Select option is selected.

rédvanced

¥ Use Standard Rule
® Selecl O Update ©) Constant O Usze dccum O Loop Count ) Use Code

Table I Iil [T Exclusive

Sub Table |

Map From Map To

<1 [+] [e[] [+]

The dialog box element definitions are as follows:

Table Select the table or table and key that you want to select. Valid values are:

Partner by EDI codeindicates that the key is the partner's EDI Code
and enables you to map from one of three fields for this partner (Name,
EDI Code, Alternate Code) from the partner table. You entered these
fields on the Partner Definition dialog of the Partner Editor.

Partner by alternate code indicates that the key is the partner's
Application Code and enables you to map from one of three fields for
this partner (Name, EDI Code, Alternate Code) from the partner table.
You entered these fields on the Partner Definition dialog of the Partner
Editor.

Partner by partner key indicatesthat the key isthe partner's Profile ID
enables you to map from one of three fields for this partner (Name, EDI
Code, Alternate Code) from the partner table. You entered these fields
on the Partner Definition dialog of the Partner Editor.

Partner location by name indicates that the name on the Locations
dialog (for the current partner) of the Partner Editor is the key and
enables you to map from any field in that table. You entered thesefields
on the Location Entry dialog of the Partner Editor.
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B Partner lookup (activates Sub Tablefield) indicatesthat the key isthe
partner lookup table name for this partner and enables you to map from
any field in that table. You entered these fields on the L ookup Entry
dialog of the Partner Editor.

B Partner xref by my item (activates Sub Table field) indicates that the
key isthe your item (value) on the partner cross-reference table for this
partner and enables you to map from any field in that table. You entered
these fields on the CrossRef Entry dialog of the Partner Editor.

B Partner xref by partner item (activates Sub Table field) indicates
that the key is the your partner'sitem (value) on the partner cross-
reference table for this partner and enables you to map from any fieldin
that table. You entered these fields on the CrossRef Entry dialog of the
Partner Editor.

B Division enablesyou to map from one of threefields (Name, EDI Code,
Alternate Code) for the <Internal System User> (system partner) in that
table. You entered these fields on the Partner Locations dialog of the
Partner Editor.

B Division location by name indicates that the key isthe name on the
Locations dialog of the Partner Editor for the <Internal System User>
and enables you to map from any field in that table. You entered these
fields on the Locations dialog of the Partner Editor.

B Division lookup (activates Sub Table field) indicates that the key is
the partner lookup table name for the <Internal System User> partner
and enables you to map from any field in that table. You entered these
fields on the Lookup Entry dialog of the Partner Editor.

B Division xref by my item (activates Sub Tablefield) indicates that the
key isthe your item (value) on the partner cross-reference table for the
<Internal System User> partner and enables you to map from any field
in that table. You entered these fields on the CrossRef Entry dialog of
the Partner Editor.

B Division xref by partner item (activates Sub Table field) indicates
that the key is the your partner'sitem (value) on the partner cross-
reference table for the <Internal System User> partner and enables you
to map from any field in that table. You entered these fields on the
CrossRef Entry dialog of the Partner Editor.

B Document record enables you to map from any of the fields within the
current document record.

B Generic envelope segment enables you to map from any of the fields
within the current envelope information, regardless of the EDI standard
used. Thisfunction isnormally not used unless you are familiar with the
generic envelope table structure for a given standard.
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Sub Table

Exclusive

Map From

Map To

Example 1

B [nterchange enables you to map from any of the fields within the
current interchange record.

B Group enablesyou to map from any of the fields within the current
group record.

Type the sub table name (if appropriate) in thisfield.

The Sub Table box isonly active if you select Partner
Lookup, Partner xref by my item, Partner xref by
partner item, Division lookup, Division xref by my

item, or Division xref by partner item from the Table/
Key box.

Click the Exclusive check box if you want the system to generate an error if
the Select does not find avalid table entry. The default is blank (do not
generate an error if the Select is not successful).

From thislist, choose the element/field from the specified table entry from
which you want to map the contents.

Entriesaredisplayed in the Map From list only after
you select a Table/K ey.

From thislist, choose the element/field to which you want to map the
contents of the Map From box. Each element/field from the side of the map
with which you are currently working (input or output) is displayed in this
list. A total of eight fields can be mapped using one Select rule.

Entriesaredisplayed in the Map To list only after you
select a Table/K ey, and these entries are activated only

after you highlight an entry in the Map From box.

The GENTRAN:Director Application Integration subsystem allows you to
use selected information from the GENTRAN:Director Partner Editor in
your maps via a Select standard rule. You can map information from your
trading partner's profile in the Partner Editor to a selected element or field in
the map. Theinformation that you can usein the map includes any fieldina
table (location, lookup, or cross-reference) or data from the partner table.
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For this example, you need to pull information from the partner definitionin
order to populate the Customer Number field (CUSTNUMHDR) on the
application side of the map. Your partner’s customer number identifies
which trading partner sent the purchase order. This customer number is
already part of the partner definition for this partner, so you can map it from
the partner definition to the customer number field.

Complete the following steps to map the customer number from the partner

definition:
1. Double-click the CUSTNUMHDR field to display the Field Properties
dialog.

Field Properties
|CUSTNUMHDH O

Marme

Dezcription I Custorner Mumber Cancel

Advanced >

Data alidation
Min Maw  Type Format

¥ tandatom |1 Ig IString |EI Ix Conditions...

Foszition...

Click Advanced>>

2. |If the Advanced section of the dialog is not currently displayed, click
ADVANCED>> to access this section, which enables you to define rules.

3. Inthe Advanced section, click the Use Standard Rule check box to
display the rule options.

124 December, 1998 GENTRAN:Director Application Integration User’'s Guide



Using Standard Rules Using the Select Standard Rule

4. Verify that the Select option is selected.
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5. Fromthe Tablelist, select “Document record.” Thisindicates that the

system updates this field with selected information from the document
record.

6. Click the Exclusive check box to indicate that acompliance error should
be generated if the select does not find avalid entry.

7. From the Map From list, choose “Partner Key.” Thisisthe field that
contains the customer number for this partner.

8. Fromthe Map To list, choose “CUSTNUMHDR.” Thisisthefield to
which the information from the partner key of the document record is
mapped.

The Advanced section of the Field Properties dialog should now look
like the following:

rédvanced

¥ Use Standard Rule
® Selecl O Update ) Constant O Use Accum O Loop Count ) Use Code

Table IDDcument record IEI ¥ Exclusive
SubTable |

kap From Map Ta

Application Field 3 + EUSTHUMHDR Custarmer Humber £
Application Figld 4 PODATEHDR Purchase Order Date
Application Field 5 POMUMHDR Purchaze Order Numbd=
Application Figld 6 POTYPCODE Puchase Order Type (]

SHIPTOMAME Ship To Mame

Cantral Munnber — SHIPTOADDT Ship To Address Line
v SHIPTAANNZ Shin To Addess | jne | ¥
«[ T + «[ +

9. Click OK to add the standard rule to the CUSTNUMMHDR field.
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Example 2

For this example, you need to map information from a cross-reference table
to trand ate your partner’s code for a purchased item into your code for the
item. Your partner uses a customer product code (CUSTPROCODE) for
each item that is meaningful to him. However, your company uses a UPC
code (UPCCODE) for each item. After you and your partner determine what
the equivalent customer product code isfor each UPC code, you can create a
cross-reference table in Partner Editor and use that information in your map.

A cross-reference table is used when you and your partner each reference an
item by a different name (or number). For example, if your unique name for
a“widget” is“wid” and your partner’s unigue name for the same “widget” is
“1234.” The system uses the cross-reference tabl e to trand ate the two names
for the “widget” item.

In this example, you have one code (UPC code) for each item ordered. Your
partner refers to the sameitem by a different code (customer product code).
You need to map the customer product code from the Product/Service ID
element to the customer product code field (CUSTPROCODE) on the
application side of the map. Also, you must create a cross-reference table to
translate the customer product code to your UPC code.

Before you create the cross-referencetable, you and

Q your partner must determine what the equivalent
customer product codeisfor each UPC code. Then you
can createthe cross-referencetablein Partner Editor
and usethat information in your map.

Finally, you need to use a standard rule to map the trand ated value from the
CUSTPROCODE field to the UPCCODE field.

Complete the following steps to translate your partner’s customer product
code to your UPC Code for each item your partner ordered:

1. Map the customer product code from the Product/Service ID element to
your CUSTPROCODE field. Please see Creating Smple Field-to-Field
Links on page 84 for more information on linking.
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2. Inthe Partner Editor, create a cross-reference table named
“PRODCODE.” Seethe GENTRAN:Director User’s Guide or online
Help for more information on creating a cross-reference table.

Thecrossreferencetable you create only contains six
entries. Thisisan example—an actual table would
contain all of the items manufactured by your
company that your partner purchases.

Use the information in the following table when you create the cross-
reference table. The “My Valug” box contains your UPC code for the
item. The “Partner Value” box contains your partner’s customer product
code for theitem. The “Description” box contains a description (and
size, if applicable) of the item, and the Reference Data box contains

additional quantity or color information.

My Value Partner Value Description Reference Data
12345678901234 | 555666411 Large Dog Collar Red
23456789012345 | 555666817 Spring Breeze Cat Litter 10# Bag
34567890123456 | 555666908 Small Beef Basted Rawhide Bag of 12
Bones
45678901234567 | 555666321 X-Large Food Bowl Black
56789012345678 | 555666287 FatKat Kitty Bed Blue with White Trim
67890123456789 | 555666413 Catnip Mouse Toy
3. Double-click the CUSTPROCODE field. The Field Propertiesdialog is
displayed.
Field Properties
Nme |USTPROCODE
Descriptian ICustnmer Praduct Code
Data alidation
Min  Max  Type Format —
W Mandatoy [1 [30  [swing  [] [
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10.

If the Advanced section of the dialog is not currently displayed, click
ADVANCED>> to access this section, which enables you to define rules.

In the Advanced section, click the Use Standard Rule check box to
display the rule options.

Verify that the Select option is selected.

rédvanced

¥ Use Standard Rule
® Select O Update O Constant O Use Accum O Loop Count O Use Code

Table I IEI [ Exclusive

Sub Table |

kap From Map Ta

«[ 1 [+] [«[1 (=]

From the Table box, select “ Partner xref by partner item.” Thisindicates
that you are using a cross-reference table and trand ating by your part-
ner'sitem.

In the Sub Table box, type “PRODCODE.” Thisisthe name of the
cross-reference table you created.

Click the Exclusive check box to signal the system that if thistranslation
fails, you want the system to generate an error.

From the Map From list, choose “My Item.” Thisisthefield from which
the contents is mapped.
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11. From the Map To list, choose “UPCCODE.” Thisisthe field to which
the information from the lookup table is mapped.

The Advanced section of the Field Properties dialog should now look
like the following:

rédvanced

¥ Use Standard Fule
® Select O Update O Constant 0 Use Accum O Loop Count O Use Code

Tahle I Partner sref by parther item IEI ¥ Exclusive

Sub Table IPHDDEDDE

Map From Map To

EM N + |  [CUSTHUMDET Customer Mumber |+
Partrer lbem . PODATEDET Purchasze Order Date
Dezcription == POMUMDET Purchaze Order Mumbe
Text1 CUSTPROCODE Customer Product |
Text 2 IJPCCODE UPC Cade

Text 3 0k Unit of Measure

Teat 4 hd LIMITPR Lrit Price hd
« + « +

12. Click OK to map from the cross-reference table.
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Using the Update Standard Rule

The Update function enables you to update a specific field in a document
record, envel ope segment, interchange, group, current partner, or document
(if the map side format type is EDI), with the contents of the element or
field.

Please note that thisfunction updatestheinternal
@ GENTRAN:Director database tables. We recommend

that you use thisfunction only if you are sure you

really want to update the internal database tables.

Typically, you only use thisfunction if you want to
update the document name and referencein the
document table. Any other use of thisfunction could
have disastrous consequences!

Complete the following steps to use the Update function:

1. Double-click an existing element or field, or create a new element or
field (please see Using a Fixed Format File and Using an EDI File for
more information on creating fields and elements). The Field Properties
dialog isdisplayed.

Field Properties E2
Name |1004
Description IDDEUMENT#MESS:&GE MUMBER
[ ata Y alidation '

Min Maw  Type Format —
[ Mandatory {1 |22 [Sting  [#] [%

Click Advanced>>

2. If the Advanced section of the dialog is not currently displayed, click
ADVANCED>> to access this section, which enables you to define rules.

3. Inthe Advanced section, click the Use Standard Rule check box to
display the rule options.
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4. Click the Update option.

rédvanced

¥ Use Standard Rule
() Selecl (@ Update ) Constant ) Use Accum O Loop Count ) Use Code

Table/Kew | 3|

Field | 1#]

The dialog box element definitions are as follows:

Table/Key Select the table or key from the Table/Key list that the system updates with
the contents of the current field/element. Valid values are:
B Document record (use to update the document name and reference)
Generic envel ope segment (advanced use only)
Interchange (advanced use only)
Group (advanced use only)
Current partner (advanced use only)

Document (advanced use only — if the format type of this side of the
map is EDI)

Field Select thefield from the Field list that the system updates with the contents
of the current field/element. The fields that are available in this list depend
on the Table/K ey selected.
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Example

We recommend that you set up a Document Name for each map, to make the
identification of a document created by this map easier in
GENTRAN:Director. This allows you to differentiate between documentsin
the document browsersin GENTRAN:Director.

To set up a Document Name, you must select an element or field in the map
that contains data that distinguishes the documents translated by this map.
Then, the Name box of the document browsers that contain this document
contains the data from the selected element or field.

You can choose any element or field asthe Document
Name, but the element or field must only occur oncein
the document and must have a data type of “ String.”
For a Purchase Order, the document nameistypically
the Purchase Order Number.

Complete the following steps to set up the Document Name for an ANSI
X12 Purchase Order:

1. Double-click the BEG03 (0324) element to display the Field Properties
dialog.

Field Properties E
Hame |0324
Dieseription IF'UFEEH:E«SE ORDER NUMBER

Diata Walidatior
Min  Max  Type Format —
I Mandatary I'I |22 IString IEI |><

|

Click Advanced>>

2. If the Advanced section of the dialog is not currently displayed, click
ADVANCED>> to access this section, which enables you to define rules.

3. Click the Use Standard Rule check box in the Advanced section, to
display the rule options.
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4. Click the Update option.

5. From the Table/Key list, choose “ Document record.” This indicates that
you are updating the document record in GENTRAN:Director.

6. From the Field list, choose “Document Name.” This indicates that you
are updating the Name box in the document browsers with the contents
of this element.

The Advanced section of the Field Properties dialog should now |ook
like the following:

Docmertoot [

Docmentene 8

7. Click OK to set up the document name.
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Using the Constant Standard Rule

The Constant option enables you to access the System Variable function and
the Constant function. The System Variable function enables you to map the
current date or time to the specified element or field.

The Constant function enables you to move aliteral constant value to the
specified element or field and indicate a qualifying relationship with another
element or field.

Using System
Variables The System Variable function enables you to set a variable that maps either

the current date or the current time to the selected element or field. The
selected element or field must have a datatype of “Dt/Tm.”

Complete the following steps to use a system variable:

1. Double-click an existing element or field, or create a new element or
field (please see Using a Fixed Format File and Using an EDI File for
more information on creating fields and elements). The Field Properties
dialog is displayed.

Field Properties

Pazition...

Descriptian IF'urchase Order Date

Data Walidation
it tax  Type Farmat =

M Mandatow [6 |6 [OvTm [#] [MMDDYY 4]

Click Advanced>>

2. If the Advanced section of the dialog is not currently displayed, click
ADVANCED>> to access this section, which enables you to define rules.

3. Inthe Advanced section, click the Use Standard Rule check box to
display the rule options.
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4. Click the Constant option. The System Variable option is selected by
default.

The dialog box element definition is as follows:

Variables Select current date or current time from the Variables list to map that
variable to the element or field.

136 December, 1998 GENTRAN:Director Application Integration User’'s Guide



Using Standard Rules

Using the Constant Standard Rule

Using a
Constant

Constants are used in maps to hold information that is needed later in the
map, either to be moved to an output field or used in a conditional statement.
Typicaly, constants are used to move aliteral constant value to the specified
element or field on an inbound map. Outbound EDI qualifiers are typically
generated from constants (to indicate a qualifying relationship with another
element or field).

Complete the following steps to use a constant:

1. Double-click an existing element or field, or create a new element or
field (please see Using a Fixed Format File and Using an EDI File for
more information on creating fields and elements). The Field Properties
dialog isdisplayed.

Field Properties

[ x|
Name |0a746
Description IDATE;"TIME GQUALIFIER
[ ata W alidation
it tax  Type Farmat =
M Mandatory |3 |3 [Sting  [#] [%

Click Advanced>>
2. If the Advanced section of the dialog is not currently displayed, click
ADVANCED>> to access this section, which enables you to define rules.

3. Inthe Advanced section, click the Use Standard Rule check box to
display the rule options.

4. Click the Constant option.
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5. Click the second Constant option.

Constants

Qualifies

Edit...

138
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“Advanced

¥ Use Standard Fule
() Selecl O Update @ Constant O Use Accum O Loop Count ) Use Code

1 System Yariable ) Congtant

Constants I

Qualfies |

The dialog box element definitions are as follows:

Select a constant from the Constants list. This constant is mapped to the
current element or field. If the necessary constant is not present in the
Constants list, you need to create it by using the Translation Object
Constants dial og, which you can access by clicking the EDI T... button.

Select an element or field from the Qualifies list if you want to indicate that

the current element or field qualifiesthe selected element or field (establish a
qualifying relationship between the two elements or fields). If the Qualifies

element is not generated because of alack of data, the constant is not moved
to the current element or field.

This button enables you to access the Trandlation Object Constants dialog,
which allows you to create, edit, and delete literal constants.
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Example

Literal constants are used by the system as arepository to store information
that isused at alater point in the map. Typically, constants are used in an
outbound map to generate a qualifier. A qualifier is an element that has a
value expressed as a code that gives a specific meaning to the function of
another element. A qualifying relationship is the interaction between an
element and its qualifier. The function of the element changes depending on
which code the qualifier contains.

In thisexample, you use a constant to define aqualifier for a Product/Service
ID.

Complete the following steps to define a qualifying relationship:

1. Double-click the Product/Service ID Qualifier that you want to use to
further define (qualify) the Product/Service ID. The Field Properties
dialog isdisplayed.

Field Properties
Description IPHDDUCTHSEHVICEIDBU:&LIFIEH
[ ata W alidation

it rax  Type Farmat —
Cengeey [2 [z [sung [#] [

Click Advanced>>

2. If the Advanced section of the dialog is not currently displayed, click
ADVANCED>> to access this section, which enables you to define rules.
Click the Use Standard Rule check box.

Click the Constant option.
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5. Click the second Constant option.

Click Edit...
6. Click EDI T... to access the Translation Object Constants dial og.

Translation Object Constants

SubTable 1

Click New...
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7. Click NEW.. to access the Edit Constant dialog.

Edit Constant E2

D Type

ralue Cancel |

8. InthelD box, typethe literal constant identifier. Thisistypically a
description of the field or element in which the constant is used. If you
need to refer to the constant in an extended rule, you should use the data
from this box.

9. From the Type list, select String because the Product/Service ID
Qualifier is formatted as a string data type. This indicates the category
of the literal constant.

10. Inthe Value box, type “UI” to indicate that the Product/Service ID field
must contain the UPC Code. Thisisthe value of the literal constant.

11. Click OK to add the constant to the system.
12. Click CLOSE to exit the Translation Object Constants dialog.

13. From the Qualifieslist, select Product/Service ID. Thisis the element
that the Product/Service ID Qualifier qualifies.

The Qualifieslist containsonly the other active fields
or elementsin the samerecord or segment asthe

qualifying field.

GENTRAN:Director Application Integration User’'s Guide December, 1998 141



Using the Constant Standard Rule Using Standard Rules

The Advanced section of the Field Properties dialog should now |ook
like the following.

0234 PRODUCT/SERVICE ID |—

14. Click CLOSE on the Field Properties dialog and the qualifying
relationship between the two elements is established.
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Using the Use Accum Standard Rule

The Use Accum function gives you access to a set of numeric variables that
you can manipulate via numeric operations, and then transfer to and from
fields. This function enables you to add, change, or delete cal culations for
the element/field, including hash totals (used to accumulate numeric field
values, i.e., quantity, price, etc.). This function also enables you to map the
accumulated total into a control total field, and use accumulators.
Accumulators are used generally for counting the occurrences of a specific
element or generating increasing or sequential record or line item numbers.

Please see Using Accumulators for more information about defining
accumul ators.

Complete the following steps to use the Use Accum function:

1. Double-click an existing element or field, or create a new element or
field (please see Using a Fixed Format File and Using an EDI File for
more information on creating fields and elements). The Field Properties
dialog is displayed.

Field Properties

[ %]
Description ILINE ITEM NUMBER
Data W alidation )
tdin Max  Type Farmat

[ Mandstory {1 |6 [Number [#] [0 B

Click Advanced>>

2. If the Advanced section of the dialog is not currently displayed, click
ADVANCED>> to access this section, which enables you to define rules.

3. Inthe Advanced section, click the Use Standard Rule check box to
display the rule options.
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Primary Accumulator

New...

Change...

Delete

4. Click the Use Accum option.

rbdwanced

¥ Use Standard Rule
) Select C) Update O Constant @ Use Accum O Loop Count O Use Code

Primary Accumulator Op1 Op2 0Op3 0Opd

Mew...

Change...

il

Delete

The dialog box element definitions are as follows:

The Primary Accumulator list contains all existing calculations that were
created for this element or field.

Click thisbutton to access the Edit Accumulator Entry dialog to create anew
calculation for this element or field. Please see Using Accumul atorsfor more
information on defining accumulatorsin your map.

Highlight a calculation in the Primary Accumulator list and click this button
to access the Edit Accumulator Entry dialog to edit the selected cal culation.
Please see Using Accumulators for more information on defining
accumulatorsin your map.

Highlight a calculation in the Primary Accumulator list and click this button
to delete the selected calculation.

The selected calculation isdeleted without war ning.
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Using the Loop Count Standard Rule

The Loop Count function enables you to count the number of timesaloopis
repeated, if the element or field is part of aloop. If theloop is a nested loop,
you can track the current loop or the outer loop. For example, if the Y loopis
nested within the X loop, and the Y loop has cycled through 15 iterations
and the X loop has cycled through 3 iterations, you can choose to count
either the“15” (Y loop) or the“3” (X loop).

Complete the following steps to use the Loop Count function:

1. Double-click an existing element or field, or create a new element or
field (please see Using a Fixed Format File and Using an EDI File for
more information on creating fields and elements). The Field Properties
dialog is displayed.

Field Properties

H
=
[ %]

Name |1uaz

Deseription ILINE ITEM NUMEER m
Drata Y alidation )

tdin Max  Type Farmat

[ Mandstory {1 |6 [Number [#] [0 B

Click Advanced>>

2. If the Advanced section of the dialog is not currently displayed, click
ADVANCED>> to access this section, which enables you to define rules.

3. Inthe Advanced section, click the Use Standard Rule check box to
display the rule options.
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4. Click the Loop Count option.

The dialog box element definition is as follows:

Groups Select theloop that you want to count. If the loop is anested loop, you can
track the current loop or the outer loop. For example, if the Y loop is nested
within the X loop, and the Y 1oop has cycled through 15 iterations and the X
loop has cycled through 3 iterations, you can choose to count either the 15"
(Y loop) or the“3" (X loop).
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Using the Use Code Standard Rule

The Use Code function enables you to match an element or field against a
predefined code table, specify whether or not acompliance error is generated
if the element or field does not contain one of the values in the code table,
and store a code’s description in another element or field.

The GENTRAN:Director Application subsystem enables you to create code
tables to be used with the current map. You can set up code tablesin the
Application Integration subsystem to function like the partner cross-
reference and |ookup tablesin GENTRAN:Director. However, code tables
that are set up in the Application subsystem can be used only for the current
map. Code tables that you create in GENTRAN:Director can be used
globally for al maps.

A field with a Use Code rule enables values to either be checked against or
selected from the codes in a specified code table. Codes are typically used to
further qualify another element. For example, if the XX element contains
address information, you can further qualify that element by choosing the
code “SU” from the 0222 table. In the 0222 table, the code “ SU” is described
asa“supplier'saddress.” Therefore, by using this code with the XX element,
you are indicating that the XX element is not just address information, but
address information for the supplier.

Please see Using Code List Tables on page 191 for more information on
using code list tables.

Complete the following steps to use the Use Code function:

1. Double-click an existing element or field, or create a new element or
field (please see Using a Fixed Format File and Using an EDI File for
more information on creating fields and elements). The Field Properties
dialog isdisplayed.

Field Properties
Mame [ 7oen:2
Deseripion  [ITEM CHARACTERISTIC, CODED
Data v alidation

Min ~ Max  Type Format
[ Mandatory |1 |3 ISytzng IEI |><

Click Advanced>>
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Table

Exclusive

Store Field

2. If the Advanced section of the dialog is not currently displayed, click
ADVANCED>> to access this section, which enables you to define rules.

3. Inthe Advanced section, click the Use Standard Rule check box to
display the rule options.

4. Click the Use Code option.

rédvanced

¥ Use Standard Rule
) Selecl O Update O Constant O Use Accum O Loop Count ®) Use Code

| 5

[ Exclusive

Store Field | 2]

The dialog box element definitions are as follows:

Select atable from the list. The Tableslist contains all the code tables. If the
necessary code tableisnot listed in thisbox, click EDI T TABLE... to load or
create a code table.

Click the Exclusive check box to specify that, for compliance reasons, the
field or element must contain one of the codes from the specified table
(nothing elseisvalid for that field). For example, if thefield or element is
defined as containing only “YES” or “NO,” you can set up an exclusive code
table that contains only YES and NO. Then if you receivea“MAYBE" in
that field or element, the system flagsit asan error.

Select an element or field from thislist where you want the description of the
code (that is used) to appear when the selection is made. For example, if the
codeis“SU,” itismuch more useful to view the description of the code
(“Supplier's Address). If you selected element “XX” from the Store Field
list, the description for the code used is mapped to element “ X X.”
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Edit Table...

Example

Click this button to access the Edit Code List dialog, which enables you to
create and edit code list tables.

For this example you need to map the customer product code from the
Product/Service ID to the customer product code field (CUSTPROCODE)
on the application side of the map. To ensure that the data that is mapped
from the Product/Service ID element really isyour partner’s customer
product code, you need to establish and use a code table with the Product
Service ID Qualifier.

Complete the following steps to validate the data in the Product/Service ID
field against a code list table:

1. Load the codelist table from the standard for the Product/Service ID
Qualifier element. Please see Loading a Code List Table from the
Sandard on page 204 for more information on loading a code table.

Please note that the standar ds provide code list tables
only for elementsthat use them. For example, in the
TD4 segment, the TD401 (Special Handling Code) and

TD403 (Hazardous Material Class Code) have code
tables provided by the standard.

2. Defineacodelist tablefor the Product/Service ID Qualifier element that
only contains the code value “BP” (Buyer’s Part Number). Please see
Defining a Code List on page 192 for more information on defining a
code table.

3. Double-click the element for which you need to validate data against a
codetable (Product/Service ID Qualifier). The Field Propertiesdialogis

displayed.

M ame

Description IPFHEIDUCT#SEFNII:E ID QUALIFIER
Drata Y alidation —

. QEEEEIEEEEEA [
tdin Max  Type Farmat —
[ Mandstory |2 |2 [suing  [#] [

Field Properties E

[oz

Click Advanced>>
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4. If the Advanced section of the dialog is not currently displayed, click
ADVANCED>> to access this section, which enables you to define rules.

In the Advanced section, click the Use Standard Rule check box.
Click the Use Code option.

rédvanced

¥ Use Standard Rule
) Selecl O Update ) Constant O Use Accum O Loop Count ®) Use Code

| 5

[ Exclusive

Store Field | 2]

7. From the Tablelist, select the code list table that the datain thisfield is
validated against (0235).
8. If you need to specify that, for compliance reasons, the field or element

must contain one of the codes from the specified table (nothing elseis
valid for that field), click the Exclusive check box.

For example, if the field or element is defined as containing only “Y ES”
or “NO,” you can set up an exclusive code table that contains only YES
and NO. Then if you receive a“MAYBE” in that field or element, the
system flagsit asan error.

9. Click OK to add this standard rule to the field.
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Using the System Date and Time

The GENTRAN:Director Application Integration subsystem enables you to
update any field or element (that has a data type of “Dt/Tm”) with the
current system date or time.

Complete the following stepsto update afield or element with the current
system date or time:

1. Usetheright mouse button to click the desired field or element. Select
Properties... from the shortcut menu. The Field Propertiesdialog is

displayed.

Field Properties E
Name |PODATEHDR
Deseription IF'urchase Order Date

D ata W alidatiorn
Min  Max  Type Format
[ Mandatory |5 6 ISETm [#] [Mmoore %]

Click Advanced>>
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2. If the Advanced section of the dialog is not currently displayed, click
ADVANCED>> to access this section, which enables you to define rules.

In the Advanced section, click the Use Standard Rule check box.

Click the Constant option. The System Variable option is selected by
default.

5. Fromthe Variableslist:

B Select “Current Date” if you want the field to be updated with the
current system date.
OR

B Select “Current Time” if you want the field to be updated with the
current system time.
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Using Literal Constants and Qualifying Relationships

Literal constants are used by the system as arepository to store information
that is used later in the map. Typically, constants are used to load common
datainto each application record on amap. You create the literal constant
and nameit. You can “hard code” (enter) avaluethat isloaded into the field
that uses the constant. Or, you can store information from afield in a
constant by using an extended rule. However, to use a constant (the
information that is stored in it), you need to use a standard rule, as explained
bel ow.

For an inbound map, constants are typically used to define the record types.
For an outbound map, constants are typically used to define qualifying
relationships.

A qualifying relationship establishes a rel ationship between an element and
itsqualifier. A qualifier contains a code that further defines the element.
Qualifying relationships are typically defined in outbound maps. Qualifying
relationships are defined using an standard rule, as explained below.

You can perform the following functions with literal constants and
qualifying relationships:

B Defining Literal Constants

Editing Literal Constants

Deleting Literal Constants

Mapping Literal Constants

Generating Qualifiers
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Defining Literal

Constants Complete the following steps to create aliteral constant so you can useit to
store information:

1. Select Constants from the Edit menu or the Main Toolbar. The
Translation Object Constants dialog is displayed.

Translation Object Constants
I} Type  Walue
VENDOR o
SHIP_TO
REMIT_TO — MHew...
DEPT_MUMBER
STORE_NUMEER .
e
BUYER_CODE
ORIGINAL_QUANTITY
FREE_FORM

DATE_QUALIFIER
VENDOR_NUMBER

Click New...
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Click NEW.. to access the Edit Constant dialog.

Edit Constant E3
[n] Type

Walue Cancel |

IntheID field, typetheliteral constant identifier. Thisistypically a
description of the field or element in which the constant is used. If you
need to refer to the constant in an extended rule, you should use the data
from thisfield.

From the Type list, select the category of thisliteral constant.
B Integer (select for numeric constants that are a positive or negative
natural (non-fraction) number or “0” (zero)

B Real (select for numeric constants that are a positive or negative
integer with an explicit decimal point)

B String (select for aphanumeric constants)

In the Vaue field, type the actual constant expression. Thisisthe value

of the literal constant.

Click OK to add the constant to the system.
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Editing Literal
Constants Complete the following steps to edit aliteral constant:

1. Select Constants from the Edit menu or the Main Toolbar. The
Translation Object Constants dialog is displayed.

Translation Object Constants E3

1D Type Walue

BILL_OF_LADIMNG i
VENDOR Clogel
SHIP_TO
REMIT_TO
DEPT_MUMBER
STORE_MUMEBER

JPC_CODE
BIUYER_CODE
ORIGIMNAL_QUANTITY

FREE_FORM
DATE_GUALIFIER

WENDOR_MUMBER

Select a constant and click Change...

2. Highlight the constant you want to modify.
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3. Click CHANGE... to access the Edit Constant dialog.

Edit Constant E2
D Type
[BILL_OF_LADING [string =]
Walue Cancel |

D

Make the changes to the constant.
Click OK to accept the changes.
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Deleting Literal

Constants Complete the following steps to delete aliteral constant:

1. Select Constants

from the Edit menu or the Main Toolbar. The

Translation Object Constants dialog is displayed.

Translation Object Constants

1D

Type Walue

BILL_OF_LADING
YENDOR

SHIP_TO
REMIT_TO
DEPT_MUMBER
STORE_MUMBER
UPC_CODE
BUYER_CODE
ORIGINAL_GILIAMNTI
FREE_FORM
DATE_GUALIFIER
YENDOR_NUMBER

™

2. Highlight the col
3. Click DELETEt
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Select a constant and click Delete

nstant you want to delete.

0 remove the constant.

Theselected entry is deleted without war ning.
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Mapping Literal
Constants Complete the following steps to map a constant in which you previously
stored information using an extended rule;

1. Double-click thefield or element in which you want to use the constant.
The Field Properties dialog is displayed.

Field Properties

|03?4:5

Mame

Descriptian IDATE!TIME QUALIFIER Cancel

Advanced >

[ ata W alidation
it tax  Type Farmat

v Mandatary |3 |3 Igmng |£I Ix Conditions...

IIIH
=
[ x]

Click Advanced>>

2. If the Advanced section of the dialog is not currently displayed, click
ADVANCED>> to access this section, which enables you to define rules.

In the Advanced section, click the Use Standard Rule check box.
Click the Constant option.
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5. Click the second Constant option.

6. From the Constants list, select the constant that you want to use.

7. Click OK and the data that was stored in the selected constant is |oaded
inthefield.

160 December, 1998 GENTRAN:Director Application Integration User’'s Guide



Using Standard Rules

Using Literal Constants and Qualifying Relationships

Generating
Qualifiers

A qualifier is an element that has a value expressed as a code that gives a
specific meaning to the function of another element. A qualifying
relationship is the interaction between an element and its qualifier. The
function of the element changes depending on which code the qualifier
contains.

Complete the following steps to define qualifying relationships:

1. Double-click the field or element that you want to use to further define
(qualify) another field or element. The Field Properties dialog is
displayed.

Field Properties E
Name |o374:6
Deseription IDﬁTEa’TIME GUALIFIER

D ata Walidation —
tin Man  Tupe Format —
I Mandstory |3 |3 [sting  [#] [

Click Advanced>>

2. If the Advanced section of the dialog is not currently displayed, click

ADVANCED>> to access this section, which enables you to define rules.
Click the Use Standard Rule check box.

4. Click the Constant option.
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5. Click the second Constant option.

“Advanced

¥ Use Standard Fule

() Selecl O Update @ Constant O Use Accum O Loop Count ) Use Code

1 System Yariable ) Congtant

Constants I Iil Edit... I
Qualfies | 3|

From the Qualifieslist, select the field or element that thisfield
qualifies.

The Qualifieslist containsonly the other active fields

or elementsin the samerecord or segment asthe
qualifying field.

7. Click OK and the qualifying relationship between the two fieldsis
established.
162 December, 1998
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Using Partner-Related Information in Maps

The GENTRAN:Director Application Integration subsystem allows you to
use information from the GENTRAN:Director Partner Editor in your maps
viastandard rules. You can map information from your partner's profile in
the Partner Editor to a selected element or field in the map. You can also map
information from the Internal System Partner. The definition information
and location tables that you define for the internal system partner can be
used for all partners. The information that you can use includes:

B Partner or Internal System Partner Definition (Name, EDI Code,
Application Code)

B Partner or Internal System Partner Location Table Fields

B Lookup Table Fields

B Cross-Reference Table Fields

Using

Information Complete the following steps to map information from the Partner or
from the !nternal System Partner Definition:

Partner 1. Double-click the field or element to which the standard ruleis applied.
The Field Properties dialog is displayed.

Definition
Field Properties E
Namme [SHIPTONAME
Description IShip TaMName
D ata Walidation —
tin Man  Tupe Format —
[ Mandatory [0 {35 | [suing  [#] [«

Click Advanced>>

2. |If the Advanced section of the dialog is not currently displayed, click
ADVANCED>> to access this section, which enables you to define rules.

In the Advanced section, click the Use Standard Rule check box.

Click the Select option. The Standard Rules section is displayed.
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5. From the Table box, select the key from which the system looks up the
trading partner. Valid selections are:

Partner by EDI codeindicates that the key is the partner's EDI
Code and enables you to map from one of three fields for this
partner (Name, EDI Code, Alternate Code) on the Partner
Definition dialog of the Partner Editor.

Partner by alternate code indicates that the key is the partner's
Application Code and enables you to map from one of three fields
for this partner (Name, EDI Code, Alternate Code) on the Partner
Definition dialog of the Partner Editor.

Partner by partner key indicates that the key is the partner's
Profile ID and enables you to map from one of three fields for this
partner (Name, EDI Code, Alternate Code) on the Partner
Definition dialog of the Partner Editor.

Division enables you to map from one of three fields (Name, EDI
Code, Alternate Code) for the <Internal System User> (system
partner) on the Partner Definition dialog of the Partner Editor.

6. If you want the system to generate an error if the lookup fails, click the
Exclusive check box.

7. Fromthe Map From list, select the field (Name, EDI Code, Application
Code) from which you want the contents mapped.

8. Fromthe Map To ligt, select thefield or element to which the
information from the Partner Editor is mapped.

9. Click OK to add the standard rule,
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Using
Information Each Partner Profile and the Internal System Partner Profile can have many
: associated location tables. The location table can be used to contain address-
from Location related information about the partner. You can store your partner's store
Tables addresses, warehouse addresses, or “invoice to” addresses.

To use information from alocation table, you must have created that table
already in the Partner Editor. See the GENTRAN:Director User’s Guide for
more information on creating a Partner location table.

Complete the following steps to map information from a Location Table:

1. Double-click the field or element to which the standard rule is applied.
The Field Properties dialog is displayed.

Field Properties E
Mame [SHIPTONAME
Description IShip TaMName

Data M alidatior —
Min  Max  Type Formnat
[ Mandstory {0 |35 ISytI;ng 2] |«

Click Advanced>>

2. If the Advanced section of the dialog is not currently displayed, click
ADVANCED>> to access this section, which enables you to define rules.

In the Advanced section, click the Use Standard Rule check box.
Click the Select option. The Standard Rules section is displayed.

From the Table box, select the key that is used to look up the Partner
Location entry. You is allowed to map from any field on the L ocations
dialog. Valid selections are:

B Partner location by nameindicates that the name on the Locations
dialog (for the current partner) of the Partner Editor is the key and
enables you to map from any field on that dialog.

B Division location by nameindicatesthat the key isthe name on the
Locations dialog of the Partner Editor for the <Internal System
User> and enables you to map from any field on the Locations
dialog.
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6. If you want the system to generate an error if the lookup fails, click the
Exclusive check box.

7. From the Map From ligt, select the field from which the contents are
mapped. The fields you can select from are: Name, Address 1, Address
2, Address 3, City, State, Zip, Country, Telephone Number, Fax
Number, Contact Name, Primary Reference, Secondary Reference.

8. Fromthe Map To ligt, select thefield or element to which the
information from the Partner Editor is mapped.

9. Click OK to add the standard rule.
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Using
Information A lookup tableis used to select information related to a value in inbound or
outbound data. Each Partner Profile and the Internal System Partner Profile
from LOOkup can have many lookup tables associated with it.
Tables

To use information from alookup table, you must have created that table
already in the Partner Editor. See the GENTRAN:Director User’s Guide for
more information on creating Partner lookup tables.

Complete the following steps to map information from a Lookup Table:

1. Double-click the field or element to which the standard rule is applied.
The Field Properties dialog is displayed.

Field Properties E
Mame [SHIPTONAME
Description IShip TaMName

Data M alidatior —
Min  Max  Type Formnat
[ Mandstory {0 |35 ISytI;ng 2] |«

Click Advanced>>

2. If the Advanced section of the dialog is not currently displayed, click
ADVANCED>> to access this section, which enables you to define rules.

In the Advanced section, click the Use Standard Rule check box.
Click the Select option. The Standard Rules section is displayed.

From the Table box, select the key from which the system looks up the
trading partner. Valid selections are:

B Partner lookup (activates Sub Tablebox) indicatesthat thekey is
the partner lookup table name for this partner and enables you to
map from any box on the Lookup Entry dialog of the Partner Editor.

B Division lookup (activates Sub Table box) indicates that the key
is the partner lookup table name for the <Internal System User>
partner and enables you to map from any box on the L ookup Entry
dialog of the Partner Editor.
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6. Inthe Sub Table box, type the name of the lookup table.

If you want the system to generate an error if the lookup fails, click the
Exclusive check box.

8. Fromthe Map From ligt, select the field (Item, Description, Text 1, Text
2, Text 3, Text 4) from which the contents are mapped.

9. Fromthe Map To list, select thefield or element to which the
information from the Partner Editor is mapped.

10. Click OK to add the standard rule,
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Using
Information Cross-reference tables are used to convert your values to your trading
from Cross- partner's values during outbound processing, or your partner's valuesto your

values during inbound processing. Each Partner Profile and the Internal
Reference System Partner Profile can have many lookup tables associated with it.

Tables To useinformation from a cross-reference (XREF) table, you must have
created that table already in the Partner Editor. See the GENTRAN:Director
User’s Guide for more information on creating Partner cross-reference
tables.

Complete the following steps to map information from a Cross-Reference
(XREF) Table:

1. Double-click the field or element to which the standard rule is applied.
The Field Properties dialog is displayed.

Field Properties E2

Name [SHIPTONAME
Description IShip TaMName
Data W alidation g

tdin Max  Type Farmat

[ Mandatoy [0 35 | [Sting [#] [«

Click Advanced>>

2. If the Advanced section of the dialog is not currently displayed, click
ADVANCED>> to access this section, which enables you to define rules.

In the Advanced section, click the Use Standard Rule check box.
Click the Select option. The Standard Rules section is displayed.
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5. From the Table box, select the key from which the system performs the
look up. For Cross-Reference Tables, valid selections are;

B Partner xref by my item indicates that the key isyour item (value)
on the partner cross-reference table for this partner and enables you
to map from any box on the CrossRef Entry dialog of the Partner
Editor.

B Partner xref by partner indicates that the key is your partner's
item (value) on the partner cross-reference table for this partner and
enables you to map from any box on the CrossRef Entry dialog of
the Partner Editor.

B Division xref by my item (activates Sub Table box) indicates that
the key isyour item (value) on the partner cross-reference table for
the <Internal System User> partner and enables you to map from
any box on the CrossRef Entry dialog of the Partner Editor.

B Division xref by partner item (activates Sub Table box) indicates
that the key is your partner'sitem (value) on the partner cross-
reference table for the <Internal System User> partner and enables
you to map from any box on the CrossRef Entry dialog of the
Partner Editor.

In the Sub Table box, type the name of the cross-reference table.

7. 1f youwant the system to generate an error if the look up fails, click the
Exclusive check box.

8. From the Map From ligt, select thefield (My Item, Partner Item,
Description, Text 1, Text 2, Text 3, Text 4) from which the contents are
mapped.

9. Fromthe Map To ligt, select thefield or element to which the
information from the Partner Editor is mapped.

10. Click OK to add the standard rule.
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Using Accumulators

Counting Line
ltems

The Use Accum function gives you access to a set of numeric variables that
you can manipulate via numeric operations, and then transfer to and from
fields. This function enables you to calculate sums, hash totals, value totals,
counts, and generate HL level and parent codes, and other mathematical
operations.

This section addresses three specific mathematical operations that you can
perform with accumulators by illustrating an example of when you would
use each.

In this example, you want an incremental count of the number of line items,
and you want to use that total value in the Number of Line Items Total field.

Complete the following steps to count lineitems and generate a control total
for an outbound ANSI X 12 purchase order:

1. Double-click the P0101 element (in the PO1 segment in the PO1 group).
Thisisthefield that you typically use to count the line items. The Field
Properties dialog is displayed.

M arme

Descriptian IASSIGNED IDEMTIFICATION

[ ata ¥ alidaticrs
Min  Max  Type Forrnat

[ Mandatory {1 |11 IS}ItIr:;ng 2] =

Field Properties

|0350

Click Advanced>>

2. If the Advanced section of the dialog is not currently displayed, click

ADVANCED>> to access this section, which enables you to define rules.

3. Inthe Advanced section, click the Use Standard Rule check box to

display the rule options.
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4. Click the Use Accum option.

Click New...

5. Click NEW.. to access the Edit Accumulator Entry dialog to create a
new calculation for this element.

|Edit Accumulator Entiy E2
[ ]
I—
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Select a Primary Accumulator from the list. Before any calculations are
performed on an accumulator, its content is“0” (zero). When you use an
accumulator, the system adds a new accumulator to the bottom of this
list.

For this example, select primary accumulator “0.”

Thereisonly one set of accumulatorsfor each map.
Thismeansthat accumulator “0,” whether it isused in
the Primary Accumulator or Alternate Accum box is
the same accumulator with the same contents. | f you
assign calculationsto accumulator “0” at the beginning
of themap and then use accumulator “0” again later in
the map, the content of that accumulator isthe result
of theearlier calculation. Any additional calculations
you assign to that accumulator are performed on the
contentsresulting from an earlier calculation.

In the Name box, type “Line Item Number.” Thisis adescriptive alias
that enables you to differentiate what the accumulators you create are
used for.

Fromthe First list, select “Increment primary.” Thisisthefirst operation
that the system performs. This specifies that the system increments the
value in this accumulator by one for each iteration of the PO1 group.

TheFirst box isactive only after you select a Primary
Accumulator.

The valid selections for this box are defined as follows:

B Increment primary adds“1” (one) to the contents of the Primary
Accumulator (i.e., Primary = Primary + 1).

B Decrement primary subtracts“1” (one) from the contents of the
Primary Accumulator (i.e., Primary = Primary - 1).

B Sum in primary adds the numeric value (takes the positive or
negative sign of the numbers into account) of the field to the
contents of the Primary Accumulator (i.e., Primary = (+/-)Primary
+ (+/-)Field).

B Hash sum in primary adds the absolute value (does not take the
positive or negative sign of the numbersinto account) of thefield to
the contents of the Primary Accumulator (i.e., Primary + Field).
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L oad primary loads the contents of the field into the Primary
Accumulator (i.e., Primary = Field).

Use primary loads the contents of the Primary Accumulator into
thefield (i.e, Field = Primary).

Zero primary sets the value of the Primary Accumulator to zero
(i.e., Primary = 0).

Multiply with primary multipliesthe field with the contents of the
Primary Accumulator, and stores the result in the Primary
Accumulator (i.e., Primary = Primary * Field).

Divide by primary divides the field with the contents of the
Primary Accumulator, and stores the result in the Primary
Accumulator (i.e., Primary = Field / Primary).

Divide primary by field divides the contents of the Primary
Accumulator with the field, and stores the result in the Primary
Accumulator (i.e., Primary = Primary / Field).

M odulo with primary divides the contents of the field with the
contents of the Primary Accumulator, and stores the remainder of
that operation in the Primary Accumulator (i.e., Primary = Primary
% Field).

M odulo with field divides the contents of the Primary
Accumulator with the contents of the field, and stores the
remainder of that operation in the Primary Accumulator (i.e.,
Primary = Field % Primary).

Negate primary makes the contents of the Primary Accumulator
negative (i.e., Primary = Primary * -1).

Theonly way to subtract the Primary Accumulator

“ from thefield isto “Negate” the Primary Accumulator
and then usethe“Sum in primary” operation to add

the negative Primary Accumulator to thefield.

Move primary to alter nate copies the contents of the Primary
Accumulator to the Alternate Accum. This overwrites the current
contents of the Alternate Accum field (i.e., Alternate = Primary).

Add primary to alter nate adds the contents of the Primary
Accumulator to the contents of the Alternate Accum, and stores the
result in the Primary Accumulator (i.e., Primary = Primary +
Alternate).
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B Multiply primary by alter nate multiplies the contents of the

Primary Accumulator with the contents of the Alternate Accum,
and stores the result in the Primary Accumulator (i.e., Primary =
Primary * Alternate).

Divide primary by alter nate divides the contents of the Primary
Accumulator with the contents of the Alternate Accum, and stores
the result in the Primary Accumulator (i.e., Primary = Primary /
Alternate).

Modulo primary with alter nate divides the contents of the
Primary Accumulator with the contents of the Alternate Accum,
and stores the remainder of that operation in the Primary
Accumulator (i.e., Primary = Primary % Alternate).

9. Fromthe Second list, select “Use primary.” Thisisthe second operation
that the system performs, after the First operation is completed. This
specifies that the system loads the current value of the accumulator into
the P0101 (Assigned Identification) element.

The values for the Second, Third, and Fourth boxes are listed above.

The Second box is active only after you select a First
operation that does not involvethe Alter nate Accum.
The Third box isactive only after you select a Second
operation. The Fourth box is active only after you
select a Third operation.

The Edit Accumulator Entry dialog should now look like this:

Edit Accumulator Entry E3
Prirnary Accurmulator ID |£I M armne ILine Itern Munber
Cancel I
Ilncrement primary Iil .-’-‘«Itemate.t’-‘n.ccuml Iil
Second IUse primary IEI
| B
Fuourth I Iil

10. Click OK to add the accumulator.
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The Advanced section of the Field Properties dialog should now |ook
likethis:

0-Line [tem Mumber

11. Click OK on the Field Properties dialog to add the standard rule to the
P0101 element.
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12.

Double-click the CTTO1 element (inthe CTT segment). Thisisthefield
that typically contains the total number of lineitems. The Field
Properties dialog is displayed.

Field Properties

E
Dieseription INUMBEH OF LIME ITEMS
[rata v alidatior
tdin Max  Type Farmat =
[ Mandatory |1 |B [Humber 2] [ND 3|

13.

14.
15.

16.

17.

Click Advanced>>

In the Advanced section, click the Use Standard Rule check box to
display the rule options.

Click the Use Accum option.

Click NEW.. to access the Edit Accumulator Entry dialog to create a
new calculation for this element.

From the Primary Accumulator list, select primary accumulator “0.”
This accumulator currently contains the total number of line items.

From the First list, select “Use primary.” This specifies that the system
loads the current value of the accumulator into the CTTO1 (Number of
Line Items Total) element.

The Edit Accumulator Entry dialog should now look like this:

Edit Accumulator Entry

Prirnary Accurmulator ID

|£I M arme ILineItem MHumnber

Cancel I

Iil Alkernate Accum I

B

Operation
Fist  |Use primary

Second | 3|
Thid | B2
Fouth | &l
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18. Click OK to add the accumulator.

The Advanced section of the Field Properties dialog should now look
likethis:

rédvanced

¥ Use Standard Rule
) Selecl O Update O Constant @) Use Accum O Loop Count O Use Code

Primary Accurnulator Opl1l OpZ 0Op3d 0Opd
0-Line Item Mumber Use

Mew...

Delete

19. Click OK on the Field Properties dialog to add the standard rule to the
CTTO1 element.

The CTTO1 element now contains the total number of line itemsin the
purchase order.
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Calculating

Hash Totals Inthisexample, you want to count the quantity ordered for each lineitem
and load the total quantity inthe CTTO02 (Hash Total) field.

Complete the following steps to count the quantity ordered and generate a
hash total for an outbound ANSI X 12 purchase order:

1. Double-click the P0102 element (in the PO1 segment in the PO1 group).
Thisisthefield that you typically use to count the line items. The Field

Properties dialog is displayed.

Field Properties

Name |0330

Description IQUANTITY ORDERED Cancel

Advanced >

[ ata W alidation
it tax  Type Farmat

[ Mandatary |1 Ig INumber |£I IHS |£I Conditiors. .

IIII
=
[ x]

Click Advanced>>

2. Inthe Advanced section, click the Use Standard Rule check box to
display the rule options.

3. Click the Use Accum option.

4. Click NEW.. to access the Edit Accumulator Entry dialog to create a
new calculation for this element.
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5. Select aPrimary Accumulator from the list (for this example, select

primary accumulator “1"). Before any calculations are performed on an
accumulator, itscontent is“0” (zero). When you use an accumul ator, the
system adds a new accumulator to the bottom of thislist.

In the Name box, type “Total Quantity.” Thisis a descriptive alias that
enables you to differentiate what the accumulators you create are used
for.

From the First list, select “ Sum in primary.” This operation specifies
that the system adds the numeric value (takes the positive or negative

sign of the numbers into account) of the field to the contents of the
Primary Accumulator for each iteration of the PO1 group.

The Edit Accumulator Entry dialog should now look like this:

Edit Accumulator Entry E3
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Primary Accurnulator |1 :I MHame ITotaIQuantily

rDperation:

Cancel I

First ISum in primary |EI Alternate docum I

Second I |EI
Thid | B
Favrth I |i|

B

8. Click CK to add the accumulator.
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The Advanced section of the Field Properties dialog should now look

like this:

rédvanced

¥ Use Standard Rule

Primary Accurnulator Op1

1 Select O Update ) Constant @ Use Accum O Loop Count O Use Code

Op2 0Op3d Opd

1-Total Quantity Sum

=

fe

(=1

Change...

Delete

9. Click OK on the Field Properties dialog to add the standard rule to the

P0102 element.

10. Double-click the CTTO02 element (inthe CTT segment). Thisisthefield
that typically containsthetotal quantity of the purchase order. The Field

Properties dialog is displayed.

Field Properties

Mame

|034?

Description IHASH TOTAL

Cahicel

Advanced >

[ ata W alidation
it tax  Type Farmat

[ Mandatary I‘I |1EI INumber |£I |F|9

El

Conditiohs. .

IIIH
=
[ %]

Click Advanced>>

11. Inthe Advanced section, click the Use Standard Rule check box to

display the rule options.
12. Click the Use Accum option.

13. Click NEW.. to access the Edit Accumulator Entry dialog to create a

new calculation for this element.

14. From the Primary Accumulator list, select primary accumulator “1.”
This accumulator currently contains the total quantity.
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15. Fromthe First list, select “Use primary.” This operation specifies that
the system loads the current value of the accumulator into the CTT02

(Hash Total) element.

The Edit Accumulator Entry dialog should now look like this:

Edit Accumulator Entry

Primary Accumulator |1 :I MName ITDtalBuantit_l,J

rOperation

Caticel I

Firzt IUse primary Iil Albernate Accum I

Second I IEI
Thid | &l
Fourth I Iﬂ

B

16. Click OK to add the accumulator.

The Advanced section of the Field Properties dialog should now look

like this:

ridvanced

¥ Use Standard Rule

Prirnary Accurmulator Op1 OpZ

Op3 Opd

() Select O Update O Constant @) Use Accum O Loop Count ) Use Code

1-T otal Quantity Jze

Mew...

Delete

17. Click OK on the Field Properties dialog to add the standard rule to the
CTTO02 element. The CTT02 element now contains the total quantity of

the purchase order.
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Resetting and

Calculating a Inthis example, you want to multiply the quantity invoiced for each line

Value Total

item by the unit price to obtain the extended price. Then, you want to

generate arunning total of extended price and load the final total into the
TDS01 (Tota Invoice Amount) element.

_I\/Iu_ltiplying Complete the following steps to multiply the quantity invoiced for each line
quantity invoiced item by the unit price to obtain the extended price for an outbound ANSI
by unit price Xi12invoice:

1

Double-click the IT102 element (in the IT1 segment in the IT1 group).
Thisisthefield that you typically use to count the quantity invoiced.
The Field Properties dialog is displayed.

Field Properties

[ x|
Name
Descriptian IQUANTITYINVDIEED
[ ata W alidation = )
it tax  Type Farmat =
[ Mandatoy {1 |10 [Mumber [#] [R9 B

|0358

Click Advanced>>

In the Advanced section, click the Use Standard Rule check box to
display the rule options.

Click the Use Accum option.

Click NEW.. to access the Edit Accumulator Entry dialog to create a
new calculation for this element.

Select a Primary Accumulator from the list (for this example, select
primary accumulator “2"). This humber is a name by which the
accumulator is referred. Before any cal culations are performed on an
accumulator, itscontent is“0” (zero). When you use an accumul ator, the
system adds a new accumulator to the bottom of thislist.

In the Name box, type “Extended Price.” Thisis adescriptive aias that
enables you to differentiate what the accumulators you create are used
for.
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7. Fromthe First list, select “Load primary.” This operation specifies that
the system loads the contents of the element into the Primary
Accumulator for each iteration of the IT1 group.

The Edit Accumulator Entry dialog should now look like this:

Edit Accumulator Entry

Primany Accumulator |2 :I Mame IEHtended Price

rOperation

Cahicel I

First ILnad primary

]

IEI Alternate Accurm I

Second I

Third |

Fourth I

8. Click OKto add the accumulator.
The Advanced section of the Field Properties dialog should now look

like this:

ridvanced

¥ Use Standard Rule
) Select O Update O Constant @ Lze Accum O Loop Count ) Use Code

Prirnary Accurmulator

Opl Op2 0Op3d 0Opd

2-Extended Frice

Load Mew...

Delete

9. Click OK on the Field Properties dialog to add the standard rule to the

1T102 element.
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10. Double-click the IT104 element (in the IT1 segment in the IT1 group).
Thisisthe field that contains the unit price for each lineitem. The Field
Properties dialog is displayed.

Description IUNIT FRICE
Data alidation
Min Maw  Type Format —
™ Mandatory |1 |14 INumber |EI IFIS |$I
Click Advanced>>

11. If the Advanced section of the dialog is not currently displayed, click
ADVANCED>> to access this section, which enables you to define rules.

12. Inthe Advanced section, click the Use Standard Rule check box to
display the rule options.

13. Click the Use Accum option.

14. Click NEW.. to access the Edit Accumulator Entry dialog to create a
new calculation for this element.

15. Fromthe list, select primary accumulator “2.”

16. Fromthe First list, select “Multiply with primary.” This operation

specifies that the system multiplies the value of the IT104 (Unit Price)
element with the contents of the primary accumulator, and store the
result in the primary accumul ator for each iteration of the IT1 group.
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The Edit Accumulator Entry dialog should now look like this:

Cancel I

Second I Iil
Thid | &l
Fourth I Iﬂ

Primany Accumulator |2 :I Mame IEHtended Price
rOperation
First IMuItipIy with primary IEI Alternate Accum I Iil

17. Click OK to add the accumulator.

The Advanced section of the Field Properties dialog should now look

likethis:

rédvanced

¥ Use Standard Rule

() Select O Update ) Constant @) Use Accum O Loop Count ) Use Code

Primary Accurmulator Opl Op2 0p3 Opd

2-Extended Price bult

Mew...

Delete

il

18. Click OK on the Field Properties dialog to add the standard rule to the
IT104 element.

%
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If thereisan extended price element in your EDI file,
you could load the total from the extended price
calculation into that element. To do this, you need to
use an accumulator on that extended price element
that specifies“Use primary” for accumulator 2.
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Generating a Complete the following steps to generate a running total of the extended
running total of price:

extended price 1. Double-click the IT104 element (in the IT1 segment in the IT1 group).

Thisisthefield that contains the unit price for each lineitem. The Field
Properties dialog is displayed.

Field Properties

I
[ %

Name |021 2 0

Description IUNIT PRICE m
D ata Walidation Advanced >> | )

Min  Max  Type Format —
[ Mandatory |1 |-|4 INumber IEI IHS IEI Conditiors. .

Thiz field uses a standard rule,

Click Advanced>>

2. Inthe Advanced section, you already established one accumulator that
isdisplayed in thelist.

rédvanced
¥ Use Standard Rule
() Select O Update ) Constant @) Use Accum O Loop Count ) Use Code
Primary Accurmulator Opl Op2 0p3 Opd
2-Extended Price bult New..
Click New...
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Click NEW.. to access the Edit Accumulator Entry dialog to create
another calculation for this element.

From the Primary Accumulator list, select primary accumulator “3.”
In the Name box, type “Running Total.”

From the First list, select “Add primary to alternate.” This operation
specifiesthat the system adds the contents of the primary accumulator to
the contents of the alternate accumulator, and stores the result in the
primary accumulator for each iteration of the IT1 group.

From the Alternate Accum list, select “2.” This operation specifies that
the system add the value of accumulator “2" (which contains the
extended price for aline item) to the value of accumulator “3.” The
system stores the sum in accumulator “3,” which therefore contains a
running total of the extended price with each iteration of the IT1 group.

The Edit Accumulator Entry dialog should now look like this:

Edit Accumulator Entry

Primary Accurnulator |3 :I MHame IHunning Tatal

rDperation:

Cancel I

First I.l’-‘n.dd primary ko alternate |EI Alternate docum |2

Second I |i|
Thid | Lzl
Faurth I |ﬂ

12|

8. Click CK to add the accumulator.
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The Advanced section of the Field Properties dialog should now look
like this:

rédvanced

¥ Use Standard Rule
() Selecl O Update ) Constant @ Use Accum O Loop Count ) Use Code

Frimary Accumulator Op1 0Op2 0Op3 0Opd
2-Eutended Price bduilt Mew..
3-Running Total AddPd,

9. Click OK on the Field Properties dialog to add the standard rule to the
IT104 element.

Loading arunning Complete the following steps to load the running total of the extended price
total of extended intothe TDSO1 (Total Invoice Amount) element:

price 1. Double-click the TDS01 element (in the TDS segment inthe IT1
group). Thisisthefield that contains the unit price for each line item.
The Field Properties dialog is displayed.

Field Properties E
Description ITDTALINVDIEE AMOUNT
Data alidation
Min  Max  Type Format —
W Mandatory {1 [10 [number [#] [n2 2]

Click Advanced>>

2. Inthe Advanced section, click the Use Standard Rule check box to
display the rule options.
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3. Click the Use Accum option.

4. Click NEW.. to access the Edit Accumulator Entry dialog to create a
new calculation for this element.

From the Primary Accumulator list, select primary accumulator “3.”

From the First list, select “Use primary.” This operation specifies that
the system loads the contents of the primary accumulator into the
TDSO01 (Total Invoice Amount) element.

The Edit Accumulator Entry dialog should now ook like this:

Frimary Accumulator |3 Hame IHunning Total
0 peration 'm
First IUse primary |£I Alternate Accunm I Iil

Second I |EI
Thid | B
Favrth I |i|

7. Click CK to add the accumulator.

The Advanced section of the Field Properties dialog should now look
likethis:

rédvanced

¥ Use Standard Rule
) Selecl O Update O Constant @) Use Accum O Loop Count O Use Code

Primary Accurnulator Opl1l OpZ 0Op3d 0Opd
3-Running Tatal ze

Mew...

Change...

Delete

8. Click OK on the Field Properties dialog to add the standard rule to the
TDS01 element.
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Using Code List Tables

Code List Tables are used by EDI standards as repositories for lists of codes.
Each EDI standard provides a code list for each element that can be further
defined with acode. GENTRAN:Director allows you to load code lists from
the standard. You can either load al the codes in the table, or you can select
only one or more codes from the table. Once you load a code table, you can
usea“Use Code” standard ruleto either look up avalue from a code table or
validate the contents of afield against the valuesin the code table.

The Code Lists function also enables you to store a code's description in an
element/field, create a unique code table, use code values from a code table,
and flag whether or not the system generates an error if avalidation against
the code table fails. You can import and export code lists and copy and paste
code lists between maps.

A field with a Use Code standard rule applied to it allows values to either be
checked against or selected from the codesin a specified code table. Codes
aretypically used to further qualify the element. For example, the Product/
Service ID (0234) element contains a product code that you expect to be the
customer's product code. If you receive avalue in that element that is
something other than the customer's product code, you want the system to
generate an error. So, you first use the code table for the Product/Service ID
Qualifier (0235), but specify when you load it that the code table should only
include the code “BP.” In this code table, the code “BP" is described as a
“Buyer's Part Number.” Then, you make the 0235 code table exclusive for
the Product/Service ID Qualifier (0235) element. Therefore, by using this
code with the qualifier for the Product/Service ID element, you are
indicating that the Product/Service ID element must contain not just a
product code, but product code from the customer.

You can perform the following functions on Code List Tables:

Defining a Code List

Modifying a Code List or Code List Entry
Deleting a Code List or Code List Entry
Importing a Code List

Exporting a Code List

Loading Code Tables from the Standard
Copying and Pasting Code Lists
Validating Data Against Code List Tables
Mapping Code Item Descriptions
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Defining a
Code List Complete the following steps to define a code list table:

1. Select Code Lists from the Edit menu or the Main Toolbar. The Code
Listsdialog is displayed.

Code Lists E2

Tahle (D Description
i

Cloze

Mew. .

Change...

Delete

Impart..

Expaort...

Copy

FPazte

Click New...
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2. Click NEW.. to access the Edit Code List dialog.

Edit Code List E
Table Detail
Table D | Desc |
“Allowed Cade
Code W alue Degcription

Mew...
Change...

Delete

Load

3. IntheTable ID box, type the name of the field or element for which this
code list tableis used.

4. Inthe Description box, type the description of the field or element for
which this codelist tableis used.

5. Click NEW.. to access the Edit Code List Entry dialog.

Edit Code List Entry

Walue I

Description I

6. Inthe Vaue box, type the actual value of the code.
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7. Inthe Description box, type a description of the code value. The code
value description isused if you specify an element or field (in the Store
Fieldslist on the Field Properties dialog) to which you want the code
description mapped.

Click OK to save the code list entry.

Repeat steps 5 through 8 to add more code list entries to the code list
table.

10. Click CLOSE to save and exit the Edit Code List dialog.
11. Click CLCSE to exit the Code Lists dialog.
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Modifying a
Code List Complete the following steps to modify a code list table or code list entry:

1. Select Code Lists from the Edit menu or the Main Toolbar. The Code
Listsdialog is displayed.

Code Lists E3
Table 1D Dezcription
p

Cloze
Mew...
Change...

Delete

Expart...

Copy

Paste

Select the code list you want to modify Click Change...

2. Highlight the code list that you want to modify.
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3. Click CHANGE... to access the Edit Code List dialog.

Edit Code List E2

T able Detail
Table ID |0235 Desc IPHDDUET#SEHVIEE ID QUALIFIER

-Allowed Code Cancel
Code Value Dezcription
BP BUYER'S PART MUMBER o

Change...
Delete

Load...

el &

4. Atthispoint, you can add new code list entriesto the table, delete

entries, or modify code list entries. To modify an entry, highlight it and
click CHANGE... to access the Edit Code List Entry dialog.

Edit Code List Entry

Walue IBF'
Degcription IBUYEF!'S FART NUMEER Cancel I

Make the necessary changes.
Click OK to save the code list entry.

Repeat steps 2 through 6 to modify other code list entriesin the code list
table.

Click CLOSE to save and exit the Edit Code List dialog.
Click CLOSE to exit the Code Lists dialog.
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Deleting a
Code List or Complete the following steps to delete a code list table:

Code List Entry 1. Sdlect Code Lists from the Edit menu or the Main Toolbar. The Code
Listsdialog is displayed.

Code Lists

T

Cloze

e
Change...
Delete
Import...
Ewpont...

Copy

Faste

Select the code list you want to delete )
Click Delete

2. If youwant to delete a code list, highlight that list.
3. Click DELETE to delete the code list table.

@ The selected tableisdeleted without warning.
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Complete the following stepsto delete acode list entry:

1. Select Code Lists from the Edit menu or the Main Toolbar. The Code
Listsdialog is displayed.

Code Lists E2

Tahle (D Description

Cloze

Me

Change...

Delete

Impart..

Expaort...

Copy

FPazte

L Select the code list from which you want to

delete an entry Click Change...

2. Highlight the code list from which you want to delete an entry.

198 December, 1998 GENTRAN:Director Application Integration User’'s Guide



Using Standard Rules Using Code List Tables

3. Click CHANGE... to access the Edit Code List dialog.

Edit Code List E
- T able Dretail
Table 1D |D235 Desc IPHDDUCT#SEHVIEE ID QUALIFIER
réllowed Code
Code Value Degcription
BP BUYER'S PART HUMEBER

Mew...
Change...
Delete

Load...

4. To delete an entry, highlight it and click DELETE to remove the entry.
Delete any other entries you wish.

Theselected entry is deleted without war ning.

5. Click OK to save the code list table.
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Importing a

Code List TheCode List Import function enables you to import code lists created for
another map and share code lists with other users of GENTRAN:Director.

Complete the following steps to import a code list table:

1. Select Code Lists from the Edit menu or the Main Toolbar. The Code
Listsdialog is displayed.

Code Lists E2
Tahle (D Description

Click Import...
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2. Click | MPORT... to access the Open dialog.

Open EHE

Laak i Ia Bin j il Ir

File name: I

Files of bope: IEnde Tables [+ CDE) ﬂ Cancel |

3. Select thelocation of the code list file. The default location is
Application Integration install folder (the default is GENSRVNT).

Thedefault file extension for codelistsis“.CDE.”

4. Select the code list file from the list and click OPEN to import the code
list and return to the Code Lists dialog. The imported code list is
available for your use.

5. Click OKto exit the Code Lists dialog.
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Exporting a

Code List TheCode List Export function enables you to export code lists to file. This
enables you to define acode list for one map and use that code list in another
map. This function also allows you to share code lists with other users of
GENTRAN:Director.

Complete the following steps to export acode list table:

1. Select Code Lists from the Edit menu or the Main Toolbar. The Code
Listsdialog is displayed.

Code Lists

Table 1D Degcription

I x|

Close
Mew. .
Change...
Delete
Impart..
Expaort...
Copy

FPazte

Select a code list and click Export..
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2. Select acode list and click EXPORT... to access the Save As dialog.

Save Az EE

Save in: |éElEin j gl E =

File name:  |0235.CDE

Save az upe; IEode Tables [*.COE] j Cancel |

3. Thefile name defaults to the table ID with a“.CDE” file extension. If
you want to change the name, type the export file name in the “File
name”’ box. The default location is the GENSRVNT folder.

Thedefault file extension for codelistsis“.CDE.”

4. Click SAVE to export the code list and return to the Code Lists dialog.
5. Click CLOSE to exit the Code Lists diaog.
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Loading a Code

List Table from Complete the following steps to load a code list table from the standard:

the Standard 1.

Double-click the element for which you need to use a code table. The

Field Properties dialog is displayed.

Field Properties

|0355

Hame

E

Drescription

IUNIT 0OR BASIS FOR MEASUREMENT CODE

Cancel

Drata Y alidation
kin

A [Advanced |

[ Mandatory |2 |2 |String El |><

Max  Type Farmat
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Click Advanced>>

The standards provide code list tables only for
elementsthat usethem. For example, in the TD4

segment, the TD401 (Special Handling Code) and
TD403 (Hazardous Material Class Code) have code
tables provided by the standard.

3. Click the Use Standard Rule check box.
4. Click the Use Code option.

rédvanced

¥ Use Standard Rule
() Selecl O Update O Constant O Use Accum O Loop Count @ Lse Code

| 5

[ Exclusive

Store Field | 12|
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5. Click EDI T TABLE... to access the Edit Code List dialog.

Edit Code List E
~Table Detail
Table D |0355 Desc |IT OF BASIS FOR MEASUREMENT CODE
rAllowed Code
Code Walue Description

The Table ID box contains the name of the field or element for which
this code list tableis used. The Description box contains the description
of the field or element for which this code list table is used.

6. Click LOAD... and you are prompted to select adata source name (DSN)
from which to access the EDI standard. Select the appropriate DSN and
click OK to access the Load Code List dialog.

Load Code List

[ x]

rSelect Code Source

Standard | |i| ListlDEEE |£|

Cancel I

rSelect Codes

Codes In Standard Codes Selected
m ACTUAL POUMDS |+

0z STATUTE MILE =
03 SECOMDS =
04 SMALL SPRAY

ng HEAT LOTS

5 LTS
10 GROUP (o Fomows |
11 OuTAT #| [ < Femave
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7. You can either select specific codes that you want to load or select the
entirelist of codes:

B To select specific codes only, from the Codes in Standard list,
highlight each code that you want to be loaded. Click ADD--> to
move it to the Codes Selected list.

B Toload theentire code list, click ADD ALL--> to select all the
codes and move them to the Codes Selected list.

Werecommend that you only add the codes that you
and your trading partnersare ableto create or accept.
Adding all the codesin the code table (using the ADD

ALL--> button) creates a much larger translation
object than if you only use selected codes.

8. Click OK to load the code list.
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Copying and
Pasting Code TheCode List Copy and Paste function enables you to copy code lists to
Lists from one map to another.

Complete the following steps to copy and paste a code list table:

1. Select Code Lists from the Edit menu or the Main Toolbar. The Code
Listsdialog is displayed.

Code Lists

Cloze
Me
Change...
Delete
Import...
Ewpont...

—s Copy

[ x]

Faste

Select a code list and click Copy..

Select acode list and click COPY... to copy the code list to the clipboard.
Click CLOSE to exit the Code Lists diaog.
4. Openthe map in which you want to use the code lit, if the map is not

already open.
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5. Sdlect Code Lists from the Edit menu or the Main Toolbar. The Code
Listsdialog is displayed.

Code Lists E2
Table 1D Degcription

Click Paste..

6. Click PASTE... to add the copied code list to this map.
7. Click CLOSE to exit the Code Lists diaog.
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Validating Data
Against Code Completethefollowing steps to validate data against a code list table:

List Tables 1. Double-click the element for which you need to validate data against a
code table. The Field Properties dialog is displayed.

Field Properties E3
Name |08
Dieseription IUNIT OR BASIS FOR MEASUREMENT CODE

D ata W alidation =
tdin rax  Type Farmat —
[ Mendsa [2 | [2 | [sne 3] [ [ Condons..|

Click Advanced>>

Please note that the standar ds provide code list tables
only for elementsthat use them. For example, in the
TD4 segment, the TD401 (Special Handling Code) and
TD403 (Hazardous Material Class Code) have code
tables provided by the standard.

3. Inthe Advanced section, click the Use Standard Rule check box.

4. Click the Use Code option.

rédvanced

¥ Use Standard Rule
() Selecl O Update O Constant O Use Accum O Loop Count @ Lse Code

| 5

[ Exclusive

Store Field | 12|
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From the Table list, select the code list table that the datain thisfield is
validated against. If the Tables list is empty, you need to load a code
table. Please see Loading a Code List Table from the Sandard on page
204 for more information.

If you need to specify (for compliance reasons) that the field/element
must contain one of the codes from the specified table (nothing elseis
valid for that field), click the Exclusive check box.

For example, if the field/element is defined as containing only “YES” or
“NO,” you can set up an exclusive code table that contains only YES
and NO. Then if you receive a“MAYBE" in that field/element, the
system flagsit asan error.

Click OK to add this standard rule to the field.
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Mapping Code
[tem Complete the following steps to map code item descriptions:

Descri p'[iOﬂS 1. Double-click the element for which you need to map a code item
description. The Field Properties dialog is displayed.

Field Properties E3
Name |08
Dieseription IUNIT OF BASIS FOR MEASUREMENT CODE

D ata W alidation =
Min  Max  Type Faormat = ;
[ Mengsan [o | [2 | [oure (8] % [ Condons..|

Click Advanced>>

Please note that the standar ds provide code list tables
only for elementsthat use them. For example, in the
TD4 segment, the TD401 (Special Handling Code) and
TD403 (Hazardous Material Class Code) have code
tables provided by the standard.

3. Inthe Advanced section, click the Use Standard Rule check box.
4. Click the Use Code option.

rédvanced

¥ Use Standard Rule
() Selecl O Update O Constant O Use Accum O Loop Count @ Lse Code

| 5

[ Exclusive

Store Field | 12|
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From the Table list, select the code list table that the datain thisfield is
validated against. If the Tables list is empty, you need to load a code
table. Please see Loading a Code List Table from the Sandard on page
204 for more information.

If you need to specify that, for compliance reasons, the field/element
must contain one of the codes from the specified table (nothing elseis
valid for that field), click the Exclusive check box.

For example, if the field/element is defined as containing only “YES” or
“NO,” you can set up an exclusive code table that contains only YES
and NO. Then if you receive a“MAYBE" in that field/element, the
system flagsit asan error.

From the Store Field list, the element to which you want the description
of the code item (that is used) to be mapped to when the selection is
made.

For example, if the codeyou used is“BR” it would be useful to view the
description of the code (“Buyer's Part Number”). If you selected
element “0350” from the Store Field list, the description for the BP code
is mapped to element “0350.”

Click OK to add this standard rule to the field.
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Theimport processis part of the outbound translation process. In the
outbound trandation process, the system trandlates your application file
format to EDI standard formats, so you can send documents to your partners.
To trandate outbound data, you need to create an import translation object
and a system import translation object in the GENTRAN:Director
Application Integration subsystem. The import translation object defines
how to move data from your application file (flat file definition), which may
contain multiple documents, to the EDI standard-formatted documents that
your partners expect to receive from you. You need to create a system import
translation object to determine which trading relationship (established in
Partner Editor) corresponds to each document in the application file, so the
system knows which import translation object to use to process the
document.

This chapter explains how to set up the import process, including the
following topics:

B |mporting data

B Modifying system configuration

B Creating a system import map

Press F1 from any area of the system to accessthe
online Help for that function. The online Help system
contains dialog box element definitions and other
detailed infor mation.
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Importing Data

During the import process, GENTRAN:Director imports a specified
application file into the Workspace. An import file can contain multiple flat
file definitions (documents) that need to be sent to multiple trading partners.

You can import any type of flat file, including TDF (Transaction Data File).
TDF isaflat file representation of the EDI standard document. Theflat file
characteristics can include multiple record types (more than one record
definition) and records delimited by carriage returng/line feeds.

You cannot import EDI or field-delimited files. The field and record lengths
for import files are defined in the Application Integration subsystem
application file definition. For example, the maximum length of afield in an
import file must not exceed the maximum length (Max) specified on the
Field Properties dialog for that field. And, the maximum length of arecord
in an import file must not exceed the record length (if specified) on the
Positional File Format Properties dialog for that record. The system default
is variable length records. If you specify record delimiters on the Positional
File Format Properties dial og, the records in the import file must begin and
end with those delimiters. If you do not specify record delimiters, the default
delimiters are carriage return and line feed.

The system must determine which trading relationship (established in
Partner Editor) corresponds to each document in the application file, so the
system knows which import translation object to use to process the
document. Each application file must have a corresponding system import
map. For each document in the application file, the system import trandation
object identifies the partner and locates the trading relationship. The trading
relationship for that partner must have an import translation object
associated with it.

After the system import trandlation object determines which trading
relationship corresponds with a document, it ascertains which import
translation object is specified in that relationship. The trandator uses the
import translation object to translate the document. If the document is
compliant (valid), it is moved to the Workspace. If the document is not
compliant (invalid), it is moved to the 20ut Documents. Then, if thereis
another document remaining in the application file, the translator repeatsthis
process until all the documents are processed.
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Importing Data

Theimport processisillustrated as follows (translator not pictured):

Application File containing
multiple documents is imported into
GENTRAN:Director

Header Record

- Document 1

Header Record

P | Document 2

Header Record

|  Document 3

System Import Translation Object

(specified in System Configuration
for this file type)

=

Trading
Relationships
- 1
2 Import
> 3 Translation ) []
Object
_> 4
5

GENTRAN:Director Application Integration User’'s Guide December, 1998

215



Modifying System Configuration Setting Up the Import Process

Modifying System Configuration

When you import afile, the system checks the Imports tab of the System
Configuration program (shipped with GENTRAN:Director) to verify that
the file is matched with aregistered system import translation object. Your
system administrator may need to add the match to the System
Configuration program. Please see Modifying Import Parametersin the
Administration Guide for more information on defining or modifying import
specifications.
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Creating a System Import Map

A system import map is used by the system to find the partner relationship
for adocument (flat file definition), to determine which import map is used
totrandate the data. The system import map builds the key that the trand ator
usesto find the partner relationship. The sole function of the system import
map isto identify the appropriate partner relationship; the system import
map does not map any data.

There are two ways to build the key in a system import map. The method
that we recommend requires six EDI-specific fields in the header record:
partner key, standard, version, transaction set, release (for TRADACOMS
only), and test/production status. The combination of these six fields defines
aunique key that identifies the appropriate partner relationship. We
recommend using this method because it is very flexible. You typically use
this method when you are defining your application from scratch and can
easily add the EDI-specific fields that are not already present in the header
record.

The second method is easier to build because it only requires three fieldsin
the header record (partner key, application ID or application alias value, and
test/production status). The combination of these three fields defines a
unique key that identifies the appropriate partner relationship. However,
because only three fields are combining to build the key, this method is not
asflexible asthe preferred method. You typically use this method when you
are using alegacy (existing) application definition, and you do not want to
add EDI-specific information.

GENTRAN:Director Application Integration User’'s Guide December, 1998 217



Creating a System Import Map Setting Up the Import Process

Complete the following stepsto create a system import map:

1. Select New from the File menu to create a new map. The Create New
Translation Object dialog is displayed.

Template Function IImport
Wata Saunce I j Cancel |
~ Input Format

Tupe Iﬁ I | sz tardand:

SgErE I j

Ersian I j

Tiarzactior I j

HelEase I "I
— Output Format

Type Iﬁ I | e Staridard:

Saency I j

W ErSIat I j

It saEtEn I j

Helease I "I

From the Trandlation Object Function list, select “ System Import.”
From the Input Format Type list, select “Positional .”

From the Output Format Type list, select “ Positional.” The system
actually ignores the Output side of the map and only process the Input
side.

5. Click OK to create the new system import map (this may take a few
seconds). The new map is displayed in the GENTRAN:Director -
Application Integration Window.
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6. After you create the new map, it isimportant to define the details of the
map and save it. Select Save from the File menu to display the
Translation Object Details dialog.

Translation Object Details '
FSummarny
Author Drescription Tranzlation Object Function Spstem

I IS_l,lstem Import Iil u lm

~erzion Contral

kd ajor version ID Minar version ID Comnpiled onl

Agency

Wersion

Release

F Group

rEDI Azzociation:

Trangaction I I

InpLat Output

[l
| |

—
! !

e

10.

Complete the Author box. This box typically contains the name of the
person who created the map.

Compl ete the Description box. For system import maps, we recommend
that you type “ System Import *,” where “*” istypically the unique type
of document for which this system import map is used. The Import tab
of the System Configuration program describes which system import
translation object is used to begin translation during the import process.
Please see the Administration Guide for more information about how
your system administrator needs to modify the system configuration
program.

The Translation Object Function list contains “ System Import.” The
only reason you change thisisif you determine at this point that you
really want to create another type of map.

Complete the Major and Minor boxes if you want to designate aversion
number for this translation object. Typethe version number in the Major
box and the release number in the Minor box.
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11. Click OK to save the translation object details and access the Save As
dialog.

Save As EHE
Save in: |¢El Maps j gl i =

File name:  [GENTRAN1.map

Save as pe: IMaps [*.rnap) j Cancel |

12. We recommend that you store maps in the map folder where
GENTRAN:Director isinstalled.

13. Type the name of the map (1-8 characters) in the “File name” box. The
default file extensionis“.MAP”

14. Click SAVE to save the map.

After creating the system import map, you need to define the header
record for the system import map. You can use either a six-field key
(thisisthe preferred method) or the alternate key method.
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Defining the

Six-Field Key To usethe preferred method of building the system import key, you need to
define at least five fields for the header record (partner key, standard,
version, transaction, and test/production status). If itisa TRADACOMS
map, you must also define arelease field. These fields do not haveto bein
any order or sequence, but they must be part of the header record.

If you want to also define the other fields that the corresponding import map
header record contains, you can do so at thistime.

B Please see Creating the First Record on page - 25 for more information
on how to define the header record.

B Please see Creating Fields on page - 32 for more information on how to
define the fieldsin the record.

Once you define the header record and fields, you can set up the mapping
operations that defines the key that the translator usesto find the partner
relationship.

Defining the Complete the following steps to define the partner key:

Partner Key 1 pouble-click the partner key field to display the Field Properties dialog.

Field Properties
Nane [PARTNERLID
Description I Partrer | dentifiar
[ ata W alidation .
it tax  Type Farmat —
v tandatom I‘I IEI IString |£I |><

Click Advanced>>

2. Click ADVANCED>> to access the Advanced section which enablesyou
to definerules.

3. Inthe Advanced section, click the Use Standard Rule check box to
display the rule options.
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4. Verify that the Select option is selected.

5. Fromthe Tablelist, select “Partner by EDI Code,” “Partner by Alternate
code,” or “Partner by Partner Key.” This indicates that the system
updates this field with the indicated partner key.

The Advanced section of the Field Properties dialog should now look
likethis:

Marne FARTHER_ID FPartner [dentifier

EdiCode STaMDARD Standard

Alternate Code YERSIOM Wersion
TRAMSACTIOM_SET Transaction Set
TEST_FPROD Test/Production Flag

6. Click OKto add the standard rule to the partner key field.
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Defining 'the Complete the following steps to define the EDI standard field:
Standard Field b e click the standard field to display the Field Properties dialog.

Field Properties
Name 51ANDARD
Description I Standard
D ata W alidatiorn
Min  Max  Type Format —
M Mandatory 1|1 [sting [ [%

Click Advanced>>

2. Inthe Advanced section, click the Use Standard Rule check box to
display the rule options.

3. Click the Update option.

rédvanced

¥ Use Standard Rule
' Select @ Update O Constant O Use Accum O Loop Count O Use Code

Table/Key | 3|

Field | |#]

4. From the Table/Key list, choose “Document record.” Thisindicates that
you are updating the document record in the GENTRAN:Director
internal system buffer (because the trandator is not mapping data at this
point in the process).

5. Fromthe Field list, choose “ Agency.” Thisindicates that you are
updating the agency (standard) field in the system buffer.
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The Advanced section of the Field Properties dialog should now look
likethis:

“Advanced

¥ Use Standard Rule
() Selec! @ Update O Constant O Use Accum ) Loop Count ) Use Code

Tahleey IDncument record |£I

Field [Agency 2]

6. Click OK to add the standard rule to the standard field.

Defining the Complete the following steps to define the version:
Version Field . L . ) -
1. Double-click the version field to display the Field Properties dialog.

Field Properties E
ore  [vERSON
Diescription IVersiDn
Data v alidation )

Min  Max  Type Format —
M Mandatory |6 6| [suing  [#] [«

Click Advanced>>

2. Inthe Advanced section, click the Use Standard Rule check box to
display the rule options.

Click the Update option.

From the Table/Key list, choose “ Document record.” This indicates that
you are updating the document record in the GENTRAN:Director
internal system buffer (because the trandator is not mapping data at this
point in the process).

5. Fromthe Field list, choose “Version.” Thisindicates that you are
updating the standard version field in the system buffer.
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The Advanced section of the Field Properties dialog should now look
likethis:

rbdwanced

¥ Use Standard Rule
) Select @ Update O Constant C) Use Accum O Loop Count O Use Code

Table ey IDDcument record IEI

Field I\a"ersinn IEI

6. Click OK to add the standard rule to the version field.

Defi.ning _the Complete the following steps to define the transaction set (document):
Transaction Field 4 o i click the transaction set fidld to display the Field Properties dia-

log.

Field Properties E
Mame [ TRANSACTION_SET
Description ITransaction Set

Data v alidation Ny

tin Man  Tupe Format
oz

v Mandatory |1 IE IString

Foszition...

Click Advanced>>

2. Inthe Advanced section, click the Use Standard Rule check box to
display the rule options.

3. Click the Update option.
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4. From the Table/Key list, choose “ Document record.” Thisindicates that
you are updating the document record in the GENTRAN:Director
internal system buffer (because the trandator is not mapping data at this
point in the process).

5. Fromthe Field list, choose “ Transaction Set ID.” Thisindicates that you
are updating the transaction set field in the system buffer.

The Advanced section of the Field Properties dialog should now look
likethis:

ridvanced

¥ Use Standard Fule
() Selecl @ Update O Constant O Use Accum O Loop Count ) Use Code

Tablesfey I Document record Iil

Field ITransaction SetID |£I

6. Click OK to add the standard rule to the transaction set field.

Defining the Complete the following steps to define the release of the selected standard
Release Field version (TRADACOMS only):

1. Double-click the transaction set field to display the Field Properties dia-

log.
Field Properties
Description I Fielease
Data alidation )
Min Maw  Type Format
W Mendtoy [1 | [5 | [svima [3] [ [ Condors..|

Click Advanced>>

2. Inthe Advanced section, click the Use Standard Rule check box to
display the rule options.
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3. Click the Update option.

4. From the Table/Key list, choose “Document record.” Thisindicates that
you are updating the document record in the GENTRAN:Director
internal system buffer (because the trandator is not mapping data at this
point in the process).

5. Fromthe Field list, choose “Release.” Thisindicates that you are
updating the release field in the system buffer.

The Advanced section of the Field Properties dialog should now look
likethis:

rbdwanced

¥ Use Standard Rule
) Select @ Update O Constant O Use Accum C) Loop Count ) Use Code

Tablefdkep IDocument record IEI

Field IF!elease |EI

6. Click OK to add the standard rule to the release field.
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Defining the Test/  Complete the following steps to define the test or production status field:
Production Field . . , ) .
1. Double-click thetest or production field to display the Field Properties

diaog.
Field Properties E3

e [TESTPROD
Drezcription ITesh’F’rnduction Flag

Click
Advanced>> Erata W atidator

tdin Max  Type Farmat —

[ Mandstory {1 |1 [suing  [#] [

2. Inthe Advanced section, click the Use Standard Rule check box to
display the rule options.

Click the Update option.

4. From the Table/Key list, choose “Document record.” Thisindicates that
you are updating the document record in the GENTRAN:Director
internal system buffer (because the trandator is not mapping data at this
point in the process).

5. Fromthe Field list, choose “ Test Mode.” This indicates that you are
updating the release field in the system buffer.

The Advanced section of the Field Properties dialog should now look
like this:

rédvanced

V¥ Use Standard Rule
) Selecl @ Update O Constant O Use Accum O Loop Count O Use Code

Tablesfey IDDcument record Iil

Field ITest tode |EI

6. Click OKto add the standard rule to the test or production status field.
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Defining the
Alternate Key

Defining the
Partner Key

To use the alternate key method of building the system import key (formerly
referred to as the “three-key method”), you need to define (create new or
update existing) three or four fields for the header record. You must define a
field for partner key, afield for either one or both application ID and
application alias value (you only need to use one of these two fields), and a
field for test/production status. If you define all four fields, you are using the
alternate key method; if you use only one of the application ID or application
aliasvaluefields, you are actually using athree-field key. Thesefields do not
have to be in any order or sequence, but they must be part of the header
record.

You do not haveto define new fieldsto usethiskey. You
can add the necessary standard rulesto threefields
that already exist in your application file.

If you want to also define the other fields that the corresponding import map
header record contains, you can do so at thistime.

B Please see Creating the First Record on page 25 for more information
on how to define the header record.

B Please see Creating Fields on page 32 for more information on how to
define the fields in the record.

Once you define the header record and fields, you can set up the mapping
operations that defines the key that the translator usesto find the partner
relationship.

Complete the following steps to define the partner key:
1. Double-click the partner key field to display the Field Properties did og.

Field Properties
Nane [PARTNER D
Description I Partrer Identifier
Data alidation ’
Min Maw  Type Format —
¥ Mandatory {1 |3 [Sting  [#] [%

Click Advanced>>

2. Click ADVANCED>> to access the Advanced section which enablesyou
to definerules.
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3. Inthe Advanced section, click the Use Standard Rule check box to

display the rule options.

4. Verify that the Select option is selected.

rédvanced
¥ Use Standard Rule
® Select O Update O Constant 0 Use Accum O Loop Count O Use Code
Table I IEI [ Exclusive
Sub Table |
kap From
L1 5] 5]

5. FromtheTablelist, select “Partner by EDI Code,” “Partner by Alternate
code,” or “Partner by Partner Key.” This indicates that the system
updates this field with the indicated partner key.

The Advanced section of the Field Properties dialog should now look

likethis:

rbdwanced

™ Use Standard Rule

® Select O Update C) Constant C) Use Accum O Loop Count O Use Code

Table I Partner by ED| code

|£I [T Exclusive

Sub Table |

4 ap Fram

Mame
Edi Code
Alkermate Code

]

6. Click OKto add the standard rule to the partner key field.
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Defining the  complete the following steps to define the application ID field:
Application ID
Field You must define either the application ID field or the
Application AliasValuefield (three-field key). You may
define both of thesefieldsif you wish to usethe
alternate key method.

1. Double-click the standard field to display the Field Properties dialog.

Field Properties E2
Mame I:D«F'F'L_ID
Description I.&pplicatinn 1D
Data v alidation )

Min ~ Max  Type Format
[ Mandatory ID IE ISytzng IEI |><

Click Advanced>>

2. Inthe Advanced section, click the Use Standard Rule check box to
display the rule options.

3. Click the Update option.

rédvanced

¥ Use Standard Rule
' Select @ Update O Constant O Use Accum O Loop Count O Use Code

Table/Key | 3|

Field | |#]
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4. From the Table/Key list, choose “Document record.” Thisindicates that
you are updating the document record in the GENTRAN:Director
internal system buffer (because the trandator is not mapping data at this
point in the process).

5. Fromthe Field list, choose “ Application Field 1.” Thisindicates that
you are updating an optional key field in the system buffer.

The Advanced section of the Field Properties dialog should now look
like this:

ridvanced

W Use Standard Rule
() Selec! @ Update O Constant O Use Accum ) Loop Count ) Use Code

Tahleey IDocument record Iil

Field I.-’-‘«pplication Field 1 |£I

6. Click OK to add the standard rule to the application ID field.
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Defining the  complete the following steps to define the application alias value field:
Application Alias
Value Field You must define either the application ID field or the
Application AliasValuefield (three-field key). You may
define both of thesefieldsif you wish to usethe
alternate key method.

1. Double-click the standard field to display the Field Properties dialog.

Field Properties E3
Mams [4PPL_aLlas vaLUE
Drezcription I.-’-‘«pplicatinn Alias Value

Data M alidatior

tdin Max  Type Farmat —
C Mengsay [o | [5 | [surs (3] %

Click Advanced>>
2. Inthe Advanced section, click the Use Standard Rule check box to
display the rule options.
Click the Update option.

4. From the Table/Key list, choose “Document record.” Thisindicates that
you are updating the document record in the GENTRAN:Director
internal system buffer (because the trandator is not mapping data at this
point in the process).
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5. Fromthe Field list, choose “ Application Field 2.” Thisindicates that
you are updating an optional key field in the system buffer.

The Advanced section of the Field Properties dialog should now look
likethis:

rédvanced

¥ Use Standard Rule
(' Select @ Update O Constant O Use Accum O Loop Count O Use Code

Table ey I Document recard |£I

Field I."-‘-.pplicatinn Field 2 Iil

6. Click OK to add the standard rule to the application alias value field.

Defining the Test/ |f you do not define the test/production status field, the document record is
Production Field setto“production” by default. In this situation, the system translation object
can only locate the correct relationship if the test mode of the partner
relationship is actually set to “production.” We recommend that you define
the test/production status field.

Complete the following steps to define the test/production status field:
1. Double-click the transaction set field to display the Field Properties

dialog.
Field Properties E
T
Description ITesh’F’roduclion Flag
Click < )
Advanced>> Erata W atidator
tdin Max  Type Farmat —
W Mendsay [1 | [1 | [our (8] [
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2. Inthe Advanced section, click the Use Standard Rule check box to
display the rule options.

Click the Update option.

4. From the Table/Key list, choose “Document record.” Thisindicates that
you are updating the document record in the GENTRAN:Director
internal system buffer (because the trandator is not mapping data at this
point in the process).

5. Fromthe Field list, choose “ Test Mode.” This indicates that you are
updating the release field in the system buffer.

The Advanced section of the Field Properties dialog should now look
likethis:

rédvanced

¥ Use Standard Rule
' Select @ Update O Constant O Use Accum O Loop Count O Use Code

Table ey IDDcument record IEI

Field [ Test Mode 2]

6. Click OK to add the standard rule to the test or production status field.
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Compiling the
System Import
Translation
Object

After you create, define, and save the system import map, you need to
compile the map and create a system import translation object. The map that
you create using GENTRAN:Director is a source map. When that source
map is compiled, the result is a compiled trandation object.

Complete the following steps to generate the system import translation
object:

1. Select Compile from the File menu or the Main Tool bar to display the
Run-Time Translation Object Name dialog.

Run-Time Tranzlation Object Hame

Save jh Ia TransObj j gl E

File name:  [HEADER.TPL

Save as hpe: ITransIation Objects . TPL] j Cancel |

2. Typethe name of the translation object, if necessary. The“File name”
box automatically contains the 1-8 characters you used to name the
source map. Use the default . TPL file extension.

Be very careful not to overlay the source map with the
compiled trandation object. Usethe . TPL fileextension

to distinguish the translation object.

3. Fromthe“Savein” list, change the Drive and Folder where the
compiled translation object is stored, if necessary.

4. Click SAVE and the system compiles the map and create athe system
import translation object.

5. Thetrandation object must registered with the GENTRAN:Director
system before you can useit. See the GENTRAN:Director User’s Guide
for information on registering a translation object.

6. If your system administrator has not already added this system import
translation object to the System Configuration program, do so now.
Please see Modifying Import Parameters in the Administration Guide
for more information on how to modify import parameters.
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To trandate inbound data, you need to create an export map in
GENTRAN:Director (because the system is exporting to your application
file). The export map defines how to move data from the EDI standard-
formatted documents that your partners send you to your application file
(flat file definition). This map also enables you to populate your application
file fields with supplementary information from the interchange, group, and
transaction set envelopes.

This chapter explains how to set up the export process, including the
following topics:

B Inbound process prior to exporting data

B Using supplementary envelope information

Press F1 from any area of the system to accessthe
online Help for that function. The online Help system
contains dialog box element definitions and other
detailed infor mation.
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Inbound Process Prior to Exporting Data

During the export process, the Communicator receives interchanges from
your trading partners via a network and passes the interchanges to the
translator. The translator uses a system interchange break translation object
(shipped with GENTRAN:Director) to unwrap the interchange envel opes
and separate each group into temporary storage. The translator uses asystem
group break translation object (shipped with GENTRAN:Director) to
unwrap the group envel opes and separate each transaction set into temporary
storage. The trandator uses a system transaction break trandlation object
(shipped with GENTRAN:Director) to unwrap the transaction envel opes and
separate each document into the ?In Documents in GENTRAN:Director.

The trangdlator attempts to locate the trading relationship for each document.
If atrading relationship islocated, the trandator then attemptsto identify the
export, document turnaround, or print translation object associated with that
relationship. If the translator does not locate the trading relationship or
translation object, the document staysin the ?2ln Documents. If the translator
does locate atrading relationship and translation object, it uses that
translation object to compliance check the document. If the document is not
compliant with the EDI standard, it stays in the ?ln Documents. If the
document is compliant with the EDI standard, the trandator movesit to the
In Documents. From the In Documents, you can print (if thereis an
associated print trandation object), or export valid documents.

If you specify (in the trading rel ationship) that the system needsto generatea
functional acknowledgement for a document, the translator uses the system
acknowledgement translation object (shipped with GENTRAN:Director) to
generate the acknowledgement. If the generated acknowledgement was
compliant, the trandlator moves the acknowledgement to the Out Documents
to be sent to the trading partner. If the generated acknowledgement was not
compliant or if an error occurred with the acknowledgement trandation
object, the translator moves the acknowledgement to the 20ut Documents.

If you specified either automatic export or automatic turnaround in the
trading relationship, the trand ator uses the specified export or document
turnaround tranglation object to either export or generate the appropriate
response document.
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To set up the export process, complete the following steps:

1. Createan export map
Please refer to Creating a New Map on page 18 for more information on
how to create a new map.

2. Register the export map with GENTRAN:Director
Please refer to the GENTRAN:Director User’s Guide or online Help for
more information on registering a translation object.

3. Createtheappropriateinbound trading relationship
Please refer to the GENTRAN:Director User’s Guide or online Help for
more information on creating an inbound relationship.
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Using Supplementary Envelope Information

The GENTRAN:Director Application Integration subsystem enables you to
use a Select standard rule to populate your application file fields (in an
export map) with information from the EDI envel opes associated with the
documents your trading partner sends you.

Complete the following steps to use supplementary envelope information in
your application file:

1. Double-click an existing application field, or create anew field (please
see Using a Fixed Format File for more information on creating fields).

The Field Properties dialog is displayed.

Field Properties
Descriptian I Ervelope Information
Data alidation
Min Maw  Type Format
[ Mandatoy [0 [30  [swing  [3] [ w

Click Advanced>>

2. Click ADVANCED>> to access the Advanced section which enablesyou
to definerules.

3. Inthe Advanced section, click the Use Standard Rule check box to
display the rule options.
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4. Verify that the Select option is selected.

rédvanced

¥ Use Standard Rule
® Select O Update O Constant 0 Use Accum O Loop Count O Use Code

Table I IEI [ Exclusive

Sub Table |

Map From Map To

« | [+] [« ] [+]

5. Fromthe Tablelist, select “ Generic envelope segment.” This enables
you to map from any of the fields within the current envelope
information, regardless of the EDI standard used.

6. Click the Exclusive check box to indicate that acompliance error should
be generated if the select does not find avalid entry.
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7. Fromthe Map From list, choose the envel ope information that you want
to map to your application field, based on the following table:

Map From Selection Information You Want Mapped

Field 1

Transaction Set ID

Field 2

Document Name

Field 3

Group ID

Field 5

Partner Name

Field 6

Interchange Control Number

Field 7

Group Control Number

Field 8

Document Control Number

Field 9

Received Version

Field 15

Received Agency

Field 16

Used Agency

Field 17

Used Version

Field 22

ISA Test Mode

Field 23

Document Test Mode

Please be certain that you choose the correct Map
From selection. Any selection that isnot listed in the
abovetableiscurrently reserved and should not be
selected under any circumstances.

8. From the Map To list, choose the field to which you want to map the
contents of the Map From field. Each field from the output side of the

map is displayed in thislist.

9. If you want to map additional envelope information, repeated steps 7
and 8 as many times as necessary. A total of eight fields can be mapped

using one Select rule.

10. Click OK to add the standard rule to the application field.
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Extended rules enable you to use a GENTRAN:Director proprietary
programming language to perform virtually any mapping operation you
reguire. You can use these rulesto define more complex translations than are
available through the link function (simple mapping) and standard rules.

This chapter explains how to use extended rules, including the following

topics:

B Introducing extended rules
B When rulesare processed
B Defining extended rules

B Extended rule syntax

B Languagereference

Press F1 from any area of the system to accessthe
online Help for that function. The online Help system
contains dialog box element definitions and other
detailed infor mation.
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Declarations
Section

You can use extended rules to define operations that are not possible using
standard rules. You define extended rules with the GENTRAN:Director
proprietary programming language. Thisisafull programming language that
gives you access to the entire GENTRAN:Director internal storage area.

Any variables that are not already defined as part of the input or output
specification of the map, that you use in arule must be declared before you
use those variables. Therefore, an extended rule consists of two sections, a
declarations section followed by a statements section. The declarations
section isonly required if you use additional variables. Thisiswhere you
declare the names and types of any variables you use either in thisrule or in
any other rule that is within the scope of this rule. The statements section is
where you define the actions that you want the rule to execute.

The variables that you define in the declarations section are used to store
values. Variables consist of a name and a data type. Variable names can
include alphanumerics and the colon and underscore characters. The first
character in a variables name may not be a numeric. Please note that all
variable names are case-sensitive.

A declaration must be terminated with a semicolon (;).
To improvereadability, you typically include a blank

link in between the declar ation and statement sections.

The data types that are supported by extended rules are the following:

B Integer —isawhole number with no decimal component.

Real —is awhole number that may have a decimal component.
String — contains one or more printable characters.

Datetime — contains a date or time.

Array — defines atable of multiple occurrences of asingle data type.
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Statements
Section

Examples of declarations of variables of each data type are as follows:

Declarei as an integer

integer i;

Declarer asarea number

real r;

Declare d asadate or time
datetime d,;

Declare s as a 20-character string
string[20] s;

Declare a asan array of 10 integers
integer a[10];

Declare p as an array of 50 10-character strings
string[10] p[50];

The actual work performed by an extended rule is defined in the statements
section. A rule consists of a statement or a combination of statements (to
perform more complex operations). A statement is a single operation that
consists of acombination of expressions, keywords, commands, operators,
and symbols.

An expressionisalogical unit (e.g., A =B or A + B) that the system
evaluates. The statements section consists of a sensible combination of
keywords, operators, and symbols. Each of these componentsis explained in
detail in Extended Rule Syntax on page 253.
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When Rules are Processed

Scope

You can specify pre- and post-session rules on the Session Rules dialog. Pre-
session extended rules are processed before the translation object, and arein
scope for every extended rule defined in the translation object. Post-session
rules are executed after the translation object is processed.

You can attach extended rules to three different levels of map components:

B EDI fileand application file groups, using the Loop Level Extended
Rules dialog.

B Groups, sub-groups, repeating records, and repeating segments, using
the Loop Level Extended Rule dialog.

B Fiedsand elements, using the Field Level Extended Rule dialog.

The scope of an extended rule determines which variables are accessible
from within a given extended rule. The scope varies depending on the
current state of the map. The scope of an extended rule is defined as follows:

B Pre-session extended rules (defined on the Session Rules dialog) are in
scope for every rulein the translation object.

B On Begin extended rules (defined on the Loop Level Extended Rules
dialog) arein scope until the conclusion of its companion On End rule
(also defined on the Loop Level Extended Rules dialog).

B Fieldlevel extended rules are only in scope for the duration of the field
or element.

An extended rule attached to the current map component depends on the
type and state of the map component. For example, if a current group to
which the ruleisattached i s subordinate to another group, the parent group is
automatically in scope for the duration of the entire child group, and the
current hierarchical structureis also in scope for the duration of the child by
using an addressing method that is explained on page 255. An extended rule
that is attached to afield or element is only in scope for the duration of the
field or element. Field level extended rules are always processed after
standard rules.

The diagram on the following page illustrates when loop level (On Begin
and On End) extended rules and field level extended rules are processed in
relation to the system process flow.
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Input rule processing

Output rule processing

A variableis considered to be “in scope” if it was declared in the current
rule, in the On Begin rule of a group that contains the current map
component, or in the Pre-Session rule.

Thetrandator builds the data storage areafor a map based on the structure of
the Input side of the map (the source side of the map). Therefore, extended
rules address the map based on the hierarchy of the Input side. When you use
extended rules, you must be careful to always address the Input side of the
map so the trandlator can locate the map component that the rule accesses.
On the Output side of a map, extended rules only have access to the current
record and the entire Input side of the map. However, from the Input side of
amap, you have accessto the entire file structure. Aslong as you addressthe
source end of alink, you can write to any field on the Output side, even
fields that have already been written.

The trandlator processes the Input side of the map first and then the Output
side. The following is the sequence of how the translator processes rules on
the Input side of a map:
1. Load the Input definition.
2. Readthelnput file.
3. Determineif datais present for the first/next group and then run the
group On_Beginrule, if present.
4. Load eachfield in the group and execute field level rules (for each field)
in the following sequence:
B Run standard rules
B Run extended rules
5. At the end of the group, execute the On_End rule, if present.
6. Repeat steps?2 - 5 for each group in the Input file.

The following is the sequence of how the translator processes rules on the
Output side of amap:

1. Verify whether or not data exists for the first/next record.
2. If therecord isthefirst record of agroup, run On_Begin rule, if present.

3. For each field in the record, execute field level rules (for each field) in
the following sequence:

B Run standard rules
B Run extended rules
4. Format data according to specified field properties (on Field Properties
dialog).
Write the record to the Output file.
At the end of the group, execute On_End rule, if present.
Repeat steps 1 - 6 for each record in the Output file.
Create or update the document entry in the database.

© N o o
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Defining Extended Rules

The map component that an extended rule accesses depends on what you
want the scope of therule to be. You also need to determine when you want
the rule to be execute (e.g., before or after the map component is processed.

The process you need to follow to define an extended rule varies slightly,
depending on whether you are defining a session rule or arule for amap
component. You can define extended rules to access three different levels of
map components.

Defining a Session Complete the following steps to define a session rule:

Rule 1. To specify apre- or post-session rule, select Session Rulesfrom the Edit
menu. The Session Level Extended Rules dialog is displayed.

i Seszzion Level Extended Rules =] B3

Editor

Cancel

Compile

Pl

" o

Compile Emots
Click the Pre-session option to Click the Post-session option to
define a pre-session rule define a post-session rule
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If you want to define a pre-session rule, click the Pre-session option. If
you want to define a post-session rule, click the Post-session option.
Pre-session extended rules are processed before the trandlation object,
and arein scope for every extended rule defined in the translation
object. Post-session rules are executed after the translation object is
processed.

You can define both a Pre-session and a Post-session rule for the agiven
session.
In the Editor list, type the extended rule.

If you want to check the rule for errors, click COVPI LE to compile the
extended rule. Any warnings or errors are displayed in the Errorslist.

This function gives you immediate feedback about the accuracy of your
rule. Regardless, the rule is compiled when you compile the entire
translation object.

Correct any errors that the system flagged and click COVPI LE again.
Repeat this process until there are no errors generated.

Click OK to add the extended rule,

Defining a Map Complete the following steps to define an extended rule for a map
Component Rule component:

1

Click the map component with the right mouse button to access the
shortcut menu. Select Rules... (or Extended Rule... if the map
component isafield or element) from the shortcut menu.

B |f the map component is an EDI file, application file, group, sub-
group, repeating record, or repeating segment, the Loop Level
Extended Rules dialog is displayed.

B |f the map component isafield or element, the Field Level
Extended Rule dialog is displayed.
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i Loop Level Extended Rules !EIE
Click either the On Begin

or the On End 4{ @ OnBegn ¢ OnEnd )
option / Editor

Type the rule in the

Editor list Compile

Cancel

_.
[ e

\ s i}

Compile Emars

i Field Level Extended Rule |_ (O] x|

ﬁ;le

1

0K

Cancel

Type the rule in the

Rule list —

\ )

Cornpile Errars
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If you want the extended rule to be executed before the system
processes the map component, click the On Begin option. If you want
the rule to be executed when the system concludes its processing of that
map component, click the On End option. You can define both an On
Begin and an On End rule for the a single map component.

In the Editor list, type the extended rule.

If you want to check the rule for errors, click COVPI LE to compile the
extended rule. Any warnings or errors are displayed in the Errorslist.

This function gives you immediate feedback about the accuracy of your
rule. Therule is compiled when you compile the entire translation
object.

Correct any errors that the system flagged and click COVPI LE again.
Repeat this process until there are no errors generated.

Click OK to add the extended rule.
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Extended Rule Syntax

Keywords and
Commands

The statements section of an extended rule consists of asensible
combination of keywords, operators, and symbols. The correct syntax for
each of these component is explained below.

You use spaces and operators to separate keywords and symbols. You cannot
string two keywords sequentially together without an operator.

A keyword is afixed defined use of aword that indicates how the
programming language should be interpreted. There are two types of
keywords. The first type of keyword controls the flow of execution of the
defined rule. These keywords are used to evaluate conditions and perform
looping operations. The second type of keyword is a command. Commands
perform actions on variables and are responsible for the movement of data.
A list of GENTRAN:Director execution control keywords s as follows:;

IF

THEN

ELSE

BEGIN

END

WHILE

DO

CONTINUE

BREAK
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A list of GENTRAN:Director commandsis as follows:

GET

SET
STRDATE
CONCAT
LEN

ATOI
ATON
CERROR
EMPTY
EXIST
INDEX
NTOA
COUNT
DELETE
FSEEK
FTELL
READBLOCK
LEFT

MID
RIGHT
SELECT
UPDATE
WRITEBLOCK

0 A statement must be terminated with a semicolon (;).
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Operators
Operators define the simplest operation in an expression. You can use the
following operatorsin extended rules:
+ addition, concatenation
- Subtraction
*  multiplication
[ division
= assignment, equality
> greater-than
< lessthan
>= greater-than or equal to
<= less-than or equal to
I= not equal to
I logical not
& logical and
| logical or
<< date modification

Symbols

Operations are performed on symbols. The symbols that you can usein
GENTRAN:Director extended rules are variables, constants, map
components/internal storage, arrays, and accumulators. You can address
existing map components and you also have the ability to create additional
instances of map components, as long as the map component is originally
defined ininternal storage. You can use this function to create, for example,
extraline items when one line item field is already defined in internal
storage. You must address each type of symbol in the proper syntax.

B To address a string constant, you must enclose the constant valuein
quotes:
#fieldname="HDR";
where HDR isthe constant value

B Toaddressafield or create afield in internal storage, within the scope
of the current mapping action, the syntax is#FIELD_NAME
#ield_1=2;
where 2 is anumeric constant value

B Toaddressafield within agroup or create afield within agroup in
internal storage within the scope of the current hierarchy, the syntax is
$GROUPHFIELD_NAME
$N1.#0234

GENTRAN:Director Application Integration User’'s Guide December, 1998 255



Extended Rule Syntax Using Extended Rules

B Tofully address agroup in the entire internal storage area or create a
group ininternal storage, the syntax is $L OOP[index1][index2][index3]
where the index entries indicate the hierarchical structure of the loop
and enable you to address specific instances of a group:
$Group_C[3][2] #Field_2
where you are specifying the second instance of Group_C within the
third instance of Group_B:

Group A

Group B

Group C

SR

B Toaddressan array (of any type), you address each element of the array
individually. For example, if array_1 isan array (of integers) and is
declared:

integer array_1[5]

with variables 0 through 4, each element of the array is addressed
individually as follows:

array_1[0]

array_1[1]

array_1[2]

array_1[3]

array_1[4]
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B Anaccumulator can be accessed in the same manner as variables or
internal storage. To address an accumul ator, use the syntax accum(n)
where “n” isthe number (not the name) of the accumulator:
accum(2) =5;

An example of asimple statement is as follows:

keywords

operator

: $Group_Name#Field_N ame |#Fi el d_Name|2;

symbols
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Common

Statements and

258

Examples

Assignment

Some of the common statements are as follows:
assignment

datetime expressions

conditional logic

string conditions and functions

numerical functions

raise compliance error function

remove field value function

existence of datafunction

The assignment statement is the most powerful and most often used
extended rule statement. In the most simple form, it is written as follows:

variable=expression

However, you can use this statement in more flexible and complex ways,
defined as follows:

numeric_variable=numeric_expression
numeric_field=numeric_expression
string_variable=string_expression
string_field=string_expression
datetime_variable=datetime_expression
datetime_field=datetime_expression

A numeric expression can consist of numbers, numeric fields, numeric
variables, and numeric functions combined with the standard arithmetic
operators. A string expression can consist of string constants, string fields,
string variables, and string functions concatenated with the “+” operator. A
datetime expression can consist of a datetime constant, datetime field or
datetime variable.

Some exampl es of assignment expressions are as follows:
a=5;

a=b+gc;

s="hello";

s=s+"world";
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Datetime Datetime expressions consist of a datetime variable and (optionally)
Expressions datetime modifiers. Datetime expressions can be written using datetime

constants if you are using the standard syntax, as follows:

year/month/day
hour:minute: second
year /month/day/hour :minute; second

Datetime expressions can also be written with datetime fields, variables, or
using date and time functions. Date functions are written as follows (month
specified as 0-11):

datetimed;

d = date(1995,4,6);
d = date(1995,4,6,12,0);
d = date(" %y/%m/%d" , " 95/4/6" );

Thed = date(" %y/% m/%d", " 95/4/6" ); format enables you to convert
any string format type into a datetime format type by indicating a format
mask (" %y/% m/%d") along with the string (" 95/4/6" ) you want to
convert. You use thisfunction if you are using non-standard syntax and need
to specify the syntax you are using.

You can use the << operator to modify your datetime variable by adding time
increments (e.g., days, weeks, years). For example:

datetimed;
d=d <<weeks(2);
/IThisadds 2 weeksto d.

Time functions are written as follows:

d = time(12,0);
d = time(12,0,59);

You can use the << operator to modify your datetime variable by adding time
increments (e.g., seconds, minutes, years). For example:

datetimed;
d=d <<seconds(1);
/IThisadds 1 second to d.

The get and set functions enable you to access (get) or modify (set)
individual components of a datetime type. These functions are used as
follows:

integer a;
datetimed,;

a = get days (d);
a = get hours(d);
set hour (d,a);
set days (d,a);
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Conditional Logic GENTRAN:Director uses conditional logic to test conditions and then,
depending on the results of the test, perform different operations. Conditions
can be nested to any level. Do not end conditions with a semicolon (;) —this
terminating syntax is necessary for statements only.

You can use the IF/THEN keywords to execute one or more statements
conditionally. The condition istypically a comparison, but it can be any
expression that concludes with a numeric value. GENTRAN:Director
interprets the value as either true or false. The system interprets a zero value
as false and a nonzero value as true.

If you include more than one statement in the body of
an IF/THEN loop, you must surround the statements
with the BEGIN/END keywords. If you only usea

single statement, you can omit the BEGIN and END.

GENTRAN:Director evaluates the IF/THEN condition, and if it istrue, the
system executes all the statements that follow the THEN keyword. If the
condition is false, none of the statements following THEN are executed.

You can use the EL SE keyword in conjunction with IF/THEN to define
several blocks of statements, one of which is executed. GENTRAN:Director
teststhe first IFFTHEN condition. If the condition is false, the system
proceeds to test each sequential condition until it finds one that is true. The
system executes the corresponding block of statementsfor the true
condition. If none of the IF/THEN conditions are true, the system executes
the statements following the EL SE keyword. The IF/THEN/EL SE statement
iswritten as follows:

IF condition THEN

BEGIN
statementl;
statement2;

END

ELSE

BEGIN
statement3;
statement4;

END
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String Conditions
and Functions

An example of when you may use conditional logic isif you need to evaluate
whether an N1 or NAD group contains billing or shipping information (this
depends on the qualifier that afield in the group contains), and then map that
information to the appropriate application fields. For this example, you need
to add an On End extended rule to the NI/NAD. Theruleis executed when
the group terminates. An example of the syntax of the rule follows:

IF #0098 ="BT" THEN

BEGIN
$Group_Name#BILLTONAME = #0093;
$Group_Name. #BILLTOADDR1 = #0166;
$Group_Name#BILLTOADDR?2 = #0166:2;
$Group_Name#BILLTOCITY =#0019;
$Group_Name#BILLTOSTATE = #0156;
$Group_Name. #BILLTOPCODE = #0116;

END

IF #0098 =" ST" THEN

BEGIN
$Group_Name#SHIPTONAME = #0093;
$Group_Name#SHIPTOADDRL1 = #0166;
$Group_Name#SHIPTOADDR2 = #0166:2;
$Group_Name#SHIPTOCITY =#0019;
$Group_Name#SHIPTOSTATE = #0156;
$Group_Name#SHIPTOPCODE = #0116;

END

You can use string conditionsin IF/ THEN and IF/ THEN/EL SE statementsto
perform comparisons between strings. Examples of the syntax are as
follows:

IFsl=s2THEN
IFs1<s2THEN
IFs1>s2 THEN

The following string functions are also available for you to use:
left

right

mid

strdate

concat

Sstrstr
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The left, right, and mid functions enable you to extract substrings from a
string. The left function extracts a specified number of characters from the
left of the string variable or field and returns the result as a string. The right
function extracts a specified number of character from the right of the string
variable and returns the result as a string. The mid functions extracts from a
specified position in the string to the right, either to the end of the string or
for a specified number of characters. These statements are used as follows:

string[1Q] s;
string[3] s1;
string[3] s2;
string[4] s3;
string[7] $4;

s="abcdefghij";
sl = left(s,3);

2 =right(s,3);
s3 = mid(s,3,4);
A = mid(s,3);

The strdate function converts a datetime type into a string using aformat that
you specify. This function allows you to include static characters such asa
dash (/), which gives you accessto full date support. The syntax isas
follows:

datetime d,;
string[8] s;

strdate(d,” %y/% m/%d" ,s);

The concat function concatenates a specified number of characters from one
string onto the end of another string. The following example demonstrates
the syntax to concatenate five characters from string “s2” onto the end of
string “s1”:

string[10] s1,82;

concat(sl,s2,5);

The strstr function finds a substring inside a string. This function returns the
position of thefirst instance of the designated substring. If this function does
not find the specified substring inside the string, it returns avalue of “-1.”
The syntax is asfollows:

integer d;

d =strstr("hello”, " d");
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Numerical Thenumerical functions enable you to convert one data type to another. The
Functions numerical functionsthat are available for you to use are the following:

B len

H aoi

B aon

B ntoa

The len function counts and returns the number of charactersin astring. An
exampleisasfollows:

integer a;
a=len("hello"),

The atoi function converts strings into integers. The aton function converts
string into real numbers. The ntoa function converts real numbersinto
strings. An example is afollows:

integer a;

real b;

string[8] s;
a=atoi("5");

b =aton("5.5");
ntoa(5.5, 9);

Raise Compliance Thecerror function raises acompliance error. The syntax is as follows:

Error Function o p6r(100,$1L D[O][1][1] #VATC):
(CERROR) ) _
The above exampl e rai ses compliance error 100 on the VATC element of the

specified instance of the ILD group. You typically specify thisfunction asan
action to be performed if acondition isfalse.

Remove Field The empty function sets the value of afield ininternal storage to null. This
Value Function functionisnot the same as setting the value of afield to a zero length string
(EMPTY) ("")ortozero. The syntax is asfollows:

empty($! L D[O][1][1] #VATC);

The above example sets the value of the specified instance of the VATC
element to null. When this function is used in expressions, the null valueis
propagated if any part of the expression is evaluated to be null. Thisfunction
istypically used to test whether or not an error occurred.
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Existence of Data The exist function returns a non-zero (true) value if thereisdatain a

Function (EXIST) specifiedfieldininternal storage. If thereis not data in the specified field,
this function returns a zero (false) value. Thisfunction istypically usesas a
part of a condition. The syntax is as follows:

IF exist($ILD[0][1][1] #VATC) THEN

The above example returns a non-zero value if the condition istrue (datais
present in the specified instance of the VATC element). A zero valueis
returned if the condition isfalse (no datais present in the specified instance
of the VATC element).

There are some situations (for example, if the field or element hasa"Use
Code" standard rule applied to it) when the IF EXIST returns a non-zero
(true) value whether or not the condition istrue. You can work around this
by only using IF EXIST for date- and number-type fields. Be certain that all
references to the field which is interrogated are nested within the |IF EXIST
begin block. For string-type fields, use the following format:

IF Fieldl=""

Count Function The count function returns the total number of times a group (or repeating
(COUNT) record) hasiterated. The syntax is as follows:

count(GROUPNAME[3][*]);

The above example returns the total iterations of the GROUPNAME group
within the third iteration of the parent group.

Delete Function The delete function deletes the specified iteration of a repeating record or
(DELETE) group. The syntax is as follows:

delete(GROUPNAM EJiteration]);

File Pointer The fseek function moves the file pointer to anew location which isa
Functions (FSEEK, specified number of bytes (offset) from the beginning of the file (origin). To
FTELL) invoke the fseek function against the input file, the value for current_fileis
“0.” To invoke the fseek function against the output file, the value for
current_fileis“1.” The fseek function istypically only used in conjunction
with the ftell, readblock, and writeblock functions. The syntax is as follows:

fseek(current_fileoffset,origin);
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Block of Data
Functions
(READBLOCK,
WRITEBLOCK)

Select Function
(SELECT)

Theftell function obtains the current position of the file pointer and returnsit
as an integer. To invoke the ftell function against the input file, the value for
current_fileis“0.” To invoke the ftell function against the output file, the
value for current_fileis“1.” Thefseek functionistypically only used in
conjunction with the fseek, readblock, and writeblock functions. The syntax
isasfollows:

numeric_variable = ftell(current_file);

The readblock function reads a block of data (segment or record) from the
input file and placesit into the argument of a string variable. The writeblock
function writes the data contains in the argument of a string variable to the
output file. The readblock and writeblock functions are used in conjunction
with each other to pass a block of datafrom the input file to the output file
without compliance checking or testing for proper EDI syntax. Together
these functions provide a more efficient alternative of using “wildcard”
segments, which are typically implemented in build and break maps. The
syntax is as follows:

readblock(string_variable);
writeblock(string_variable);

The select function alows information to be retrieved from the database
tables. Only the tables and fields available in the Select standard rule are
available for the select extended rule. In the command syntax “expression”
and “receiverlist” can be astring field, string variable, or string literal. It is
important to note that the table and field names for the select extended rule
are dightly different than those depicted in the standard rule. A listing of
these table and field names can be found at the end of this chapter. The
syntax is as follows:

select fieldname into receiverlist from tablename where key = expression
[and key = expression];
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Update Function The update function allowsinformation in the database tables to be updated.
(UPDATE) Thisfunction is similar to the Update standard rule, except that it provides

more flexibility. Only the tables and fields available in the Update standard
rule are available for the update extended rule. In the command syntax
“expression” can be astring field, string variable, or string literal. It is
important to note that the table and field names for the update extended rule
are dightly different than those depicted in the standard rule. A listing of
these table and field names can be found at the end of this chapter. The
syntax is as follows:

update tablename set fieldname =expression [fieldname =expression]
where key = expression [and key = expression];
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Alphabetic Language Reference

This section contains an a phabetic reference for the GENTRAN:Director
proprietary programming language keywords and commands. This enables
you to quickly and easily refer to information on specific keywords or
commands. This section uses the following conventions:

While Bold typeface is used to express what you need to
type.

condition In syntax, italic lettersindicate information that you
need to provide.

[1] In syntax, items inside sgquare brackets are optional .

The following programming guidelines are utilized in this section:

B Keywordsand commands are shown in all lower case letters.
Map components are shown in all upper case letters.
A double slash (//) introduces comments.

Linesthat are too long to fit on one line in this section may be continue
on the next line using a line-continuation character (w»).

atoi

The atoi function is a numerical function that converts strings into integers.
The numerical functions enable you to convert one data type to another.

The syntax isasfollows:
int = atoi(string);

where: int = integer variable
string = string variable

An exampleisasfollows:

integer a;
string[20] s;

s="5"
a = atoi(s);
/I"a" containsthevalue5b
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aton

begin

The aton function is a numerical function that converts stringsinto real
numbers. The numerical functions enable you to convert one data type to
another.

The syntax is asfollows:
real = aton(string);

where: rea = real number variable
string = string variable

An exampleisasfollows:

real b;
string[20] s;

s="55";
a = aton(s);

/I"a" containsthevalue5.5

GENTRAN:Director uses conditional logic to test conditions and then,
depending on the results of the test, perform different operations. Conditions
can be nested to any level. You can use the if/then keywords to execute one
or more statements conditionally. If you include more than one statement in
the body of an if/then loop, you must surround the statements with the
begin/end keywords. If you only use a single statement, you can omit the
begin and end.

Do not end conditionswith a semicolon (;) —this
terminating syntax is necessary for statements only.

The syntax is asfollows:

if condition then
begin
statementl,;
statement?2;
end
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break

cerror

The break function terminates the execution of the nearest enclosing while
loop, and passes control to the statement that follows the end keyword. The
break keyword is generally used in complex loops to terminate aloop
before several statements have been executed.

An exampleisasfollows:

integer i
integer j;

i :j =0;
whilei<10 do
begin
if (i = 8) then
continue;
if (I =9) then
break;
end

/[Aslongas"i" hasavaluelessthan " 10" theloop repeats. If "i" has
/lavalueof "i", theloop continues. If "i" hasavalue
/lof " 9" theloop terminates.

The cerror function raises a compliance error. You typically specify this
function as an action to be performed if a condition isfalse.

The syntax is asfollows:

cerror(error_number,$GROUP_NAM E[index][index][index].
w#FIELD_NAME);

An exampleisasfollows:
cerror (100,$I L D[O][1][1] #VATC);

/IThisraises compliance error 100 on the VAT C element of the
/Ispecified instance of the ILD group
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The compliance error codes are as follows:

Error Generated

100

Mandatory Element

105

Conditional Element

110

Incorrect Element Format

115

Incorrect Element Length

120

Too Many Components

125

Element Delimiter

130

Conditional Relation

135

Element Code

140

Implicit Rule Failure

200

Mandatory Component

205

Conditional Component

210

Incorrect Component Format

215

Incorrect Component Length

220

Component Delimiter

225

Component Code

300

Mandatory Segment

305

Segment Sequence

310

Invalid Start End

400

Session Error

405

Unknown Partner

410

Invalid Ctl Number

415

Invalid Sub Count

420

Unknown Relationship

425

Unknown Standard
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concat

Error
0 Error Generated
Number
430 Unknown Version
435 Unknown Transaction

The concat function concatenates a specified number of charactersfrom one
string onto the end of another string.

The syntax is asfollows:
concat(string,string,num_char);

where: string = gtring variable
num_char = number of characters from the second string onto the
end of thefirst string

An exampleisasfollows:
string[10] s1,82;
concat(sl,s2,5);

/[Concatenate five charactersfrom string " s2" onto the end of string
/" s1"
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continue

count

delete

The continue function continues the execution of the innermost loop
without processing the statements in the loop that follow the continue
Statement.

An exampleisasfollows:

integer i
integer j;

i :j =0;
whilei<10 do
begin
if (i = 8) then
continue;
if (I =9)then
break;
end

/[Aslongas"i" hasavalueof "8" theinnermost loop repeats. If "i"
/ldoes not have avalueof " 8" the next statement (break statement)
/lis processed.

The count function counts and returns the number of iterations of a group.
An exampleisasfollows:

integer i;
i = count($N1[*]);

/IThe[*] isawildcard that countsthe number of iterations of the N1
/lgroup.

The delete function deletes a specified occurrence of a group.
The syntax is asfollows:

delete($GROUP_NAME[N]O;

where [n] is the occurrence of the group that you want to delete.
An exampleisasfollows:

delete($1 LD[2]);

/IDeletes the second occurrence of the ILD group.
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empty

The empty function sets the value of afield in internal storage to null. This
function is not the same as setting the value of afield to azero length string
(" ") or to zero.

The syntax is asfollows:
empty($GROUP_NAME[index][index][index]. #FIELD_NAME)

An exampleisasfollows:

empty($ILD[0][1][1] #VATC);

//Set the value of the specified instance of the VAT C element to null
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end

exist

GENTRAN:Director uses conditional logic to test conditions and then,
depending on the results of the test, perform different operations. Conditions
can be nested to any level. You can use the if/then keywords to execute one
or more statements conditionally. If you include more than one statement in
the body of an if/then loop, you must surround the statements with the
begin/end keywords. If you only use a single statement, you can omit the
begin and end.

Do not end conditionswith a semicolon (;) —this
terminating syntax is necessary for statements only.
The syntax is asfollows:

if condition then
begin
statementl;
statement2;
end

The exist function returns a non-zero (true) valueif thereisdatain a
specified field in internal storage. If there is not datain the specified field,
this function returns a zero (false) value. Thisfunction istypically used asa
part of a condition.

The syntax is asfollows:

if exist($GROUP_NAMEJindex][index][index]. #FIELD_NAME) then
An exampleisasfollows:

if exist($ILD[O][1][1] #VATC) then

/IReturn a non-zero value if the condition istrue (data is present in the
/Ispecified instance of the VATC element). A zero valueisreturned

/fif the condition isfalse (no data is present in the specified instance of
/lthe VAT C element).

There are some situations (for example, if the field or element hasa"Use
Code" standard rule applied to it) when the IF EXIST returns a non-zero
(true) value whether or not the condition istrue. You can work around this
by only using IF EXIST for date- and number-type fields. Be certain that all
references to the field which is interrogated are nested within the IF EXIST
begin block. For string-type fields, use the following format:

IF Field1=""
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fseek

The fseek function moves the file pointer to a new location which isa
specified number of bytes (offset) from the beginning of the file (origin). To
invoke the fseek function against the input file, the value for current_fileis
“0.” To invoke the fseek function against the output file, the value for
current_fileis“1.” The fseek function istypically only used in conjunction
with the ftell, readblock, and writeblock functions. The syntax is as follows:

fseek(current_file,offset,origin);

Theftell function obtains the current position of the file pointer and returnsit
as an integer. To invoke the ftell function against the input file, the value for
current_fileis“0.” To invoke the ftell function against the output file, the
valuefor current_fileis“1.” Thefseek functionistypically only used in
conjunction with the fseek, readblock, and writeblock functions. The syntax
isasfollows:

numeric_variable = ftell(current_file);

An exampleisasfollows:
string[1024]temp_buffer;
Integer Position;

Position = ftell(0)

whilereadblock(temp_buffer) do

begin
if left(tem_buffer,3) =" IEA" then
begin
fseek (0,Position,begin);
break;
end

writeblock (tem_butffer);
Position = ftell(0);
end

/IRead segment from input file and placein temp_buffer. L ook for

/" EA" segment tag. If found, reset file pointer to whereit was before
/Ithe" IEA" segment wasread. Write contents of temp_buffer to output
[file. Set " Position" =the current file pointer position.
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get

The get function enables you to access individual components of a datetime
variable.

The syntax is asfollows:

integer variable = get datetime_component (datetime_variable);

integer variable

individual component of the datetime
variable

datetime variable of which you want to
access a component part

where: integer_variable
datetime_component

datetime variable

An exampleisasfollows:

integer a;

integer b;

datetimed,;

a = get days (d);

b = get hours (d);

/[Accesses the days from the datetime variable " d" and loadsinto

/Ivariable" a" . Accessesthe hours from the datetime variable"d" and
/lloadsinto variable" b" .
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if...then...else

Theif, then, and el se keywords allow the use of conditional logic.
GENTRAN:Director uses conditional logic to test conditions and then,
depending on the results of the test, perform different operations. Conditions
can be nested to any level. You can use the if/then keywords to execute one
or more statements conditionally. The condition is typically a comparison,
but it can be any expression that concludes with a numeric value.
GENTRAN:Director interprets the value as either true or false. The system
interprets a zero value as false and a nonzero value as true.

GENTRAN:Director evaluates the if/then condition, and if it istrue, the
system executes all the statements that follow the then keyword. If the
condition is false, none of the statements following then are executed.

You can use the else keyword in conjunction with if/then to define several
blocks of statements, one of which is executed. GENTRAN:Director tests
the first if/then condition. If the condition is false, the system proceeds to
test each sequential condition until it finds one that istrue. The system
executes the corresponding block of statements for the true condition. If
none of the if/then conditions are true, the system executes the statements
following the else keyword.

Do not end conditionswith a semicolon (;) —this
terminating syntax is necessary for statementsonly.

An exampleisasfollows:

if condition then

begin
statementl,;
statement2;

end

ese

begin
statement3;
statement4;

end
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index

left

Theindex function enables you to determine which instance of a particular
loop the trandlator is currently accessing.

The syntax is asfollows:
index(integer_variable);

where: integer_variable = integer variable that indicates the
hierarchical level for which you want to
determine the loop count

An exampleisasfollows:

index(1)

/IThisextended ruleislocated on the ILD group in the diagram below.
/IThisdeterminesthe current loop count for thefirst level (ODD) in the
/Inierarchical structure.

INVOIC M- INVOICE DETAILS £F
00D -M- 393999 £
ILD -M- 399939 £F-

The left function extracts a specified number of character from the left side
of astring variable or field and returns the result as a string.

The syntax is asfollows:

string_variable = left(string_variable,num_char)
where: num_char = integer variable

An exampleisasfollows:

string [25]name;

string [5]temp_variable;

name =" Acme Shipping Company"
temp_variable = left(hame,4);

/[ temp_variable" would contain " Acme"
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len

messagebox

Thelen function isanumerical function that counts and returns the number
of charactersin a string. The numerical functions enable you to convert one
data type to another.

The syntax is asfollows:
number_char = len(string);

where: num_char = integer variable
An exampleisasfollows:

integer a;

a=len("helo");

/I"a" containsthevalue5

The messagebox function enables you to display a message box for which
you have designated the format and content. You can specify the number and
type of buttons on the message box, the message icon (e.g., hand, question
mark, exclamation point, or asterisk), and the message displayed. You can
also issue areturn value based on the chosen action.

The syntax isasfollows:
messagebox (" message” ,defined_number)

where: message = message string
defined_number = defined number of the desired buttons plus the
defined number of the desired icon (if used)

An exampleisasfollows:

if messagebox(" Do you really want to delete this object?" ,36) = 6
begin

end

/IDisplays a message box with the given string asthe message, YES and
/INObuttons (4) and a question mark icon (32). The number and type of
/Ibuttons (4) plustheicon (32) equalsthe defined_number (36). If the

/luser clicksthe YES button (return value" 6"), the statementsin the
/Ibegin/end loop ar e executed.
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The defined_numbers for the button and icon types are as follows:

IID\leufmke)gr_ Button or Icon Types
0 K button only

1 K and CANCEL buttons

4 YES and NObuttons

16 Icon Hand

32 Icon Question Mark

48 Icon Exclamation Point

64 Icon Asterisk

The message box return values are as follows:

Action Selected

XK selected

CANCEL selected

YES selected

N[O | N

NoO selected
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mid

ntoa

The mid function extracts from a specified position in a string, either to the
end of the string or for a specified number of characters and returns the
resultant string.

The syntax is asfollows:
string_variable = mid(string_variable,start_pos,num_char)

where: start_pos
num_char

integer variable
integer variable

An exampleisasfollows:

string [25]name;

string [10]temp_variable;

name =" Acme Shipping Company"
temp_variable = left(name,5,8);

/[ temp_variable" would contain " Shipping"

The ntoa function is a numerical function that converts real numbersinto
strings. The numerical functions enable you to convert one data type to
another.

The syntax is asfollows:
string = ntoa(real ,string);

where: rea = real number variable
string = string variable

An exampleisasfollows:

real b;
string[8] s,

b=55;
ntoa(5.5, s);
/[Thevariable"s" containsthestring"5.5".
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readblock

right

The readblock function reads a block of data (segment or record) from the
input file and placesit into the argument of a string variable.The readblock
and writeblock functions are used in conjunction with each other to pass a
block of datafrom the input file to the output file without compliance
checking or testing for proper EDI syntax. Together these functions provide
amore efficient alternative of using “wildcard” segments, which are
typically implemented in build and break maps.

The syntax is asfollows:
readblock(string_variable);
An exampleisasfollows:

whilereadblock (temp_buffer) do

begin
if left(tem_buffer,3) =" IEA" then
begin
fseek (0,Position,begin);
break;
end

writeblock (tem_butffer);
Position = ftell(0);
end

/IRead segment from input file and placein temp_buffer. L ook for

/" EA" segment tag. If found, reset file pointer to whereit was before
/Ithe" IEA" segment wasread. Write contents of temp_buffer to output
[file. Set " Position" =the current file pointer position.

Theright function extracts a specified number of characters from the right
side of astring variable or field.

The syntax is asfollows:

string_variable = right(string_variable,num_char)
where: num_char = integer variable

An exampleisasfollows:

string [25]name;
string [10]temp_variable;

name =" Acme Shipping Company"
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temp_variable = left(hame,7);

/[ temp_variable" would contain " Company"

GENTRAN:Director Application Integration User’s Guide December, 1998 283



Alphabetic Language Reference Using Extended Rules

select

set

The select function allows information to be retrieved from the database
tables. Only the tables and fields available in the Select standard rule are
available for the select extended rule. In the command syntax “expression”
and "receiverlist” can be astring field, string variable, or string literal. It is
important to note that the table and field names for the select extended rule
are sightly different than those depicted in the standard rule. A listing of
these table and field names can be found at the end of this chapter. The
syntax is as follows:

select fieldname into receiverlist from tablename where key = expression
[and key = expression];

An exampleisasfollows:
string[10]temp_var 1,temp_var2,temp_var3;

select Textl, Text2, Text3 intotemp_varl, temp_var2, temp_var3from
w Partnerlookup where Tablename =" Test" and Item =" widgit"

/[Example assumesthat a L ookup table named " Test" has been
/lcreated.

The set function enables you to define individual components of a datetime
variable.

The syntax is asfollows:

set datetime_component (datetime_variable,integer_variable);

where: datetime_component = individual component of the datetime
variable

datetime variable of which you want to
access a component part

integer variable

datetime variable

integer_variable
An exampleisasfollows:

integer a;
integer b;
datetimed,;

set days (d,a);
set hours (d,a);

/IDefines the days of the datetimevariable” d" from variable" a".
/IDefinesthe hour s of the datetime variable " d" from variable" b" .
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strdate

The strdate function converts a datetime type into a string using a format
that you specify. Thisfunction allowsyou to include static characters such as
adash (/), which gives you access to full date support.

The syntax is asfollows:
strdate(datetime,"format” ,string);
where: datetime = datetime variable (month specified as 0-11)

format = desired date format
string = string variable

An exampleisasfollows:

datetimed;

string[8] s

strdate(d,” %y/% m%d" ,s);

/[Converts a datetime variableinto an eight character stringin the
/[format " year/month/day" .

The format specifiers are as follows:

Si)oercniqf?ér Description

%a Abbreviated weekday name

%A Full weekday name

%b Abbreviated month name

%B Full month name

%d Day of the month as a decimal nhumber (01 — 31)
%H Hour in 24-hour format (00 — 23)

%I Hour in 12-hour format (01— 12)

%] Day of the year as a decimal number (001 — 366)
%m Month as a decimal number (01 — 12)

%M Minute as a decimal number (00 — 59)

%S Second as a decimal number (00 — 59)
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FO”T“?“ Description

Specifier

%U Week of the year as a decimal number, with Sunday
as the first day of the week (00 — 51)

%W Weekday as a decimal number (0 — 6, with Sunday
as “0”)

%W Week of the year as a decimal number, with Monday
as the first day of the week (00 — 51)

%y Year without the century as a decimal number (00 —
99)

%Y Year with the century as a decimal number

%% Percent sign

strstr

The strstr function finds a substring inside a string. Thisfunction returnsthe
position of the first instance of the designated substring within the specified
string.

The syntax is asfollows:

integer = strstr("string","substring");

where: integer
string
substring

integer variable
string
part of the string

An exampleisasfollows:
integer d;

d = strstr (" mississippi” ,"is");

/[Findsthefirst instance of the substring " is" inside the string
/I" mississippi” and returnsthe position of that first substring.
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update

The update function allowsinformation in the database tables to be updated.
This function is similar to the Update standard rule, except that it provides
more flexibility. Only the tables and fields available in the Update standard
rule are available for the update extended rule. In the command syntax
“expression” can be a string field, string variable, or string literal. It is
important to note that the table and field names for the update extended rule
are sightly different than those depicted in the standard rule. A listing of
these table and field names can be found at the end of this chapter. The
syntax is as follows:

update tablename set fieldname =expression [fieldname =expression] where
key = expression [and key = expression];

An exampleisasfollows:
string[15]temp_variable;

temp_variable="5 Pound Hammer" ;
update Partner Xref set Textl = temp_variable where Myltem =
= PN5IbHMR" and Tablename =" Tools";

/[Example assumesthat a cross-reference table named " Tools" hasbeen
/lcreated.
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while...do

winexec

The while...do function executes a statement repeatedly until the specified
termination condition evaluates to zero. The system tests the terminating
condition before each iteration of the loop, so awhileloop executes zero or
more times depending on the value of the termination expression.

Do not end conditionswith a semicolon (;) —this
terminating syntax is necessary for statements only.
An exampleisasfollows:

integer i;

whilei <10do
begin
if (i =8) then
continue;
if (i =9) then
break;
end

/IWhile"i" islessthan ten, executetheloop. If "i" isequal to or greater
/Ithan ten, terminate the loop.

The winexec function enables you to execute another program while running
the trandator. This program is executed asynchronously. You specify the
program and determine how you want the program window displayed. You
can also return an error code, if desired. If the error code is greater than 32,
the program ran without errors. If the error codeisless than 32, the program
did not run because of an error. If the error code is“0,” the systemis out of
memory. If the error codeis“2,” you didn’t specify afile name. The error
code is not the return value from the program you executed.

The syntax is asfollows:

winexec("program",window_display)

where: program = executable program name string
window_display = number that indicates how you want the program
window displayed
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An exampleisasfollows:

winexec(" program.exe” , 3)

/[Exits GENTRAN:Director and executesthe" program.exe"
/lprogram asynchronoudly. The program window is displayed
/Imaximized (3).

The window_display nhumbersthat control the appearance of the program
window are as follows (you must use the number to indicate how you want
the program window displayed, not the window_display value):

Number Window_Display Definition
0 SW_HIDE Hides the window and activates another window.
1 SW_SHOWNORMAL Activates and displays a window. If the window is

minimized or maximized, it is restored to the
original size and position. This flag should be
specified when displaying a window for the first

time.

1 SW_NORMAL Activates and displays a window in the original
size and position.

2 SW_SHOWMINIMIZED Activates the window and displays it as a
minimized windows.

3 SW_SHOWMAXIMIZED Activates the window and displays it as a
maximized window.

3 SW_MAXIMIZE Maximizes the window.

4 SW_SHOWNOACTIVATE | Displays the window in its most recent size and

position, but does not activate it (the current
active window remains active).

5 SW_SHOW Activates the window and displays it in its current
size and position.
6 SW_MINIMIZE Minimizes the window.
7 SW_SHOWMINNOACTIV | Displays the window as a minimized window
E without activating it (the current active window

remains active).
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Number

SW_SHOWNA Displays the window in its most recent size and

Window_Display Definition

position without activating it (the current active
window remains active).

SW_RESTORE Activates and displays the window. If the window

was minimized or maximized, it is restored to its
original size and position.

10

SW_SHOWDEFAULT Activates the window and allows Windows to

determine the size and position.

290

writeblock

Select and

Thewriteblock function writes the data contains in the argument of a string
variableto the output file.The readblock and writeblock functionsare used in
conjunction with each other to pass a block of data from the input file to the
output file without compliance checking or testing for proper EDI syntax.
Together these functions provide a more efficient alternative of using
“wildcard” segments, which are typically implemented in build and break

maps.
The syntax is asfollows:
readbl ock(string_variable);
An exampleisasfollows:

whilereadblock (temp_buffer) do
begin
if left(tem_buffer,3) =" IEA" then
begin
fseek (0,Position,begin);
break;
end
writeblock (tem_butffer);
Position = ftell(0);
end

/IRead segment from input file and placein temp_buffer. L ook for
/I"[EA" segment tag. If found, reset file pointer to whereit was before
/lthe" I[EA" segment wasread. Write contents of temp_buffer to output
/ffile. Set " Position" =the current file pointer position.
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Update
Available
Options

Document Table

The following section contains the database table names and the associated
field names that are available when using the select and update extended
rules. Additional “keys’ are also available for certain tables. Where
applicable, a description of the key follows the field name.

The field names that are available when using the select or update extended

rules on the Document Table are the following:

Partner Table

TESTMODE

AGENCY

VERSION
TRANSACTIONSETID
RELEASE
DOCUMENTTYPE
REFERENCEDATA
DOCUMENTNAME
APPFIELD1
APPFIELD2
APPFIELD3
APPFIELD4
APPFIELD5S
APPFIELD6
DOCUMENTPARTNERKEY
CONTROLNUMBER
PARTNERKEY

The field names that are available when using the select or update extended

rules on the Partner Table are the following:

PARTNERNAME
EDICODE
APPLICATIONPARTNERKEY

The alternate keys that are available for the Partner Table are the following:
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PARTNERKEY
ALTERNATEKEY (refersto Application Key)
APPLICATIONPARTNERKEY (refersto Application Key)
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Location Table Thefield namesthat are available when using the select or update extended

rules on the Location Table are the following:

B CONTACTNAME
NAME

ADDRESS1
ADDRESS2
ADDRESS3

CITY

STATE

ZIP

COUNTRY
TELEPHONE
PRIMARY REFCODE
SECONDARY REFCODE
FAX

Lookup Table Thefield namesthat are available when using the select or update extended

rules on the Lookup Table are the following:

B ITEM
DESCRIPTION
TEXT1
TEXT2
TEXT3
TEXT4

The alternate key that is available for the Lookup Table is the following:

B TABLENAME

Cross-reference Thefield namesthat are available when using the select or update extended

Table rules on the Cross-reference Table are the following:

B MYITEM
PARTNERITEM
DESCRIPTION
TEXT1

TEXT2

TEXT3
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The alternate key that is available for the Cross-reference Table isthe

TEXT4

following:

B TABLENAME

Interchange Table Thefield namesthat are available when using the select or update extended

rules on the Interchange Table are the following:

TESTMODE

CONTROLNUMBER

VERSION

APPFIELD1
APPFIELD2
APPFIELD3
APPFIELD4
APPFIELD5
APPFIELD6
AGENCY

PARTNERKEY

Group Table Thefield namesthat are available when using the select or update extended

rules on the Group Table are the following;:
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TESTMODE

CONTROLNUMBER
FUNCTIONALGROUPID

VERSION

APPFIELD1
APPFIELD2
APPFIELD3
APPFIELD4
APPFIELD5
APPFIELD6
AGENCY
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Generic Envelope Thefield namesthat are available when using the select extended rule on the
Segment Table Generic Envelope Segment Table are the following:

B CONTROLNUMBER
SUBCOUNT
FIELD1
FIELD2
FIELD3
FIELD4
FIELDS
FIELD6
FIELD7
FIELD8
FIELD9
FIELD10
FIELD11
FIELD12
FIELD13
FIELD14
FIELD15
FIELD16
FIELD17
FIELD18
FIELD19
FIELD20
FIELD21
FIELD22
FIELD23
FIELD24
FIELD25
FIELD26
FIELD27
FIELD28
FIELD29
FIELD30
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Error Messages

The GENTRAN:Director error messages and other informational messages
are noted in the Compile Errors dialog when you compile the trandation
object or in the Error section of the Extended Rules dialogs when you
compile an extended rule containing errors prior to compiling the tranglation
object, and when you commit an erroneous action in GENTRAN:Director.
The informational messages are dependent on the context of the program,
and are intended to be self-explanatory. The error messages are described in
the topics accessed below, along with the actions you can take to correct the
problem. This chapter explains how to determine the action you should take
when you receive an error message, including the following topics:

B CompileError Messages (when you compile the translation object or
compile an extended rule containing errors prior to compiling the
translation object)

B GENTRAN:Director Error Messages (if you perform an erroneous
action in GENTRAN:Director)
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The Compile Error Messages are displayed in the Compile Errors dialog if
you compile atrand ation object with errors. Or, error messages are
displayed in the Error section of an Extended Rule dialog if you compile the
extended rule containing errors prior to compiling the translation object.
After you correct the cause of the errors, click the COVPI LE button again to
ensure that the rule is error-free.

The compile error messages are listed by the four- or five-digit message
number and the error message text. The error definitions contain the actions
that you can take to correct the problem (if appropriate) and a description
that includes possible causes of the error.

100 Mandatory Element Missing

Description: An element that the trandlation object designated as
“Mandatory” was not created in an Outbound document or
was not received in an Inbound document.

1000  expected '

Description: The rule does not have the required “.” between a group
name and afield name.

User Action: Insert a“.” between the group name and field name.

1001  no statement to compile
Description: Theruleis does not contain any statements.
User Action: Add a statement or statements to the rule.

1002  unexpected end of program
Description: The rule was not complete.
User Action: Finish therule.

1003  expected ')

Description: The rule does not have the required “,” between
parameters.

User Action: Insert a“,” between parameters.

1006  no statementsto compile
Description: The body of an IF/ELSE or WHILE condition was empty.
User Action: Complete the body of the unfinished condition.

1008  expected '#

Description: The rule does not have the required “#" before afield
name.

User Action: Insert a“#" before the field name.
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2000 group ... undefined

Description: Therule references a group that does not exist.

User Action: Change the reference to an existing group or delete the
reference.

2001 ...isnot amember of ...

Description: Therulereferences afield that does not belong to the
specified group.

User Action: Change the reference to an existing field in the specified
group.

2002 insufficient indicesto accessgroup ...
Description: The rule does not give the full addressing for agroup.
User Action: Compl ete the addressing for the group.

2003  too many indicesto access group...
Description: The rule uses too many addresses for the group.
User Action: Address the group correctly.

2004 ... hasnot been defined
Description: The rule references an undefined variable.
User Action: Define the variable in the declarations section.

2005 out of temporary variables

Description: The rule could not be compiled because some expressions
are too complex.
User Action: Simplify the expressions and compile the rule again.

2008 field type unknown
Description: The compiler was unable to determine the type of afield.
User Action: Verify that a Data Type is selected for thisfield.

2009 cannot reference alocal field with no current group

Description: Therule (probably pre- or post-session) references alocal
field, but is not associated with any group.

User Action: Reference the field using the proper addressing.

2010 instancesof '% 1" aretransient and cannot be accessed

Description: The rule references an output group using full addressing.
Thisform of addressing is only appropriate for input
groups.

User Action: Reference the output group with the proper address.

2011 nofield specified
Description: Therule omits afield reference.
User Action: Add the field reference to the rule.
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20700 only onebinary data and one binary length field are per mitted

Description: You have more than one binary data and/or more than one
binary length element in one segment.

User Action: Remove the additional binary data and/or binary length
elements from the segment.

20701 binary length must precede binary data

Description: The binary length element must be sequenced before the
binary data element in the segment so the trandator knows
how much data to expect.

User Action: Move the binary length element to before the binary data
element.

20702 incomplete binary data

Description: You marked a segment as binary, but did not include either
abinary length element or a binary data element (or both).

User Action: Add abinary length element and/or a binary data element
to the segment.

20703 group [group] has no active child objects

Description: You tried to compile the translation object, but the
specified group is empty.

User Action: Activate at least one child object in the group.

2100 ..isnot an array variable

Description: Therule uses array indexing for avariable that is not an
array.

User Action: Use the proper indexing for the variable.

2101  ..:arrayindex required

Description: Therule usesan array variable without using the necessary
array indexing.

User Action: Add the necessary indexing to the array variable.

2102  ...:array overflow

Description: Theruleusesaninvalid array index.

User Action: Use the proper array index for the array variable.

2103  only onewildcard index is permitted
Description: The rule uses more than one wildcard index.
User Action: Only one wildcard index is permitted per rule.

2104  awildcard index must be specified
Description: The rule does not specify awildcard index when required.
User Action: Add awildcard index where necessary.
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2200 expected astring
Description: A required string or string variable is not supplied.
User Action: Add the required string or string variable.

2201  dtring overflow

Description: A string overflow occurred.

User Action: Verify that the size of atarget string is equal to or greater
than the source string.

3000 array size expected in declaration of ...
Description: Invalid array declaration.

3001 declaration of ... missing ']’
Description: Invalid array declaration.

3002  string size expected
Description: Invalid string declaration.

3003 string sizemissing ']’
Description: Invalid string declaration.

3004 variable name expected
Description: Invalid variable declaration.

3005 ... already defined

Description: Two variables with the same name are defined at the same
scope.
User Action: Rename one of the two variables.

3006  expected an accumulator number, found ...

Description: Invalid accumulator reference.
3007 ...isnot avalid accumulator number
Description: Invalid accumulator reference.

4000 expected a numeric expression, found ...

Description: You specified something other than the expected numeric
expression.
User Action: Specify the correct numeric expression.

4001  expected aterm, found ...
Description: You specified something other than the expected term.
User Action: Specify the correct term.
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4002  expected '+ or '-'
Description: You specified something other than the expected “+” or

User Action: Specify “+” or “-".

4003  expected '"*' or '/’

Description: You specified something other than the expected “*” or
“ /” .

User Action: Specify “*"or"/".

4004  expected ')’
Description: You specified something other than the expected “)”.
User Action: Specify “)".

4005  expected afactor, found ...
Description: Invalid numeric expression.

4006  expected ‘('
Description: You specified something other than the expected “(”.
User Action: Specify “(".

4007 ...isof incorrect type
Description: The specified expression is of an incorrect type.
User Action: Specify the correct type for the expression.

4008  expected areational operator

Description: You specified something other than the expected rel ational
operator.

User Action: Specify the correct relational operator.

4009 missing argument
Description: A required parameter was omitted.
User Action: Add the required parameter.

4010 assignment expected

Description: The assignment operator was omitted from an assignment
statement.
User Action: Add the correct assignment operator to the statement.

4011  operator ... requirestwo arguments
Description: Only one parameter was supplied for abinary operator.
User Action: Supply a second parameter for the binary operator.

4100 expected adate, found ...
Description: A dateisrequired but not supplied.
User Action: Specify a date.

300 March, 1999 GENTRAN:Director Application Integration User’'s Guide



Error Messages

Compile Error Messages

GENTRAN:Director Application Integration User's Guide March, 1999 301

4101  expected a date modifier, found ...
Description: A date modifier was required but not supplied.
User Action: Specify a date modifier.

4102  ...isnot adate
Description: Invalid date expression.

5000 THEN expected
Description: The compiler expected a THEN condition.

5001 DO expected
Description: The compiler expected a DO condition.

5002 END expected
Description: The compiler expected a END condition.

5003 IF expected
Description: The compiler expected a IF condition.

5004 FROM expected
Description: The compiler expected a FROM condition.

5005 INTO expected
Description: The compiler expected aINTO condition.

5006 END without BEGIN

Description: An END statement was found without a corresponding
BEGIN statement.
User Action: Insert a BEGIN statement in the correct location.

5018 too many parameters
Description: Too many parameters were supplied for a function.
User Action: Remove the unnecessary parameters.

5019 too few parameters
Description: Too few parameters were supplied for afunction.
User Action: Add the necessary parameters.

6000 expected a database table name
Description: The compiler expected a database table name.
User Action: Insert a database table name in the necessary location.

6001 expected a database column name
Description: The compiler expected a database column name.
User Action: Insert a database column name in the necessary location.
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6002  too many column receivers specified

Description: The number of columns specified did not match the
number of receiversin a SELECT statement.

User Action: Correlate the number of columns specified inthe SELECT
statement to the number of receivers.

6003  too few column receivers specified

Description: The number of columns specified did not match the
number of receiversin a SELECT statement.

User Action: Correlate the number of columns specified inthe SELECT
statement to the number of receivers.

6004 WHERE expected
Description: The compiler expected a WHERE statement.

6005 expected a database key

Description: Aninvalid database key was specified in aWHERE
statement.

User Action: Specify the correct database key in the WHERE statement.

6006 WHERE not allowed with this databasetable

Description: A WHERE statement is not necessary to access the
specified database table.

User Action: Remove the WHERE statement.

6007 invalid key combination

Description: The combination of keys specified in the WHERE
statement is not avalid unique compound key to the table.

User Action: Specify avalid combination of keysin the WHERE
statement.
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The GENTRAN:Director error messages are displayed when you commit an
erroneous action. When the system displays an error message, you must first
acknowledge the message by either clicking OK, and then take the
appropriate action.

The error messages are listed alphabetically below by the first Ietter of the
error message text. The error definitions contain the actionsthat you can take
to correct the problem (if appropriate) and a description that includes
possible causes of the error.

A codelist entry must have a code value
Description: You attempted to add a code without an associated code
value.

A codelist must have an element id
Description: You attempted to create a code list without an element ID.

A codelist for thiselement already exists. You must use another element

id or deletetheoriginal codelist first

Description: You attempted to create a code list with the same element
ID asan aready existing code list.

User Action: Either change the element ID or delete the original code
list.

A condition field isrequired
Description: You established a conditional relationship that requires a
condition field, but did not specify a condition field.

A datatypeisrequired.
Description: You did not specify the Data Type of afield.

A field must have a namethat isunique within its parent group

Description: You tried to give afield anamethat is already in use by
another field within the same group (not necessarily the
same record).

A group must have a unique name
Description: You tried to give a group a name that is already used by
another group or record.
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A group or record with a maximum usage of 1 cannot be split or

promoted

Description: You attempted to split or promote a single-occurrence
group or record. Thisis not avalid action.

A key field has been selected but no key value has been specified.
Description: You established a key field without specifying a key value

A Memory Exception has occurred.
Description: A system error occurred.
User Action: Exit GENTRAN:Director and restart Windows.

A name must be entered
Description: You did not specify aname for an object.

A problem occurred while attempting to close loop ... Thisis probably
duetoincorrect standards.
Description: An error occurred when reading from the standards.

A record must have a unique name
Description: You tried to give arecord a name that is already used by
another group or record.

A Resour ce Exception has occurred.
Description: A system error occurred.
User Action: Exit GENTRAN:Director and restart Windows.

A seriouserror wasencountered whilst accessing the clipboard and the

action was abandoned

Description: The system aborted a cut, copy, or paste operation because
aserious error occurred.

User Action: Perform the cut, copy, or paste operation again.

A system error was encountered while compiling the translation object

Description: While compiling a translation object, a system-related
problem, such as lack of memory, prevented the compile
from completing.

User Action: Close unnecessary applications to free memory, and
reboot your computer (if necessary), and then recompile
the trand ation object.
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A TDF could not be generated dueto a lack of available memory. Either

restart Windows or close down other applications, then try again

Description: While generating a TDF, the system ran out of memory.

User Action: Exit GENTRAN:Director, restart Windows and regenerate
the TDF.

An accumulator must be chosen for thisentry
Description: You did not specify the accumulator to be used in aUse
Accum standard rule.

An invalid usage count has been entered
Description: You entered an invalid usage count for arecord or group.

No actions have been chosen for thisaccumulator entry
Description: You selected an accumulator but did not specify any
actionsfor it in aUse Accum standard rule.

No alternate accumulator hasbeen selected

Description: In aUse Accum standard rule, you attempted to create an
accumulator entry that used an alternate accumulator, but
did not specify which alternate accumulator should be

used.

No character ranges have been specified for thistoken.

Description: You did not specify the characters allowed for a syntax
token.

No fields have been used in thisrelationship
Description: You established a conditional relationship but did not
specify the fieldsinvolved.

No more accumulator entries can be created
Description: You attempted to create more than six accumulator entries
in aUse Accum standard rule.

No morefield mappings can be created
Description: You attempted to create more than eight field mappings
for a Select standard rule.
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Theconstant 1D must be unique.

Description: You entered aliteral constant identifier in the ID field that
isaready used in an existing constant.

User Action: Type aunique literal constant identifier in the ID field.

The contents of the clipboard cannot be pasted into the trandation

object at this point

Description: Either the Clipboard does not contain copied or cut data,
or you aretrying to paste EDI information into a positional
file format or paste position information into an EDI file
format.

Thefileformat cannot be deleted
Description: You tried to delete afile format object.

The Maximum Usage must be greater then zero and not less than the
Minimum Usage.
Description: You entered an invalid maximum usage count.

Thenumber of entriesto be split must begreater than zero and lessthan

the maximum number of entriesin theoriginal

Description: You entered an invalid number in the Split dialog. The
number to be split must be greater than zero and less than
the maximum number of entriesin the original.

Thetranslation object could not be compiled
Description: The translation object is not ready to be compiled.

Thetoken code must be unique.

Description: You attempted to create a syntax token with the same
token identifier as an existing syntax token.

User Action: Type a unique token identifier in the Token field.

Thesefields cannot be linked because the input field is deeper than the

output field. Thetrandator would be unableto addresstheinput field.

Description: You are attempting to create an invalid link. A valid link
involves an Input field and an Output field that are at the
same level.

Thesefields cannot be linked because the loop which theinput field

belongsto is shallower than the loop which the output field belongsto.

Description: You are attempting to create an invalid link. A valid link
involves an Input field and an Output field that are at the
same level.
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Thiscode already exists. You must use another code or deletethe

original code first

Description: You attempted to add a code to a code list that already
contained that code.

Thisfield cannot belinked to another field
Description: Due to an unknown error, GENTRAN:Director was
unable to begin creating the link.

Thisfileisnot avalid GENTRAN trandation object
Description: You attempted to open (load) afilethat is not atransdation
object.

You have entered an invalid character or character codein Record

Delimiter 1

Description: You entered an invalid Record Delimiter 1 on the
Positional File Format Properties dialog.

You have entered an invalid character or character codein Record

Delimiter 2

Description: You entered an invalid Record Delimiter 2 on the
Positional File Format Properties dialog.

You have entered an invalid decimal separator or character code.
Description: You entered an invalid decimal separator.

You have entered an invalid element delimiter character or character
code
Description: You entered an invalid element delimiter.

You have entered an invalid Pad character or character code
Description: You entered an invalid pad character for a positional field.

You have entered an invalid release character or character code
Description: You entered an invalid release character.
You have entered an invalid segment delimiter character or character code

Description: You entered an invalid segment delimiter.

You have entered an invalid sub-element delimiter character or
character code
Description: You entered an invalid sub-element delimiter.

You have entered an invalid tag delimiter character or character code
Description: You entered an invalid tag delimiter.
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You must enter a description of the trandlation object.

Description: You attempted to save the trandation object without
entering the trandation object description on the
Translation Object Details dialog.

User Action: Type the translation object description in the Description
field on the Translation Object Details dialog. Thisfield
must be unique because it is used by the system to identify
the map. We recommend that you use the following
identifying characteristics: the partner that thismap is used
for, the standard, the version, the type of transaction this
map uses, and the direction of the map (i.e., Import,
Export, etc.). For example, “MWT X 3030 850 Export” is
the description of amap used with partner MWT, for an
ANSI X.12 version 003030 Purchase Order (850), that is
sent Inbound (Export).

You must enter a subtable name.
Description: For a Select or Update standard rule, the selected table
reguires you to specify atable name in the Sub Table field.

You must enter avalid character range.
Description: You entered an invalid character range for a syntax token.

You must enter avalid syntax token.
Description: You did not enter avalid token identifier in the Token field
when creating or editing a syntax token.

You must enter avaluefor thisconstant.
Description: You did not specify avalue for the constant in the Value
field when creating or editing a syntax token.

You must enter an ID.

Description: You did not specify aliteral constant identifier for the
congtant in the ID field when creating or editing a syntax
token.

You must enter the name of the author of thistrandation object.

Description: You attempted to save the trandation object without
entering the name of the translation object author on the
Translation Object Details dialog.

You must select a constant type.
Description: You did not select a constant type from the Type list when
creating or editing a constant.

You need to specify Input and Output File Typesfor the new trandation

object

Description: You clicked OK on the Create New Translation Object
dialog without selecting both the Input Format Type and
Output Format Type.
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?In Documents

?0ut Documents

acknowledgement

activation

AIAG

ANA

ANSI

application file

This GENTRAN:Director browser contains alist of documents that were
received by the system but failed compliance checking or that do not have an
identifiable partner or transaction set.

This GENTRAN:Director browser contains alist of documents that were
imported into the system via unattended processing but are invalid.

Thistermisused to indicate the ANSI 997 functional acknowledgement, the
EDIA 999 acceptance/rejection advice, and the EDIFACT CNTRL
document.

This function enables you to make map components available for use. The
system activates all the groups, segments, composites, and elements that are
defined as “mandatory” (must be present) by the standard. The system does
not enable you to deactivate the mandatory groups, segments, composites,
and elements. When trandating data, the system does not process groups,
segments, composites, and elements (or records and fields) that are not
activated. Therefore, you must activate the groups, segments, composites,
and elementsthat are not defined as mandatory by the standard, but that you
have determined that you need to use in mapping.

The Automotive Industry Action Group (AIAG) is the standards-setting
group for the automative industry. The standards form a subset of the ANSI
X12 standard.

Article Numbering Association.

American National Standards Institute. ANS| sets standards for many
products and services, such as safety glasses and battery capacities. The
ANSI X12 committee isthe chief EDI standards-setting organization for the
United States.

If you are creating an import or export map, you must define your
application to GENTRAN:Director. In GENTRAN:Director terminology,
your application fileis also referred to as afixed-format file or a positional
file. Your application file must contain all the information that you either
need to extract from your partner’s document (if the map isinbound) or need
to send to your partner (if the map is outbound), so that your system can
accurately process the data.
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application system

browser

button

check box

click

code list tables

colours

communications
session

Communicator

compile
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Computer systems, outside of EDI, designed to fulfill specific business
functions. These include accounting, purchasing, materials control, human
resources, shipping, and other systems.

A browser isawindow that displaysalist of items, such as documents
(transaction sets), interchanges, transl ation objects, etc. A document browser
displays only documents.

A button enables you to execute acommand. You select a button either by
clicking it or by pressing TAB until the button you want is selected and then
pressing ENTER. Unavailable buttons are dimmed, and the currently
selected button has a darker border than the other buttons.

A check box enables you to select or clear optionsfrom alist. You can select
as many options from the list as you need. A selected check box contains a
checkmark. The labels of unavailable options are dimmed.

Click indicates that you should position your cursor on top of the designated
item and press and release your primary mouse button. The primary mouse
button is the button you access with your index finger, regardless of whether
you are utilizing right-handed or left-handed mouse operation.

These are used by EDI standards as repositories for lists of codes. Each EDI
standard provides a code list for each element that can be further defined
with a code.

This feature enables you to select foreground and background colours to
visually define the various map components. The use of colour is optional.

Everything sent and received to/from one tel ephone number in one
continuous period of connection. This could include sending two or three
interchange envel opes to a network, each for a different trading partner.

Thisisthe GENTRAN:Director communications software. The
Communicator enables you to send, receive, resend, establish
communication port definitions, establish communication profiles, establish
communication scripts, and view and delete communi cation sessions.

This function compiles the map and creates a trand ation object. The map
that you create using GENTRAN:Director is a source map. When that
source map is compiled, the result is a compiled trandation object. This
translation object must be registered with the GENTRAN:Director system
before you can useit.
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compliant
component data
element
composite data

element

conditions

constant

cross-reference table

date/time

deactivation

default

dialog box

This means that the document conforms to the EDI standards as defined by
the trandlation object.

A simple data element that belongs to acomposite data el ement. Component
data elements are also called sub-elements.

A contains two or more component data elements or sub-elements.
Composites are defined by the EDI standards that use them (EDIFACT,
TRADACOMS, and certain ANSI X12 standards).

Seerelational conditions.

This standard rule enables you to move aliteral constant valueto the
specified element or field, indicate a qualifying relationship with another
element or field, and map the current date or time to the specified element or
field.

Thistableis created in Partner Editor and is used to convert your values to
your trading partner's values during outbound processing, or your partner's
values to your values during inbound processing.

Thistype of field or element contains a date or time. If you specify that a
field or element is adate/time type, you must specify exactly how the date or
time must be formatted.

This function enables you to make map components unavailable for use by
the system. The system does not enable you to deactivate the mandatory
groups, segments, composites, and elements.

A predefined value — programs use these built-in val ues unless you
specifically override them.

A dialog box (or dialog) contains additional information or options that you
need to act on. If you specify any options, you can select a button to execute
the command. Some dialog boxes display warnings or messages indicating
why arequested task cannot be accomplished. If the dialog box has atitle
bar, you can move it to another location on your desktop.
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312

document

EANA

EDI

EDI standard

EDIA

EDIFACT

element

One transaction set containing actual data and treated as asingle entity. The
amount of datadoes not affect whether something is a document or not, only
thefact that it istreated asasingle entity. For example, regardless of whether
apurchase order contains one item or ten thousand, if it is one purchase
order, it is one document.

If atrading partner sends you a communication containing 10 purchase
orders, you have received 10 documents. If the communication contained 15
invoices, you have received 15 documents.

International Article Numbering Association, Brussels, Belgium.

Electronic Data Interchange (EDI) is the process by which companies can
exchange business documents directly from application to application by
computer without paper documents being produced.

Thisisthe rulesfor turning a business document into an EDI document.

The Electronic Data Interchange Association, formerly known asthe
Transportation Data Coordinating Committee (TDCC).

This is the standards organization of the United Nations Economic and
Social Council. The acronymis short for the Electronic Data Interchange for
Administration, Commerce, and Transport.

The smallest piece of usable information defined by the standards. Examples
might include a quantity, unit price, or description. An individual element
can have somewhat different meanings depending on context. Therefore,
elements are normally not considered to have useful meaning until they are
combined into segments. An element is the EDI map component that is
mapped (linked) to a corresponding application field to move data to and
from the EDI file.

There are three types of data elements, asillustrated in the table below:

Data Element Definition

Simple data element A single piece of information defined by
the standards.

Composite data A data element that is made up of

element multiple component elements.

Component data A simple data element that belongs to a

element composite data element. Component
data elements are also called sub-
elements.
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envelope A way of separating information in transmissions for ease of processing.
Each envel ope contains a header segment and a trailer segment, which
separate the envel ope from other envelopes and provide information about
the contents of the envelope.

There are three levels of envelopes, asfollows:

Transaction Set
Each transaction set (business document) is contained within atransaction
set envelope.

Functional Group

An envelope containing related business documents. The standards define
which transaction sets should be placed together into a functional group
envelope.

I nterchange Envelope

All material being sent to one trading partner in one communication. The
term Interchange Envelope is the term used by ANSI. EDIA uses the term
Transmission Envelopeto refer to thislevel of envelope. Since we use the
term transmission for other uses, we refer to Interchange Envelope only.

A communications session could easily include a

number of interchange envelopes. For thisreason, the
standar ds-setting bodies are considering a fourth level
of envelopeto cover an entire communications session.

equalize Thisfunction enables you to reinstate the two sides of the map with focusin
equal dimensions. The use of the Equalize function is optional.

export map This map defines how to move data from the EDI standard-formatted
documents that your partners send you to your application file (flat file
definition). An export map is necessary for inbound processing.

export translation See export map.
object

extended rules These rules enable you to use a GENTRAN:Director proprietary
programming language to perform virtually any mapping operation you
require.

field The smallest piece of information defined in the application file. A field is
the application map component that is mapped (linked) to a corresponding
EDI element to move datato and from your application file.

fixed-format file Seeapplication file.
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font

functional group

group

import

import map

import translation
object

inbound mapping

In Documents

This feature enables you to globally change the font that is used in the
display of all maps. The default font that GENTRAN:Director usesisa Sans
Serif 9 point. The Font feature enables you to change the font type, style, and
point size. This gives you the flexibility to shrink the font if you need to
view more of the map on your monitor, enlarge the font, or change the type
and style to be more easily readable by you.

A group of transaction sets that the standards-setting body (such as ANSI)
has defined as fitting together with other related transaction sets. An
example might be a Functional Group defined as containing all purchasing
transaction sets.

A looping structure that contains related records/segments and/or groups that
repeat in sequence until either the group data ends or the maximum number
of timesthat the loop is allowed to repeat is exhausted. If you create a group
that is subordinate to ancther group (a sub-group), this correspondsto a
nested |ooping structure (aloop within aloop). The application (positional)
file and the EDI file are both groups and therefore, they isvisually
represented the same way as other groups and sub-groupsin
GENTRAN:Director.

This command enables you to import data from an external application file.
Depending on the content of the file, the system may prompt you for partner,
transaction, or translation object information.

This map defines how to move data from your application file (flat file
definition), which may contain multiple documents, to the EDI standard-
formatted documents that your partners expect to receive from you. An
import map is necessary for outbound processing.

See import map.

The system trandlates your trading partner’s EDI standard formatted
business document to your application file format, so you can receive
documents from you partners. To trandate inbound data, you need to create
an export map.

This GENTRAN:Director browser contains alist of documents that the
system received but that have not yet been processed by the user. Once the
documents are processed (printed or exported) the documents are transferred
to the In Drawer.
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In Drawer

integer

interchange

Interchanges
browser

link

literal constant

location table

lookup table

loop count

loop start/loop end

This GENTRAN:Director browser contains alist of documents that were
received and processed.

An integer is a number that has an implied decimal point (e.g., “2.01" is
formatted as “201").

Theinterchange contains all the functional groups of documents (transaction
sets) sent from one sender to one receiver in the same transmission.

This GENTRAN:Director browser enables you to view a hierarchical list of
all the interchanges that were sent or received. It contains status information
about the interchanges, (e.g., whether or not afunctional acknowledgement
was received and the status of that acknowledgement). This browser also
enables you to access the documents within the interchanges. The

I nterchanges browser can always be accessed.

This function enables you to map afield or element from the Input side of
the map to afield or element on the Output side of the map. The link
between two map components (hereafter referred to asfields) isvisualy
represented with aline connecting the two fields.

These are used by the system as a repository to storeinformation that is used
at alater point in the map. Typically, constants are used in an outbound map
to generate a qualifier.

Thisisatable created in Partner Editor that is used to contain address-rel ated
information about the partner.

Thisisatable created in Partner Editor that is used to select information
related to avalue in inbound or outbound data.

This standard rule enables you to count the number of timesaloop is
repeated, if the element or field is part of aloop. If theloop is anested loop,
you can track the current loop or the outer loop. For example, if theY loopis
nested within the X loop, and the Y loop has cycled through 15 iterations
and the X loop has cycled through 3 iterations, you can choose to count
either the“15” (Y loop) or the“3" (X loop).

Certain EDI standards use Loop Start (LS) and Loop End (LE) segments. LS
and L E segments differentiate between two or more loops of the same type.
If the transaction contains LS and LE segments and depending on whether
your map isinbound or outbound, you need to definethe LSand LE
segments for the loops you are using in the map in one of two different ways.
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map

menu

menu bar

network

number

ODETTE

outbound mapping

316

Out Documents

Out Drawer

partner

Partner Editor

positional file

A set of instructions you define in the GENTRAN:Director Application

I ntegration subsystem that indicates the corresponding relationship between
your application file and the EDI standards, and defines how the system
should translate data.

A list of items from which you can choose. Each item represents a
command. Unavailable items on amenu are dimmed to inform you they are
disabled.

This contains the list of menus for the application.

Also known as a Third Party Network or Value-Added Network (VAN). A
service, such as COMMERCE:Network, that accepts and holds
transmissions from companies until it is convenient for atrading partner to
accept them.

Thistype of field or element contains either an integer or real number. If you
specify that afield or element is a number type, you must designate the
format by specifying aformat of either “N” (integer) or “R” (real) and the
number of decimal places.

The Organization for Data Exchange by Tele-Transmission in Europe.

The system translates your application file format to EDI standard formats,
S0 you can send documents to your partners. To translate outbound data, you
need to create an import map and a system import map in
GENTRAN:Director.

This GENTRAN:Director browser contains alist of documents that are
ready to be sent. After the documents are successfully sent, they are
automatically transferred to the Out Drawer.

This GENTRAN:Director browser contains alist of documents that were
successfully sent out by the system.

Another firm with which your company trades documents. Also referred to
as atrading partner.

This GENTRAN:Director function enables you to define, edit, and delete all
partner information for your company and all of your trading partners.

See application file.
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post

predefined

printout

promote

qualifier

real number

receive

record

relational condition

respond

This GENTRAN:Director function enables you to move compliant
documents from the Workspace to the Out Documents.

On adata entry translation object, a default value for a particular element.
You can change the value as necessary.

Thisis produced when data received from a trading partner passes through a
print translation object. You do not have to actually print the data. The
printout could be to afile on your hard disk.

This function extracts one iteration (instance) of a group or repeating
segment. This enables you to map unique data from your application file,
and/or enter aspecialized definition. GENTRAN:Director specifiesthat only
one-to-one (no loops) or many-to-many (loop) mapping relationships are
valid.

Thisisan element that has a value expressed as a code that gives a specific
meaning to the function of another element. A qualifying relationship isthe
interaction between an element and its qualifier. The function of the element
changes depending on which code the qualifier contains.

A real number has an explicit decimal point (e.g., “2.01” isformatted as
“2.01"), and truncates trailing zeroes.

This GENTRAN:Director function enables you to manually initiate a
communications session to receive data from your trading partner.

Contains a group of related fields. A record can occur once or can repeat
multiple times.

This function enables to connect fiel ds together for syntax or compliance
reasons. For example, Field A isinvalid unless Field B is present. Therefore,
if you set up acondition that pairs Fields A and B, the system generates a
compliance error if one of those fieldsis not present.

This GENTRAN:Director function enables you to create a turnaround
document (using the Turn Around translation object in the partner
relationship) in response to one or more selected documentsin the In
Drawer.
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responsible agency

segment

select

send

set
simple mapping

split

standard rules

status bar

An organization that develops and updates standards for EDI
communications. These organizationsinclude ANSI, EDIA, AIAG, UCS,
EDIFACT, ODETTE, and VICS.

A group of related elements or composite data elements that combine to
communicate useful data. Segments are defined by the EDI standards. A
segment can occur once or can repeat multiple times. For example, a catalog
price segment might consist of elements for item description, volume, price,
lead time, etc. By themselves, none of these elements would communicate
useful information. Together, they provide the information necessary for
someoneto tell if theitem iswhat is desired, whether the priceisreasonable,
etc. A number of segments together form a transaction set.

This standard rule enables you to select entries from alocation table, cross-
reference table, partner table, or lookup table (all tables created in the
GENTRAN:Director Partner Editor). You can then map the fields in those
tables to one or more fieldsin the data. The Select function uses the val ue of
the current field to perform the selection.

This GENTRAN:Director function enables you to manually start a
communications session to send datato your trading partner. Only selected
documents are enveloped and sent. If no documents are selected, ALL
documents are sent. Successfully sent documents are moved to the Out
Drawer.

See Transaction Set.
Seelink.

This function enables you to split (break) a group or repeating segment into
two loops. You typically use this function when you need more than one
instance of the same map component that still occurs multiple times.

These rules give you access to functions that are necessary for mapping
operations that are more complex than simple linking, but lessinvolved than
extended rules. Each of the standard rules are mutualy exclusive (you can
use only one on a particular field).

The status bar of an application window defines information about a
selection, command, or process, defines Menu Bar items as the user
highlights each item, and indicates any current keyboard-initiated modes for
typing (e.g., CAPfor the“ CapsLock” key or NUM for the“Num Lock” key,
etc.).
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string Thistype of field or element contains one or more printable characters. If
you specify that afield or element is a string type, you must designate the
format by specifying a syntax token.

syntax token Thisfunction enables you to designate a “token” that defines ranges of
characters and/or numbers that are allowed to be used for a string-type
element or field. You can then use the syntax tokens in the Format field of
the Field Properties dialog. This enables you to define what type of
characters should be used while compliance checking each element/field
(i.e., dphanumeric within a certain range, numeric within a certain range,
etc.).

system import map Thetranslator uses this map to determine which trading relationship
(established in Partner Editor) corresponds to each document in the
application file, so the system knows which import map to use to process the
document. You need a system import map that is defined in EDIMGR.INI to
translate outbound data.

systemimport See system import map.
translation object

system translation Thesetrangation objects control the creation and separation of interchanges,
object functional groups, and transaction sets. They also used to generate and
reconcile functional acknowledgements. All the required system translation
objects are automatically installed with the GENTRAN:Director system.

TDCC SeeEDIA.

TDF TDF isthe Transaction Data File. Thisfile serves as afilter between your
document files and the GENTRAN:Director translator. For outbound
processing, datais imported from a TDF file and translated to EDI format
using a TDF Import translation object. The data is then ready to be posted
and sent to your trading partner. For inbound processing, EDI documents
that are received by GENTRAN:Director can be exported to a TDF-
formatted file using a TDF Export tranglation object. This datafile is then
ready to be processed or converted to your internal application files.

third-party network See Network.

title bar Thetitle bar of an application window contains the name of the application
and enables you to move the window to another position on your desktop.
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toolbar

TRADACOMS

trading partner

transaction set
(document)

translation object

translator

tfransmission

transmission chain

320

This contains buttons that graphically represent commands available in the
Menu Bar.

The U. K. standards for EDI that are published by the Article Numbering
Association (UK) LTD.

Another firm with which you company trades documents. Also referred to as
apartner.

A businessform as defined by the standards. Examplesinclude an ANSI 850
purchase order or an UCS 880 invoice. The standards define each transaction
set in terms of the segments and elements that make up the form, the order in
which they appear, and the relationships among them. Thisis also known as
“message” in Europe.

A predesigned layout set up to ensure that input or output for a particular
transaction set exists and is presented in a usable fashion. You must specify
which trand ation objects are used by each partner relationship.

Inbound Trandation Objects:

Turn Around: Thistranslation object is used when a document is received,
to create the natural response document that contains as many el ements from
the received document as possible.

Export File: Thistrandation object indicates that when a document is
received, it is exported to a specified file format.

Print: Thistrandation object is used to print documents.
Outbound Trandation Objects:

Import: Thistranslation object is used to import data from an application
file.

Print: Thistrandation object is used to print documents.

Data Entry: Thistranslation object is used to enter data into the Document
Editor facility.

Thisisthe engine that processes data for GENTRAN:Director, the
Application Integration subsystem, and the Forms Integration subsystem.

See Communications Session.

A path an EDI communication could follow, including one company, one
trading partner, and one or more network services.
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turnaround document A document into which data elements from the source document have been

turnaround map

ucs

update

use accum

use code

automatically transferred using a turnaround map.

A series of instructions that the system uses to create a turnaround document
(alogical response document to the source) from an inbound (source)
document, by transferring data from the source document to elementsin the
target document (translation object).

The Uniform Communications Standard is the standard used by the grocery
industry.

This standard rule enables you to update a specific field in a document
record, envel ope segment, interchange, group, current partner, or document
(if the map side format type is EDI), with the contents of the element or
field.

Please note that thisfunction updatestheinternal
@ GENTRAN:Director database tables. We recommend

that you use thisfunction only if you are sure you

really want to update the internal database tables.

Typically, you only use this function if you want to
update the document name and referencein the
document table. Any other use of thisfunction could
have disastrous consequences!

This standard rule gives you access to a set of numeric variablesthat you can
mani pulate via numeric operations, and then transfer to and from fields. This
function enables you to add, change, or delete calculations for the element/
field, including hash totals (used to accumulate numeric field values, i.e.,
quantity, price, etc.). This function also enables you to map the accumulated
total into a control total field, and use accumulators. Accumulators are used
generaly for counting the occurrences of a specific element or generating
increasing or sequential record or line item numbers.

This standard rule enables you to match an element or field against a
predefined code table, specify whether or not acompliance error is generated
if the element or field does not contain one of the values in the code table,
and store a code’s description in another element or field.
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322

user translation
object

version

VICS

Workspace

X12

These trand ation objects control data entry, importing, exporting, document
turnaround, and creating printed reports. These trandlation objects are
created using the Application Integration or Forms Integration subsystems.
The Application Integration subsystem enables you to generate import,
export, and document turnaround trangl ation objects. The Forms Integration
subsystem enables you to generate data entry and print translation objects.

Each standards-setting body updates its standards on aregular basis. Each
formal update is referred to asaversion.

The Voluntary Inter-industry Communication Standards is the standards-
setting body for the retail industry, a subset of ANSI X12.

This GENTRAN:Director browser contains alist of outbound “Work in
Progress’ documents. It also contains recently imported or data entry
documents.

The ANSI committee that sets and publishes standards for EDI.
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Symbols strdate 285
?ln Documents 309 strstr 286
20ut Documents 309 then 277
update 287
A while 288
accumulators 143 winexec 288
calculating avalue total 183 ANA 309
calculating hash totals 179 ANSI 309
calculating sums 171 application file 309
using 171 application file format 8
acknowledgements 309 application system 310
activation 44, 94, 309 atoi 267
AIAG 309 aton 268
alphabetic language reference
atoi 267 B
aton 268 begin 268
begin 268 break 269
break 269 browser 310
cerror 269 button 310
concat 271
continue 272 C
count 272 cerror 269
delete 272 check box 310
do 288 click 310
else 277 code list entry
empty 273 deleting 197
end 274 code list table 147
exist 274 code list tables 191, 310
fseek 275 copying and pasting 207
get 276 defining 192
if 277 deleting 197
index 278 exporting 202
left 278 importing 200
len 279 loading 204
messagebox 279 mapping code item descriptions 211
mid 281 modifying 195
ntoa 281 validating data against 209
readblock 282, 290 code table 147
right 282 code tables
select 284 copying and pasting 207
set 284
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defining 192

deleting 197

exporting 202

importing 200

mapping code item descriptions 211

modifying 195

using 191

validating data against 209
colours 310

customizing 87
communications session 310
Communicator 310
compile 310
compliant 311
component data element 311
composite 10

customizing properties 118
composite data element 311
concat 271
conditions 311

defining 115

modifying 115
constant 311
constants

defining 154

deleting 158

editing 156

mapping 159

using 135, 137, 153
continue 272
control menu 12
copy 54
count 272
cross-reference table 311
cross-reference tables

using information from 169
customer service 5
cut 54

D

data
exporting 238
formatting 67
importing 214

data element 312
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date
system 151
date and time
using the system 151
date format
setting default 93
date/time 311
date/time type
using 81
deactivation 311
default 311
delete 272
dialog box 311
display
customizing 85
do 288
document name
setting up 96
documents 312, 320
turnaround 321
double-click 312

E
EANA 312
EDI 312
standard 312
EDI file
activating 44
defining 35
loading amap 57
modifying composite properties 42
modifying element properties 43
modifying group properties 39
modifying segment properties 40
opening amap 57
promoting 47
splitting 50
using 35
using copy, cut, and paste 54
EDI file format 9
EDIA 312
EDIFACT 312
element 10, 312
component 311
composite 311
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customizing properties 113
else 277
empty 273
end 274
envelope 313
equalize 92, 313
exist 274
export map 6, 237, 313
export trandation object 313
extended rules 313

F
field 8, 313
creating 32
customizing properties 113
fixed-format file 313
creating a group 30
creating fields 32
creating subsequent records 28
creating the first record 25
using 23
font 314
fonts
customizing 89
formatting
data 67
formatting data
date/time type 81
number type 78
string type 67
fseek 275
functional group 314

G

GENTRAN:Director
navigation 11

get 276

getting started 1

getting support 5

global display options
customizing 85

group 8, 9, 314
creating 30
customizing properties 100
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modifying 39
promoting 47
splitting 50

H

hash totals
calculating 179

header record 25

I
if 277
import 314
process 215
system configuration
modifying 216
system import map
creating 217
system import trandation object 217
import map 6, 7
import process 213
import translation object 314
In Documents 314
In Drawer 315
inbound mapping 6, 314
index 278
integer 315, 316
interchange 315

K
keyboard techniques 14

L

left 278

len 279

link 315

link display
customizing 91

linking 84

links
creating 84

literal constant 315

literal constants
defining 154
deleting 158
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editing 156
mapping 159
using 135, 153
location table 315
location tables
using information from 165
lookup table 315
lookup tables
using information from 167
loop count 315
using 145
loop end 315
defining inbound 108
defining outbound 112
loop start 315
defining inbound 105
defining outbound 110

M
Main Menu Bar 13
Main Toolbar 13
map 6, 58, 316
building 15
compiling 62
creating 18
equalizing 92
loading 57
naming 60
opening 57
mapping
inbound 6
introducing 6
outbound 6
mapping report
printing 65
maximize 12
menu 316
Menu Bar 13, 316
message 320
messagebox 279
mid 281
minimize 12
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N

network 316

ntoa 281

number 316

number type
using 78

O

ODETTE 316

Out Documents 316

Out Drawer 316
outbound mapping 6, 316

P

partner 316

partner definition
using information from 163

Partner Editor 316

partner-related information
using 163

paste 54

positional file 316

posting 317

predefined 317

printout 317

promote 317

Q
qualifier 317
qualifiers
generating 161
qualifying relationships
using 153

R

readblock 282, 290

real number 317

real) 316

receiving 317

record 8, 317
creating subsequent 28
creating the first 25
customizing properties 103
header 25
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reference
setting up 96
relational conditions 317
defining 115
modifying 115
responding 317
responsible agency 318
right 282

S

saving 58

segment 9
customizing properties 101
modifying 40
promoting 47
splitting 50

segments 318

select 284, 318
using 120

sending 318

set 284, 318

simple mapping 84, 318

source map 6

split 318

standard rule
loop count 145

standard rules 318
constant 135
select 120
update 131
use accum 143
use code 147
using 119

status bar 14, 318

strdate 285

string 319

string type 67

strstr 286

sums
calculating 171

support 5

syntax token 319

creating for Eastern European languages 70
creating for Western European languages 67

deleting 75
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editing 73
using 77
system configuration
modifying 216
system date 151
system import map 6, 319
compiling 236
creating 217
defining the alternate key 229
application alias value 233
application ID 231
partner key 229
test/production 234
defining the six-field key 221
partner key 221
release 226
standard 223
test/production 228
transaction 225
version 224
system import trandation object 319
compiling 236
creating 217
system time 151
system trandlation object 6, 319
system variables
using 135

T
TDCC 319
TDF 319
technical support 5
then 277
third-party network 319
time
system 151
title bar 12, 319
Toolbar 13, 320
TRADACOMS 320
trading partner 320
transaction set 320
translation objects 320
translation process
inbound 7
outbound 7
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translator 320
transmission 320

chain 320
turnaround document 321
turnaround map 321
type

date/time 81

number 78

string 67

U

UCS 321

update 287, 321
using 131

use accum 321
using 143

use code 321
using 147

user trandation object 6, 322

User's Guide
conventions 4

using 191

\/

value total
calculating 183

version 322

VICS 322

W

while 288
winexec 288
Workspace 322

X
X12 322
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